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Chapter 1

Overview

Welcome to the Tracker User Guide for Life and Health users.

This chapter describes:

• Tracker on page 8

• The Tracker Modules on page 9

• SERFF Integration on page 12

• Using a DMS with Tracker on page 12

• Tracker Training on page 12

• Documentation on page 13

• Using the Online Help on page 15
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Tracker

Tracker is compliance automation software that automates and accelerates the 
state filing processes. 

Tracker’s filing automation includes:

• Ability to manage filings in a centralized repository providing a single point 
of access to compile and store all documentation. 

• Ability to access a wide range of management and production reports to 
view filings, rates, advertisements, or forms, and monitor productivity and 
speed to market.

• Ability to record and monitor a filing’s history through customizable 
activities. 

Tracker provides the only third party direct integration with SERFF, (the System 
for Electronic Rate and Form Filings). Tracker leverages and extends SERFF. It 
enables carriers to further accelerate speed to market by automating the product 
development and state filing preparation process and utilize SERFF for electronic 
filings with the Departments of Insurance. Tracker provides a quicker way to get 
your filings to the Departments of Insurance utilizing a start to finish process. 
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The Tracker Modules

Tracker the following interrelated modules:

• Filing Module on page 9

• Legislation on page 11

• Reports on page 11

• Administration on page 11

• Regulatory Specialist on page 11

Filing Module

The Filing Module is comprised of three levels in which you can create, store and 
track filing submissions to the Departments of Insurance. These levels are:

• the Top level

• the Filing Group level

• the Filing level

The Top level allows you to select the products that you want to work with and 
identifies a filing at its broadest level as a part of one of your company's overall 
insurance products. The second level, called the Filing Group, stores high-level 
information regarding a group of related filings that are part of that product. The 
third level, called the Filing level, stores individual filings within a filing group.

Individual filings are classified by the State, Line of Business, Company and 
filing content (form, rate, advertisement) with which they are related. There may 
be multiple filings within a single filing group and multiple filing groups within a 
single product. 

Imagine a filing cabinet where the cabinet is identified as the product you are 
working with. The drawers in this cabinet are the filing groups that store high 
level information about a group of related filings. In each drawer you would store 
individual file folders that can represent the filings classified by State, Line of 
Business, Company and filing content.
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Finding a particular filing record is both quick and easy. When you first log in to 
Tracker, the Top level allows you to specify a product, and to view a list of all the 
filing groups within that product. You can then select a filing group and move to 
the next level — the Filing Group level. Here you can view a list of all the filings 
within that particular filing group. You can then select a filing and move to the 
third level — the Filing level. Here you can view detailed information pertaining 
to that filing alone.

Additional My Filings tabs, found at the Top level and Filing Group level of the 
system, organize your Tracker filings further by listing the filings specific to you 
alone. They can even be filtered to show only filings of a particular status, or only 
filings showing a suspense date (indicating a pending activity), so that you can see 
immediately what you need to do, and where to find it.

For more information, see:

• Products and Filing Groups on page 97

• Working with Filings on page 107

• Working with Common Filing Tasks on page 195

• Working with Activities on page 201

• Understanding Filing Letters on page 335

Filing Groups

Filing Letters
Rates, Advertisements, 
Forms
Supporting 
Documentation
Activities

Filings

Product
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Legislation

The Legislation section of the system (accessible via the View menu) stores all of 
the information about the legislation you receive and refer to in one well-
organized place. Here you can view detailed information about a single legislation 
record, or browse through your legislation records to locate the information you 
need.

Legislation such as bulletins, regulations, circular letters, and advance and 
approved laws issued by the various departments of insurance, can be entered into 
Tracker as they are received by your company to track state insurance changes 
that impact your products and practices. Such legislation can be linked to each 
other and they can also be linked to related filings which might be necessary to 
comply with the legislation.

See Working with Legislation on page 343 for more information.

Reports

Tracker has a robust reporting module, allowing users, managers and 
administrators to generate a number of reports to meet a variety of needs. 

The main Reports module in Tracker is divided into three categories: Status, 
Historical and Management Reports. 

Other reports in Tracker are located in the Admin Menu (available only to Tracker 
administrators). 

For more information, see: 

• Searching, Reporting, and Filing Summary on page 369

• Administrative Reports on page 90

Administration

You use the Administration module to configure Tracker. This module includes:

• System Defaults on page 31

• Security Access Levels on page 39, including user security

• Company Information on page 33

• User Profiles on page 60

• Custom Tables on page 65

See The Administration Module on page 19 for more information.

Regulatory Specialist

Regulatory Specialist provides access to SERFF information and General 
Instructions. It also provides a database where you can maintain your own set of 
contacts and addresses at the Departments of Insurance, and a set of custom state-
specific information.

See Working with the Regulatory Specialist on page 363.
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SERFF Integration

Tracker is fully integrated with SERFF (System for Electronic Rate and Form 
Filing) a Web-based filing service maintained by the NAIC. Instead of having to 
log on to the SERFF application to submit and manage your filings, you only need 
to use Tracker to submit and manage all aspects of your SERFF filings. All 
communication between the state Departments of Insurance (DOI) is contained 
and managed within Tracker.

Help with SERFF Functionality

If you are having problems with submitting SERFF filings in Tracker, please 
contact Customer Support. Please do not contact the NAIC or the state DOI 
directly because they will not be able to help you with any issues related to 
SERFF functionality in Tracker.

Using a DMS with Tracker

Your system administrator may have configured Tracker to allow you to store 
filing attachments (forms, rates, and advertisements) in a document management 
system like Oracle IDM. Oracle IDM is a document management system where 
you and other Tracker users can open and save certain files.

If you are configured to use a DMS, a Browse DMS button will be included on 
specific screens that appear when working with attachments.

Tracker Training

Tracker training courses are offered through Oracle Consulting. Training is 
usually done in your office after the administrative setup of Tracker has been 
completed. Having training after setup allows you to train your employees using 
your recommended setup of Tracker. 

Training courses are designed for your segment of the insurance industry. Both 
new and experienced Filing Analysts are taught every facet of Tracker and how to 
use Tracker for every step of a filing. 

For more information on Tracker training, please contact Customer Support. 

Note When you browse the DMS from Tracker, the last folder that was accessed is displayed. 
This includes the last folder that was accessed when a filing is generated and moved to 
the Filing Package tab.
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Documentation

The following topics help you get the most of the documentation for this product:

• Accessibility on page 13

• Related Documents on page 13

• Conventions on page 13

Accessibility

Accessibility of Links to External Web Sites in 
Documentation

This documentation may contain links to Web sites of other companies or 
organizations that Oracle does not own or control. Oracle neither evaluates nor 
makes any representations regarding the accessibility of these Web sites.

TTY Access to Oracle Support Services

Oracle provides dedicated Text Telephone (TTY) access to Oracle Support 
Services within the United States of America 24 hours a day, seven days a week. 
For TTY support, call 800.446.2398.

Related Documents
For more information, refer to the following Oracle resources: 

• The Tracker User Guide contains overviews, step-by-step procedures and 
descriptions of the screens and fields.

• The Tracker Online Help contains the same information as the User Guide, 
but in an online help format with a search tool, an index and a table of 
contents.

• The Tracker Release Notes include general product information, product 
enhancements and new features.

• The Tracker Installation Guides contain system requirements and detailed 
installation and configuration information. Guides are supplied for new 
installations and upgrades, and for both Oracle and SQL environments.

• The Tracker Technical Guide is for system administrators and includes 
information about the optional DMS, maintaining DMS components, log 
files, error levels and Tracker Monitor, and troubleshooting information.

Conventions

The following text conventions are used in this document: 
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Tips, Notes, Important Notes and Warnings

Dialog
“Dialog” is the term used to describe windows, screens and other types of user 
interface elements used to enable reciprocal communication or “dialog” between a 
computer and its user. It may communicate information to the user, prompt the user 
for a response, or both.
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Using the Online Help

This section describes how to use the Online Help and includes information about 
these topics:

• The Contents of the Online Help on page 15

• Searching the Help on page 15

• Using the Help Index on page 16

• Using the Help Table of Contents on page 16

• Navigating the Help on page 16

• Printing a Help Topic on page 17

The Contents of the Online Help

The Online Help contains the same contents as the related PDF document, but in 
an online Help format.

To open the Online Help, click the Help menu.

The Help is divided into two frames:

• the left frame displays the navigation tools: Contents, Index and Search

• the right frame contains the contents of each Help topic

There are different ways to find a Help topic:

• Searching the Help on page 15

• Using the Help Index on page 16

• Using the Help Table of Contents on page 16

• Navigating the Help on page 16

Searching the Help

You can search the entire Help contents to find a specific topic.

Method: Search the Help

1. In the left pane of the Help, click the Search tab.

2. Enter the word(s) you want to search for, then click Go! or press Enter.

3. A list of Help topics is displayed in descending order by Rank. The Rank 
indicates how many times the word(s) you searched for appears in a Help 
topic. It can help indicate how relevant the topic may be in your search.

Tip Use specific words in your search, for example: model document. Avoid using plurals, 
for example, “sections,” because this may limit your search results.
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Using the Help Index

The Help Index contains a listing of all the Help topics in alphabetical order.

Method: Use the Help Index

1. In the left pane of the Help, click the Index tab.

2. Click the letter that corresponds to the topic you are searching for. You 
cannot select a letter that is greyed out, because it contains no index entries.

3. A list of all index entries beginning with the letter you selected is displayed.

4. Scroll to the index entry of the topic you are searching for.

5. Click the topic to view its contents in the main body of the Help.

Using the Help Table of Contents

When you open the Help, the Contents are displayed. The Contents contain main 
topics and their subtopics.

Each main topic appears as a book icon:

Each subtopic appears as a page icon:

Subtopics can also appear as book icons. In other words, books can appear within 
other books.

You can open a book by clicking a book icon or the text next to the book icon. 
This will expand the book and display the topics within that book. 

To close an open book, click the book icon. The book “collapses”, hiding the 
topics within the book.

Navigating the Help

To go to the next or previous Help topic in the Contents, use the Next and 
Previous buttons in the right pane of the Help:

Tip When a Help topic is displayed, you can click the “Show in Contents” button to open the  
corresponding book that contains the displayed Help topic:
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To go to the next or previous topic that you have viewed, use the Forward and 
Back buttons in your Web Browser.

Printing a Help Topic

You can print a Help topic in case you want to refer to it later.

Method: Print a Help topic

1. Click the Print icon in the upper-right corner of the Help:

2. The Print dialog box is displayed.

3. Click Print to print the Help topic. 
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Chapter 2

The Administration Module

This chapter provides background information and complete instructions for using 
all of the features of the Administration menu. As the name implies, the 
Administration menu is your access point to Tracker’s system-wide and user-
specific settings. This is where the information specific to your company is 
entered and maintained in the Tracker system. This chapter is recommended 
reading for anyone involved in setting up or maintaining a Tracker system.

This chapter describes:

• Initial Setup on page 20

• System Defaults on page 21

• Security Access Levels on page 29

• Company Information on page 33

• SERFF Settings on page 48

• User Profiles on page 60

• Custom Tables on page 65

• Reassigning Activities on page 89

• Administrative Reports on page 90

Note The Admin menu is available only to users whose security level provides access. It will 
not appear on the screen for users not designated to access it.

Important It is recommended that administrators limit access to this menu. Changes made to 
central system tables and records here can have a widespread impact throughout your 
Tracker system.
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Initial Setup

Because Tracker is designed to be highly flexible and to conform to the needs of 
your company, you need to perform customization on the following screens after 
completely installing Tracker before you allow users to begin working in it:

1. System Defaults: see System Defaults on page 21

2. System Security: see Security Access Levels on page 29

3. Company Information: see Company Information on page 33

4. SERFF System Defaults: see SERFF Settings on page 48

5. User Profiles: see User Profiles on page 60

6. Custom Tables: see Custom Tables on page 65

For some of the required information, you may need to contact your IT 
department.

Note Oracle Global Support can help you with the system setup process.
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System Defaults

This section describes how to define certain system default settings that will apply 
to every Tracker user. These settings are found on the System Defaults dialog. 
Access the System Defaults dialog by clicking Admin > System Information > 
System Defaults.

There are three tabs on the System Defaults dialog:

• Settings on page 21

• Custom Field Labels on page 25

• RS Custom Field Labels on page 27

Settings

On this tab you can perform the following tasks:

• Defining a Group Name on page 21

• Configuring the Display of Filings with Suspense Activities on page 22

• Displaying or Hiding Canadian Provinces on page 23

• Setting User ID and Password Authentication on page 24

Defining a Group Name

The field Group Name is included within the System Defaults tab. If this field is 
populated, Tracker will pass the value in this field to SERFF.

Method: Define a group name

1. Select Admin > System Information > System Defaults.

The System Defaults dialog displays with the Settings tab displayed.
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2. Enter the Group Name.

3. Click OK.

Configuring the Display of Filings with Suspense Activities

Using the Show all suspended check box, you can set up Tracker to always 
display, in the My Filings and Filings tabs, one of the following sets of filings 
with suspense activities:

• filings with suspense activities that require action, regardless of date

OR

• filings with suspense activities that require action, up to the current date

The second option is the default setting when Tracker is first installed.

Method: Configure the display of filings with suspense activities

1. Select Admin > System Information > System Defaults.

The System Defaults dialog displays with the Settings tab displayed.
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2. To show in the My Filings and Filings tabs filings with suspense activities 
regardless of date that require action, select the Show all suspended check 
box.

OR

To show in the My Filings and Filings tabs only those filings with suspense 
activities up to the current date that require action, clear the Show all 
suspended check box.

3. Click OK to save the settings.

Displaying or Hiding Canadian Provinces

Tracker allows you to create, submit, and track filings for Canadian provinces. 
There is a check box in System Defaults which allows you to specify if Canadian 
provinces appear in Tracker. By default, this check box is not selected. If you need 
to create filings for Canadian provinces, you will need to select this check box. 

If provinces are displayed, then provinces are available within most parts of 
Tracker just as states are. This means they are available when companies are being 
created in Tracker, and within filings. However, note that no regulatory 
information on provincial filings is maintained within Tracker.

Method: Display or hide Canadian provinces

1. Select Admin > System Information > System Defaults.

The System Defaults dialog displays with the Settings tab displayed.
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2. To display Canadian provinces, select Show Canadian Provinces.

3. To hide Canadian provinces, deselect Show Canadian Provinces.

4. Click OK to save your changes and close System Defaults.

Setting User ID and Password Authentication

You can select a Windows Authentication option for the Tracker logon. With this 
option, a user’s Windows ID and password are used to access Tracker. Users will 
no longer need a separate user ID and password for Tracker.

In addition to ease of use for users, the main benefit of this option is that your 
company can systematically enforce your password update policy, without any 
additional set up or configuration in Tracker.

By default, the Windows Authentication option is not enabled. 

Method: Enable Windows Authentication

1. Select Admin > System Information > System Defaults.

The System Defaults dialog displays with the Settings tab displayed.
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2. Select the Use Windows Logon check box.

3. Click OK to save your changes and close System Defaults.

Note: If you do not select Use Windows Logon, no password change will automatically 
occur or be enforced in Tracker. When a user changes their Windows password, it 
will not be passed intoTracker; the user’s Tracker password would stay the same 
until changed. See Changing Your Tracker Login Password on page 103.

Custom Field Labels

Custom fields allow you to capture and store additional information pertinent to 
your company and the way you perform filings.

You are able to change the label name of the custom fields to reflect the value 
captured in those fields. The value you enter for the custom field label is the text 
that will appear beside the corresponding custom field in Tracker. The custom 
field labels are organized according to where they are located in Tracker.

Method: Define or edit custom field labels

1. Select Admin > System Information > System Defaults.

The System Defaults dialog displays with the Settings tab displayed.

Important The logon setting applies to all Tracker users. A user cannot select their own logon 
preference. The logon setting selected at the Admin level controls which fields are then 
enabled on each user’s profile.
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2. Click the Custom Field Labels tab.

Each field on the tab corresponds to custom fields in that part of the Tracker 
system. In each custom field box, enter the name that you would like to 
appear as the field label in that part of the system.

For example, to store your company’s courier account number, enter a value 
of “Courier Acc” in Company. When you view the Company Information 
window, there will be a new field label of Courier Acc.
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3. When finished, click OK.

RS Custom Field Labels

You can assign a custom name to the tab and to each of the free-format fields in 
the RS Custom Fields within the Regulatory Specialist.

Method: Change RS custom field labels

1. Select Admin > System Information > System Defaults.

The System Defaults dialog displays with the Settings tab displayed.

Note You will have to log out of Tracker and log back in to see any changes made in the 
custom field labels at the Filing Group level.
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2. Click the RS Custom Field Labels tab.

3. Make any necessary changes.

4. When finished, click OK.

For more information about these fields, see RS Custom Fields on page 368.

Enter custom 
tab name here

Enter custom field 
labels here
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Security Access Levels

Initially, you determine what functional user levels are required at your company 
location, and then assign various security settings for these user levels.

This section describes

• Understanding Security Settings on page 29

• Configuring Security Access Levels on page 29

Understanding Security Settings

Each security access level has generic security settings and SERFF-specific 
security settings.

Generic security settings

• Read/View filing data

• Edit/Modify/Append filing data

• Add/New/Create filing data

• Delete/Erase filing data

• View administrative functions

• Perform administrative functions

• Remove from Filing Package tab (activities)

• Add/Edit content in Regulatory Specialist custom fields

SERFF-specific security settings

• Delete My SERFF Messages (from the SERFF messages tabs)

• Delete All SERFF Messages (from the SERFF messages tabs)

• Set EFT Authority Level

 

Configuring Security Access Levels

Tracker employs a flexible security system that allows your company to 
customize each of 10 access levels to reflect the hierarchy of your organization. 
Each level can be configured to allow access to a given set of Tracker tasks, so 
that users can see and use only the functions necessary to them, streamlining the 
access and processes and enabling tight control of the filing process within your 
departments.

This section describes:

• Defining Security Access Level Titles on page 30

• Defining Security Access Levels on page 31

• Assigning User Access Levels on page 32
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Defining Security Access Level Titles

You can change the default access level titles to match titles used in your 
organization.

Method: Define an access level title

1. Select Admin > System Information > System Security.

The Security Access Levels dialog displays.

2. Click Rename Levels.

The Rename Security Levels dialog displays.

3. Click the title you want to rename and click Rename.

4. Type in the desired new level title and press Enter.
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5. Repeat steps 3 and 4 to rename other security levels.

6. When finished, click Close.

Your changes are saved.

7. Click OK to exit the Security Access Levels dialog.

Defining Security Access Levels

For each access level, you can define which activities can be performed within 
Tracker. 

Method: Define a security access level

1. Select Admin > System Information > System Security.

The Security Access Levels dialog displays.

2. Click the tab for the security access level for which you want to define 
permitted functions.

3. Select the check boxes beside all the functions you want this level of user to 
be able to perform. 

4. Repeat steps 2 and 3 for each security access level you have defined.

Note As indicated in this dialog, message suppression functionality applies only to SERFF 
filings created in Tracker 6.1 and 6.3.
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5. Click OK to save your information and exit the dialog box.

Assigning User Access Levels

Users are assigned a specific security access level on their User Profile dialog 
screens. See Adding New User Profiles on page 60 for details.     
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Company Information

This section describes:

• Understanding Company Information on page 33

• Adding New Companies on page 33

• Understanding Company Codes on page 35

• Entering or Editing General Information for Companies on page 35

• Entering or Editing Authority Information for Companies on page 38

• Entering or Editing Resource Information for Companies on page 43

• Deleting Companies on page 45

• Accessing Existing Company Information Records on page 47

Understanding Company Information

The Company Information screens are where you enter all of the pertinent 
information about the companies for which your company prepares filings. There 
is a separate company information record for each company, office, or location. 
This information is divided into the following types, located on the corresponding 
tabs: 

• General information, which includes basics such as address and company 
code

• Authority information, which includes the states and lines of business in 
which each company is licensed to sell insurance

• Resources, which lists the names of personnel occupying various positions 
within the company

Adding New Companies

You must add at least one company before you can start working with filing 
groups and filings.

Method: Add a new company 

1. Select Admin > Company Information.

The Companies dialog displays.

Important All company information must be entered into the Tracker system during the initial 
system set up. You cannot begin to create and manage filings within Tracker until this 
information is in place.
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2. Click Add.

The Company Information dialog displays.
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3. Enter General Information and Authority Information. (See detailed 
directions in Entering or Editing General Information for Companies on 
page 35 and Entering or Editing Authority Information for Companies on 
page 38).

4. Assign Resources. (See detailed instructions in Enter resource information 
for a new company on page 44).

5. Click OK to save your data and return to Companies.

6. Repeat steps 2 to 5 to add additional companies.

7. When finished, click Close.

Understanding Company Codes

Each company you file for must be assigned a unique two-character code for easy 
identification within Tracker. When you enter a new company into the system, be 
sure to choose a new code which you have not already used to identify another 
company. Any combination of numbers and letters in the two-digit code is 
acceptable (with the exception of the reserved system code (CG).

With the exception of advisory/rating organizations, each company must have an 
NAIC Code. Tracker ensures that the code entered 5 digits long and that you have 
not already used the same NAIC Code to identify another company.

Entering or Editing General Information for 
Companies

This section provides detailed directions for entering general information on a 
new company or updating the general information for an existing company.

Method: Enter or edit general information for a company

1. Select Admin > Company Information.

The Companies dialog displays.
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2. Click Add to create a new company, or select an existing company and click 
Edit.

3. On the General tab of the Company Information dialog, enter the Name of 
the company and a unique, two-digit Company Code.

4. Select the Advisory/Rating Organization check box if this company is an 
advisory or rating organization. (Some states allow only advisory/rating 
organizations to use EFT payments. See Regulatory Specialist, SERFF tab, 
General subtab on page 366 for details.) 

5. Enter the company’s Main Address, and then the company’s secondary or 
Alternate Address if applicable.

6. Enter Contact information for the company:

• Enter company’s main Phone Number, Toll-Free Phone Number, Fax 
Number, and URL. (Formatting rules apply.)

• Enter the company’s NAIC Group Code and the NAIC Code (the 
NAIC company code), if applicable.

Note For a Company Group filing, in order for EFT to be an option, the Advisory/Rating 
Organization check box on the General tab of the Company Information dialog would 
have to be selected for all of the companies in the Company Group. If the Advisory/
Rating Organization check box is not selected for any of the companies in the Company 
Group, then Check is the only option available for filing fees – EFT will not be an option.
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• Enter the company’s State of Domicile.

• Enter the company’s Federal Employer Identification Number (FEIN). 
The correct format is NN-NNNNNNN, where N is a numerical digit.

7. Enter Company Type. If populated, the field will be passed to SERFF on 
each filing. This field can be used to capture information about what type of 
insurance a company is licensed to write. Typical values include Property & 
Casualty, Life, Health, and so on.

8. If you have registered with the NAIC to pay filing fees by EFT for this 
company, enter the UNID number assigned by the NAIC in Payer UNID.

9. Click Edit Departments.

The Departments dialog displays.

10. To create a new department, click Add, or select an existing department and 
click Edit. 

The Company Department dialog displays.

Note The NAIC Code field may be blank for Advisory/Rating organizations, but companies 
that are not Advisory/Rating organizations must enter a value for NAIC Code.

Note If more than one company shares the same FEIN, you will experience problems if 
you try to submit a Company Group EFT filing or a Company Group rate filing that 
includes companies that share the same FEIN. The filing will be rejected by SERFF 
or have unpredictable results.
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11. Enter the Name of this department. Modify any other information as 
required. 

12. Click OK to save the department information.

13. Repeat steps 10 to 12 until you have made all required additions or 
modifications.

14. When finished, click Close.

15. Click Apply to save the information you have just entered.

16. If finished entering information, click OK, then click Close. 

OR

To continue setting up a new company, select the Authority tab, and 
proceed to enter authority information. (See Entering or Editing Authority 
Information for Companies on page 38.)

Entering or Editing Authority Information for 
Companies

This section provides detailed instructions for entering authority information 
when adding a new company. This method can also be used to update the 
authority information for an existing company.

Method: Enter authority information for a new company

1. Select Admin > Company Information.

The Companies dialog displays.
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2. Click Add to create a new company, or select an existing company and click 
Edit.

3. Click the Authority tab.

The Authority tab displays.
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4. Click Add (located below State ID).
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The Company State Authority dialog displays.

5. On the list of Available States, select the states in which this company is 
licensed to sell insurance and move them to the Licensed States list by 
using the right arrow button.

Clicking on the double arrows will move all entries.

6. When all of the states for which the company is licensed appear in the 
Licensed States list field, click OK to return to the Authority tab. 

The selected licensed states will now appear in the list field at the left of the 
tab.

7. To enter or modify the State ID for a state, click the state in the list, enter the 
state identification code for this company in the text box, and click Update.

 If entered, the State ID will be sent to SERFF.

8. To add LOBs to a state for this company, click the Add button located near 
the bottom of the tab.

9. The Company LOB Authority dialog displays.
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10. From the Available LOB list, select the lines of business for which this 
company is licensed to sell insurance in this state and move them to the 
Licensed LOB list using the right arrow button.

Clicking on the double arrows will move all entries.

11. When all of the lines of business for which the company is licensed in this 
state appear in the Licensed LOBs list field, click OK to return to the 
Authority tab.

The selected licensed lines of business will now appear attached to the 
selected state in the list on the left.

12. Repeat steps 7 through 11 for each state listed.

13. To remove a state (and all lines of business attached to it) from the list, 
select the state and click Delete. Click Yes to confirm.

14. When finished, click OK to save your information, and then click Close.

15. The following three fields are for US States only. Currently, these are for 
PPACA eligible filings only, but may be used for non-PPACA filings in the 
future.

• HIOS Issuer ID

• NCQA ORG ID

• URAC Application Number
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If you are a new user to Tracker, these fields will be transmitted to SERFF 
when the filling is submitted.  If you are an existing user of Tracker, once 
these fields are updated with the correct values, these fields will be 
transmitted to SERFF for all filings not currently submitted to SERFF, i.e. in 
a start status.

Entering or Editing Resource Information for 
Companies

This section provides detailed instructions for entering resource information when 
adding a new company. This method can also be used to update the resource 
information for an existing company.

Note Resource information can be added to a company record only after user profiles 
have been entered into the system. See User Profiles on page 60.
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Method:  Enter resource information for a new company

1. Select Admin > Company Information.

The Companies dialog displays.

2. Select a company and click Edit.

3. Click the Resources tab.
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4. For each resource applicable to this company, select a name from the related 
drop-down list.

5. Click OK to save your resource information and exit Company 
Information.

Deleting Companies

You can delete an existing company, as long as it does not have any filings 
associated with it.

Method: Delete a company

1. Select Admin > Company Information.

The Companies dialog displays.

Important Companies already associated with filings should never be deleted, as this might 
cause record tracking difficulties. Contact Oracle Global Support if you have any 
questions.
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2. Click the company you want to delete.

3. Click Delete.

If this company does not have any filings associated with it, a confirmation 
dialog displays.

4. Click Yes to confirm the deletion (or No to cancel).

The updated Companies list displays.

5. Repeat steps 2 to 4 for other companies you want to delete.

6. When finished, click Close.

Note If you attempt to delete a company that is in use (that is, it already has filings 
attached to it), a message displays:

Unable to delete this company; it may be in use.
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Accessing Existing Company Information Records

You can access existing company information records to review them.

Method: Access an existing company information record

1. Select Admin > Company Information.

The Companies dialog displays.

2. Select a company from the list and click Edit, or double-click the company 
you want to access.

The Company Information dialog displays.

3. When finished examining the company information, click Cancel, then 
click Close.
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SERFF Settings

In order to submit filings using SERFF, the Tracker administrator must configure 
the Tracker-to-SERFF communication settings. Certain information is mandatory 
for use with SERFF. When you first start Tracker, these SERFF System Defaults 
fields will be blank.

On the SERFF Defaults dialog there are three tabs. The System tab and the 
Attachment Format tab are used to control the default settings for Tracker-to-
SERFF communications. The third tab, State Messages, controls the display of 
state-generated messages. The following sections describe the settings available 
and how to configure the information within these tabs:

• Understanding the SERFF System Defaults on page 48

• Configuring SERFF System Defaults and SERFF Filing Default Options on 
page 51

• Setting EFT Fee Authority Levels on page 52

• Configuring SERFF Schedule Item Attachment Formats on page 55

• Configuring Display of State Messages on page 65

Understanding the SERFF System Defaults

The following section describes the fields on the SERFF Defaults dialog.
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SERFF SPI Log On ID and SERFF SPI Password

When you have fully registered with the NAIC and have activated your SERFF 
account there, the NAIC will assign you a SERFF SPI Log On ID and 
Password. This combination of log on ID and password is unique to your 
organization, and you will be assigned only one log on ID and password 
regardless of the number of companies you are licensed to file under or the 
number of companies included in a single filing.

Tracker automatically passes the SERFF SPI Log On ID and Password with 
each filing submitted to SERFF. (The password is encrypted before being 
transmitted to ensure security.) 

Because the SERFF SPI Log On ID and Password are unique to your 
organization, they are used to validate and authenticate your company information 
for filings before they are transmitted to the relevant state DOIs through SERFF. 
The SERFF SPI Log On ID is also used to identify and track your filings in 
SERFF, including tracking the number of transactions you have performed 
through SERFF. Because your filings are uniquely identified within SERFF, 
SERFF can automatically transfer messages on your filings from the relevant state 
DOIs back to you in Tracker.

Filing Rule, State Filing and Attachment URLs

The URLs listed on the System tab of the SERFF Defaults dialog are for 
SERFF’s production servers. 

The Filing Rule URL is the address of the server where all SERFF filing 
requirements all stored. The states are responsible for entering and updating the 
data on the Filing Rule server. The NAIC is responsible for the actual 
maintenance of this server.

The State Filing URL is the address of the server where your actual state filings 
are stored. The State Filing server is located at the NAIC and maintained by them.

The Attachment URL is also required by the NAIC.

The Billing URL is the address of the server where transaction block/billing 
information is stored.

 The Utility URL is the address of the server where PPACA information is stored.

Values for these URLs are provided directly by NAIC upon receipt of a signed 
NAIC SERFF agreement.

Hide All Messages After [ ] Days

As you receive messages from SERFF about the status of your filings, they will be 
logged in the Log Entries subtab within the SERFF tab of the filing, and in the 

Note The NAIC periodically performs maintenance on the SERFF servers. When this 
occurs, Oracle will email you in advance with the approximate times that the 
maintenance will occur so that users can schedule their SERFF filings accordingly.
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My SERFF Messages and All SERFF Messages tabs (collectively referred to as 
the Message Center) at the top level of Tracker.

The value you enter in this field is the number of days messages will be displayed 
after the date they were received by Tracker in the Message Center tabs. Messages 
and their contents will always be available for viewing in the filing and within the 
Log Entries subtab of the filing to which they apply. Certain message types such 
as Note to Filer, Objection Letters and Disposition Reports will also appear under 
the Correspondence tab within the filing to which they apply. 

SERFF Filing Default Options

This section contains three settings. Default values can be set by making choices 
from drop-down menus: 

The default value for Project # has the following choices:

• Company Reference #

• Filing Custom Field

• Filing Group Custom Field

• Filing Description

• Filing Group Description

• Filing Group name

• None

• Tracker Filing ID

The default value for Project Name has the following choices:

• Filing Description

• Filing Group Description

• Filing Group name

• None

• Program Description

The default value for Product Name (for SERFF filings) has the following 
choices:

• Custom

• Filing Description

• Filing Group Description

• Filing Group Name

• None

• Program Description
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Configuring SERFF System Defaults and SERFF Filing 
Default Options

To set or make changes to the SERFF System Defaults and SERFF Filing Default 
Options, follow these steps:

Method: Configure the SERFF system defaults settings and SERFF 
Filing Default options

1. Select Admin > System Information > SERFF System Defaults.

The SERFF Defaults dialog displays.

2. On the System tab, complete the following fields:

SERFF System Defaults:

• SERFF SPI Log On ID

• SERFF SPI Password

• Filing Rule URL

• State Filing URL

• Attachment URL

• Billing URL
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• Hide All Messages After # Days

SERFF Filing Default Options:

• Project #

• Project Name

• Product Name

3. If required, configure the EFT Fee Authority Levels. See Setting EFT Fee 
Authority Levels on page 52.

4. Click OK.

The data is saved, and will be applied to every SERFF filing created in 
Tracker.

Setting EFT Fee Authority Levels

If you will be using EFT to pay filing fees where permitted in SERFF, in addition 
to entering the Payer UNID for each of your companies, (see Entering or Editing 
General Information for Companies on page 35), you need to enter:

• a description for each level within your organization that you want to be 
able to authorize EFT filings

and

• the maximum dollar amount for an EFT filing that the specified level can 
authorize

Method: Establish an EFT Fee authority level

1. Select Admin > System Information > SERFF System Defaults.

The SERFF Defaults dialog displays.

Important You can enter as many levels as you need, however, you must enter at least one 
authorization level and maximum amount for the one level. If you do not enter any 
information in this section, the system assumes that EFT has not been authorized 
and no one will be able to use the EFT functionality.

Note The EFT Fee Authority level information you enter here controls the options which 
display in the EFT Fee Authorization Level field on the Security Access Levels 
and which then can be affiliated with each access level.
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2. In the EFT Fee Authority Levels area, click Add. 

The Authority Level Description field unlocks with a prompt of “Please 
enter the range name for the EFT authority level here,” and a Maximum 
Amount of $0.00.

3. Click the description and type in a meaningful name for this authority level.

4. Click the value to the right and type in the Maximum Amount for this 
level.

5. Press Enter.

The level is added.

6. Repeat steps 3 to 5 to add additional levels.

7. When finished, click OK.

Note This is a per-EFT transaction per-filing maximum. It is not a cumulative maximum 
per user or per filing.
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Configuring Proxy Server Settings (Advanced Settings)

Method: Configure the proxy server settings

1. Select Admin > System Information > SERFF System Defaults.

The SERFF Defaults dialog displays.

2. On the System tab, click the Advanced Settings button.

The Proxy Settings dialog displays.

Note Complete this procedure only if you use a proxy server to access the Internet. If you 
are not sure if you use a proxy server, contact your IT department.
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3. Select the Use Proxy Server check box.

4. Select the Authentication type used by your organization:

• For basic username/password security, select Basic Authentication, 
enter the user name and password which the proxy uses to access the 
Internet. Your IT department will have this information.

• To use Windows Authentication, simply select this option.

5. When finished, click OK.

Configuring SERFF Schedule Item Attachment 
Formats

By default, all schedule item attachments sent to SERFF are converted to PDF 
when you select the Move to Filing Package check box in the Submit to SERFF 
activity dialog box. However, you can use the Attachment Format tab to have 
Excel and/or text schedule item attachments sent in their native file format. 
Specifically, for each state, you can select whether to send such files in their 
native format (Excel or text), and/or as PDFs. If you select PDF and another 
format for a state, the attachments are sent on the same schedule item to SERFF.

Method: Configure the SERFF default schedule item attachment 
formats

1. Select Admin > System Information > SERFF System Defaults.

The SERFF Defaults dialog displays.
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2. Click the Attachment Format tab.

The SERFF Attachment Formats dialog displays.
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3. Configure the default schedule item attachment format(s) sent:

For most states, the SERFF default schedule item attachment format is PDF.

To change the default schedule item attachment format(s), select or clear the 
Excel and/or Txt Native check boxes for the required states. If required, 
clear the PDF check box after selecting other check boxe(s).

Based on your selections:

• attachments will be converted and sent as PDF files if the PDF check 
box is selected

• Excel files will be sent if the Excel check box is selected

• text files will be sent if the Txt Native check box is selected

Note You must select at least one check box per state.
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Configuring Display of State Messages

On the State Messages tab, the system administrator can control which state-
generated messages are captured in the database and displayed on the All SERFF 
Messages and My SERFF Messages tabs. The administrator can select to display 
messages of type P&C, L&H, or messages of both types for each desired state. If 
no selection is made, no messages from that state will display. The default for 
each state is to display no messages.

Method: Configure the SERFF state messages display

1. Select Admin > System Information > SERFF System Defaults.

The SERFF Defaults dialog displays.

2. Click the State Messages tab.

The State Messages tab displays.

Note If a received message is marked as both P&C and L&H, it will be displayed if the 
setting for that state is one or the other, or both.



SERFF SETTINGS

TRACKER L&H USER GUIDE  59

3. Select which messages should be displayed. For each state, valid choices are 
L&H, P&C, both L&H and P&C, or no selection.

4. Click OK to save and return to Tracker.
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 User Profiles

The Users section contains a listing of all the people at your company who use 
Tracker. Each person must have a detailed user profile in the Tracker 
administrative tables in order to be able to use the system. Each user’s profile 
contains basic identification and contact information for that user.

Adding New User Profiles

User profiles contain essential data about the user, including their security access 
level. The user level determines what they can do in Tracker. (See Security Access 
Levels on page 29.)

Method: Add a new user profile

1. Select Admin > Users.

The Users list dialog displays.

2. Click Add.

A blank User Profile dialog displays.
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3. Select the prefix for this person (for example Mr. or Ms.) from the Prefix 
drop-down list.

4. Enter the Name, Initials, Title and any professional Designations (such as 
FLMI, JD or ACS) for this person.

5. If you want to configure this user as an available selection for a filing group 
manager, check the FG Manager check box.

(A filing group manager is the person responsible for a particular filing 
group, and is assigned when creating a filing group.)

If you want to configure this user as an available selection for a filing 
manager, check the Filing Manager check box.

(A filing manager is the person responsible for a particular filing, and is 
assigned when creating a filing.)

6. In the upper portion of the Logon Authentication section:

• You can set the security Access Level for this person. For more 
information about access levels, see Security Access Levels on page 29.

• You can set the EFT Fee Authority Level for this person. For more 
information, see Setting EFT Fee Authority Levels on page 52.

7. In the lower portion of the Logon Authentication section, enter the unique 
user ID for this person. This will be used as their logon user name. The 
information you need to enter here depends on whether you have enabled 
Windows authentication for your users.



THE ADMINISTRATION MODULE

62 TRACKER L&H USER GUIDE

• If you have enabled Windows authentication for your users, Use 
Windows is selected. Enter the person’s unique Windows User ID.

• If you have not enabled Windows authentication for your users, Use 
Tracker is selected. Enter the Tracker User ID and temporary 
Password for this person. You should supply each user with an initial 
password and have them change it to a password meaningful to them 
alone the first time they log in to Tracker.

See Setting User ID and Password Authentication on page 24 for more 
information about Windows authentication.

8. Enter this person’s Department information. Address information will be 
automatically populated according to the department entered. You can 
change this information if necessary. (See Entering or Editing General 
Information for Companies on page 35.)

9. Enter this person’s contact information, including their Phone numbers, 
Extension, Address and E-Mail address. (Formatting rules apply.)

10. To enable a signature image for this user (for use in certain custom letters):

a. Check the Signing Authority check box. This activates the other fields 
in this section.

b. Click the browse button  to browse for the file where this user’s  
signature image file has been stored. Select Browse DMS if the file is 
located in a DMS.

11. Enter this user’s User Type and State License information (if applicable). 
The User Type is used to assign Company Resource information . See Enter 
resource information for a new company on page 44 for details.

12. Click OK to save this information and return to the User list dialog.

13. Repeat steps 2 to 13 for other users you want to add.

14. When finished, click Close.
 

Changing User Profile Information

You can change user profile information.

Method: Change user profile information

1. Select Admin > Users.

The Users list dialog displays.

Note The signature image file must be in BMP or JPG format. The size of the signature 
image will be adjusted to 1.5 inches wide by 0.5 inches high (a ratio of 3:1). 
Signature images with a different dimensional ratio will appear stretched or 
compressed.
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2. Click the user record whose information you want to change.

3. Click Edit to open the related User Profile dialog box.

4. Make any necessary changes.

5. Click OK to save your changes and return to the Users list dialog.

6. Click Close to exit the Users list dialog.

Deleting User Profiles

You can delete a user profile if that user is no longer required to access your 
Tracker system.

If you try to delete a user affiliated with a filing, an error message appears stating:

This user is linked to filings and cannot be deleted.

Method: Delete a user profile

1. Select Admin > Users.

The Users list dialog displays.

Note You cannot delete any user associated with filings. This is any of the following 
users: 

• a filing group manager

• a filing manager

• any user who has performed an activity on a filing.
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2. Click the user record you want to delete.

3. Click Delete.

A message appears confirming whether you really want to delete this user.

4. Click Yes to confirm the deletion (or No to cancel the deletion) and return to 
Users.

The deleted user will no longer appear on the list.

5. Repeat steps 2 to 4 for other users you want to delete.

6. When finished, click Close.
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Custom Tables

Tracker contains a number of custom tables which you can configure with values 
and terminology used in your organization 

The following sections discuss custom tables:

• Understanding Custom Tables on page 65 contains overview information on 
custom tables.

• Performing Custom Table Tasks on page 70 describes how to work with 
custom tables.

• Activity Codes on page 73 describes how to work with activity codes.

• Recurrent Filing Activities (Calendar Filings) on page 82 describes how to 
create recurring filing activities.

• Mapping Custom LOBs to Standard LOBs on page 83 describes how to use 
your company’s own LOBs with Tracker.

Understanding Custom Tables

The following section lists each custom table, with a brief description of its 
purpose in the system. For the tasks you can perform with custom tables, see the 
topics starting with Performing Custom Table Tasks on page 70.

Each custom table consists of:

• a list box, listing the default members of that table

• a series of dialog boxes which are activated when you want to add, edit or 
delete an entry in the custom table

The tables which can be customized within Tracker are:

• Activity Codes on page 66

• Advisory Organizations on page 66

• Attachment Types on page 66

• Eligible Groups on page 66

• Filing Method (Rate) on page 75

• Filing Types on page 67

• Form Types on page 68

• Legislation Status on page 69

• Legislation Type on page 69

• LOB Mapping on page 70

Important All custom tables must be configured and all necessary information entered before 
you begin to use the Tracker system to prepare and manage filings.
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• Print Status on page 70

• Solicitation Methods on page 70

Activity Codes

This table contains a listing of all of the activity codes active in the Tracker 
system. Tracker comes with a set of default activity codes which you can use to 
perform a wide variety of tasks, from making notes to recording instructions and 
responses to generating complete filings. You can edit, rename, or add to these 
standard activities. You can also delete or obsolete activity codes if required.

See also Activity Codes on page 73

Advisory Organizations

This table contains a listing of the default Advisory Organizations from which 
your company receives legislation, or with which your company deals, such as 
ACLI, WESTLAW, and so on.

Attachment Types

This table contains a listing of the default other attachment types for documents 
other than rates, advertisements, and forms that you might need to include in your 
filings.

The default other attachment types included with the system are:

• Actuarial Memorandum

• Certification

• Check List

• Filing Form

• Other

(See Other Attachments on page 187 for more details on working with other 
attachment types.)

Eligible Groups

This table contains a listing of the group market types available in your system. 
The standard types included with the system are:

• Association Group

• Blanket

• Credit Union

• Credit/Debtor Group

• Dependent Group

• Discretionary Group

• Employer/Employee
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• Labor Union

• Non Employer Group

• Trustee

The Group Market Type Description field contains the name you use to describe 
the eligible group in your organization. While Tracker allows for customization, 
SERFF has predefined choices that you must use so you will need to map your 
custom choices to one of the pre-defined SERFF choices so that the correct value 
is passed to SERFF. 

Filing Method (Rate)

This table contains a list of the options for the Filing Method field drop down 
menu on the Rate tab. The standard filing methods included with the system are:

• File and Use

• Prior Approval

• Use and File

Filing Types

This table contains a list of the default filing types available for use. The standard 
types included with the system are:

• Advertising

• Advisory

• Annual

• Blanket

Note If you map your choice to Other, when the value of Other is passed to SERFF, it 
will be appended with your custom description.

Note You can add, modify and delete custom filing methods, but the standard ones cannot 
be deleted.
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• General Reference

• Group

• Individual

• Informational

• Other

Form Types

This table contains a listing of the default types of forms which may be required to 
be used in filings. The standard types included with the system are:

• Amendment

• Application

• Certificate

• Contract

• Covers/Jackets

• Endorsement

• Enrollment Form

• Notice

• Policy Form

• Rider

• Schedule

• Supplement

The Form Type Description field contains the name you use to describe the form 
type in your organization. While Tracker allows for customization, SERFF has 
predefined choices that you must use so you will need to map your custom choices 
to one of the pre-defined SERFF choices so that the correct value is passed to 
SERFF.

The list of SERFF form types is a follows:

• ADV - Advertising

• AEF - Application/Enrollment Form

• CER - Certificate 

• CERA - Certificate Amendment, Insert Page, Endorsement or Rider 

• DDP - Data/Declaration Pages

• FND - Funding Agreement (Annuity, Individual and Group) 

• MTX - Matrix

• NOC - Notice of Coverage

• OTH - Other
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• OUT - Outline of Coverage

• POL - Policy/Contract/Fraternal Certificate

• POLA - Policy/Contract/Fraternal Cert: Amend/Insert Pg/End/Rider

• PJK - Policy Jacket

• SCH - Schedule Pages 

Legislation Status

This table contains a listing of the default statuses of legislation that you receive 
and enter into your system. The default types included with the system are:

• Administrative

• Advisory

• Approved

• Filed

• To Be Effective

Legislation Type

This table contains a listing of the types of legislation that you receive and enter 
into your system. The default types included with the system are:

• Advanced Law

• Line Circular

• Premium Comparison

• Statistical Plan

Note The default form types provided are all mapped to Other. Therefore, even if you do 
not add your own custom form types, you should still map the system-provided 
form types to the appropriate SERFF form type.
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LOB Mapping

You may have defined line of business codes in Tracker to correspond to your 
organization’s products and traditional codes. For example, you may have coded 
the Group Health Conversion line of business as GC, GHC, or CV.

Tracker, however, does not recognize organization-specific LOB codes. Before 
people in your organization can create filings using these codes, you must “map” 
them to equivalent standard lines of business. See Mapping Custom LOBs to 
Standard LOBs on page 83.

Print Status

This table contains a listing of the default print statuses used by your company in 
the Tracker system. Print Status codes are established in Tracker to help monitor 
the production process. Here, the term Print Status refers to the various stages 
involved in printing and sending a completed filing. Standard Print Status codes 
include:

• First Proof

• Forms Available

• Mailing Completed

• Mailing Schedule

• Not Applicable

• Orig. Copy Sent

• Project Complete

• Proof Approved

• Second Proof

• Sent To Printing

• Third Proof

Solicitation Methods

This table contains a listing of default business solicitation methods that your 
company might use. The standard types included with the system are:

• Agent/Broker

• Financial Institutions

• Mass Market

Performing Custom Table Tasks

The method for entering and altering custom tables information is similar for most 
of the tables. The basic set of tasks is:

• Viewing Custom Tables on page 71
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• Entering Information into Custom Tables on page 71

• Changing Information in Custom Tables on page 72

• Deleting Custom Table Elements on page 72

Viewing Custom Tables

You view all custom tables in the same way.

Method: View a custom table

1. Select Admin > Custom Tables.

2. Select the custom table you want to work with from the list.

The selected custom table is displayed.

3. To view the properties of an entry, select the entry and click Edit.

4. When finished viewing the entry, click Cancel.

5. Repeat steps 2 to 4 to view other entries in a custom table.

6. When finished, click Close.

Entering Information into Custom Tables

When Tracker is installed, the custom tables have default data entered already. 
You can also add more information to a custom table.

Method: Enter information into a custom table

1. Select Admin > Custom Tables.

2. Select the custom table you want to work with from the menu list.

The selected custom table is displayed.

3. Click Add. 

The Add dialog displays.

4. Enter information for the new item.

5. Click OK to save the information and return to the custom table.

6. Repeat steps 3 to 5 for additional new items.

7. When finished, click Close.
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Changing Information in Custom Tables

Method: Change information in a custom table

1. Select Admin > Custom Tables.

2. Select the custom table you want to work with from the menu list.

The selected custom table is displayed.

3. Click the record you want to change.

4. Click Edit.

The form for that custom table item is displayed.

5. Make any required changes.

6. Click OK to save your changes and return to the list box.

7. Repeat steps 3 to 6 to change any other items in this custom table.

8. When finished, click Close.

Deleting Custom Table Elements

• Activity Codes

• Advisory Organizations

• Filing Types

• LOB Mappings

Method: Deleting information from a custom table

1. Select Admin > Custom Tables.

2. Select the custom table you want to work with from the menu list.

Warning While each table can be added to or edited using function buttons by users having 
the appropriate security access levels, changes to the custom tables can have far 
reaching effects on the Tracker system and your Tracker environment. Please contact 
Oracle Global Support before making changes to these tables following initial 
system set-up.

Warning While items can be deleted from custom tables by users that have the appropriate 
security access levels (provided the item has not been used in a filing), deleting items 
from some custom tables is not recommended because of the potential effects on the 
Tracker system and your Tracker environment. Please contact Oracle Global Support 
before making changes to the default entries in the following custom tables:
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The selected custom table is displayed.

3. Click the record you want to delete.

4. Click Delete.

A confirmation message appears.

5. Click Yes to delete the record or No to cancel.

6. Repeat steps 3 to 5 for other records you want to delete.

7. When finished, click Close.

Activity Codes

Activity codes are accessed via Admin > Custom Tables > Activity Codes. You 
can add, obsolete and delete activity codes. To use activity codes to work with 
recurrent activities, see Recurrent Filing Activities (Calendar Filings) on page 82.

This section describes

• Adding Passive Activity Codes on page 73

• Adding Active Activity Codes on page 82

• Changing Activity Codes on page 85

• Obsoleting and Reactivating Activity Codes on page 86

• Deleting Activity Codes on page 88

Adding Passive Activity Codes

Passive activities are activities that do not update or generate any data inside your 
filings. It is possible to set passive activities to occur in the future (that is, post 
activities), and also to recur over a given time period.

Method: Adding a passive activity code

1. Select Admin > Custom Tables > Activity Codes.

The Activity Codes list opens, with the In Force activity codes displayed.
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2. Click Add.

The Activity - Add dialog displays.

3. Enter a short Activity Code by which the activity can be easily identified, 
such as MEM for a Create Memo activity.

4. Enter a brief Description of the activity.

5. In the Applies To field, enter the level of the Tracker system from which 
this activity may be accessed – All, Filing Group, Filing, or Legislation.

6. Select Future Allowed if this activity will be used as a post activity.
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7. Click OK to save your addition and return to Activity Codes.

8. Repeat steps 2 to 7 for additional Activity Codes.

9. When finished, click Close.

Adding Active Activity Codes

Active activities are activities that update or generate data inside your filings. 
Activity codes associated with active activities can only be applied to filings.

Method: Add an active activity code

1. Select Admin > Custom Tables > Activity Codes.

The Activity Codes list opens, with the In Force activity codes displayed.

2. Click Add.

The Activity - Add dialog displays.
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3. Enter a short Activity Code by which the activity can be easily identified, 
such as MEM for a Create Memo activity.

4. Enter a brief Description of the activity.

5. Click the Applies To drop-down menu and select Filing.

6. Select Is Active.

7. In the Activity Functions section, select the appropriate options to define 
the parameters and actions of the activity:

• Update Status – select the status to assign to the filing after this activity 
is performed

• Move to Filing Package Tab – select this option if you want the filing 
to be moved to the filing package when this activity is performed

• Generate Letter – select this option if you want to generate, view, and 
print a filing letter when this activity is performed

• Include Attachments – select this option if you want to allow 
attachments to be added to the filing when this activity is performed

• Lock Fee Details – select this option if you want to stop filing fee 
payment information from being changed after this activity is performed

8. In the Update Dates section, to affiliate a date with an activity, make a 
selection from one, two, or three of the drop-down lists.
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9. Click OK to save your changes and return to Activity Codes.

10. Repeat steps 2 to 9 for additional activity codes.

11. When finished, click Close.

Changing Activity Codes

You can change an activity code. This includes the name of the code, the 
parameters and actions of the activity, and you can mark unused or no longer 
needed activity codes as Obsolete. Activity codes that are not obsolete are In 
Force. You can only change activity codes that are In Force.

Drop-
down 
lists

Note If you affiliate Implementation Date with an active activity, a check box is 
displayed that lets you choose On Approval. If you select the On Approval check 
box, a user who performs the activity will have a choice between selecting a date or 
selecting On Approval. If you do not select the On Approval check box, a user 
who performs the activity must select a date; the user will not see the On Approval 
check box.
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Method: Change an activity code

1. Select Admin > Custom Tables > Activity Codes.

The Activity Codes list opens, with the In Force activity codes displayed.

2. Click the activity code you want to change.

3. Click Edit. 

The Activity – Edit dialog displays.

4. Make any necessary changes.

5. Click OK to save your changes and return to Activity Codes.

6. Repeat steps 2 to 5 for other activity codes you want to change.

7. When finished, click Close.

Obsoleting and Reactivating Activity Codes

If you have an activity code that you are no longer using or do not need, you can 
mark it as obsolete. Obsoleting an activity code removes it from the list of 
currently available activities; it does not actually delete it from the Tracker 
database.

Activities that are not obsolete are called In Force. You can only edit or delete 
activity codes that are In force.

Important Changing activity codes that are part of the default Tracker installation can have far-
reaching effects on the Tracker system and your Tracker environment. Please 
contact Oracle Support before changing default activity codes following initial 
system setup.
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Method: Obsolete an activity code

1. Select Admin > Custom Tables > Activity Codes.

The Activity Codes list opens, with the In Force activity codes displayed.

2. Click the activity code you want to obsolete.

3. Click Obsolete.

The selected Activity Code is made obsolete. It is removed from the In 
Force list. It can be found in the Obsolete list.

4. Repeat steps 2 and 3 for other activity codes you want to obsolete.

5. When finished, click Close.

Method: Reactivating an obsolete activity code

1. Select Admin > Custom Tables > Activity Codes.

The Activity Codes list opens, with the In Force activity codes displayed.
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2. Click the Obsolete list selector.

The list of obsolete activity codes is displayed.

3. Click the Activity Code you want to reactivate.

4. Click Reactivate.

The Activity Code is reactivated. It is removed from the Obsolete list. It 
can now be found in the In Force list. 

5. Repeat steps 3 and 4 for other activity codes you want to reactivate.

6. When finished, click Close.
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Deleting Activity Codes

If an activity code has never been used and is no longer needed, you can delete 
it.See Obsolete an activity code on page 79.

Method: Delete an activity code

1. Select Admin > Custom Tables > Activity Codes.

The Activity Codes list opens, with the In Force activity codes displayed.

2. Click the activity code you want to delete.

3. Click Delete.

4. Click Yes to confirm the deletion. 

The deleted activity code will no longer appear in the list.

5. Repeat steps 2 to 4 for other activity codes you want to delete.

6. When finished, click Close.

Important You can only delete activity codes that are In Force.

Warning Deleting activity codes can have far-reaching effects on the Tracker system and your 
Tracker environment. Please contact Customer Support before deleting activity 
codes following initial system set-up.
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Recurrent Filing Activities (Calendar Filings)

You can create recurrent activities using the Activity Code dialog. For example, 
you can set up an activity to occur automatically every year on the same date, for 
annual filings or reports.

Creating Recurrent Filing Activities

You create a recurrent activity at the Filing level.

Method: Create a recurrent filing activity

1. Select Admin > Custom Tables > Activity Codes.

The Activity Codes list opens, with the In Force activity codes displayed.

2. Click Add.

The Activity - Add dialog opens.
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3. Complete the Code and Description entry boxes.

4. Click the Applies To drop-down menu and select Filing.

5. Select Recur Every.

6. In the entry boxes beside Recur Every, enter the number and the units for 
the applicable timeframe.

7. Click OK to save your changes and return to Activity Codes.

8. Repeat steps 2 to 7 for additional recurrent activities.

9. When finished, click Close.

Custom LOBs

This section describes:

• Mapping Custom LOBs to Standard LOBs on page 83

• Changing LOB Mappings on page 85

• Deleting LOB Mappings on page 93

• Mapping Multiple LOBs to a Custom LOB on page 86

Mapping Custom LOBs to Standard LOBs

If you have entered lines of business that do not match the standard Tracker lines 
of business, then you will have to map them to the standard Tracker lines of 
business.
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You can still continue to create the multiple LOB mapping by clicking Yes. 
However, be aware that if you create this filing, its submission might not be 
accepted.

Method: Map a non-standard Line of Business to a standard Line of 
Business

1. Select Admin > Custom Tables > LOB Mappings.

The LOB Mapping dialog displays.

2. Click Add.

LOB Mapping - Add opens.

Important After you have finished mapping, you need to log out of Tracker, then log back in. 
This is required for any mapping changes take effect.

Note Multiple LOBs and SERFF Filings.

The SERFF system generally does not allow for multiple LOBs to be combined 
and submitted in a single filing. If you create a custom LOB that is mapped to two 
or more standard LOBs, a warning appears:

SERFF does not support creating the following file(s) for a Customized LOB 
that has been mapped to multiple standard LOBS.

Do you still want to continue?
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3. Enter your company’s Custom LOB Code.

4. Select the corresponding standard Available Line of Business.

5. Enter a brief Description of your company’s custom LOB.

6. Click OK to save the mapping.

7. Repeat steps 2 to 6 for other LOB mappings you want to make.

8. When finished, click Close.

Changing LOB Mappings

You can change LOB mappings.

Method: Change an LOB mapping

1. Select Admin > Custom Tables > LOB Mappings. 

LOB Mapping opens.

2. Click the LOB record you want to change.

3. Click Edit to open the related LOB Mapping dialog box.

4. Make any necessary changes and click OK.

5. Repeat steps 2 to 4 for other LOB mappings you want to change.

6. When finished, click Close.
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Deleting LOB Mappings

You can delete LOB mappings.

Method: Delete an LOB mapping

1. Select Admin > Custom Tables > LOB Mappings. 

The LOB Mapping dialog opens.

2. Click the LOB record you want to delete.

3. Click Delete.

A message appears asking you to confirm whether you really want to delete 
this mapping.

4. Click Yes to confirm the deletion (or No to cancel the deletion) and return to 
the LOB Mapping dialog.

5. Repeat steps 2 to 4 for other LOB mappings you want to delete.

6. When finished, click Close.

Mapping Multiple LOBs to a Custom LOB

This feature allows you to file for more than one line of business (LOB) in a single 
filing. This is useful for products that contain more than one LOB. You can set up 
a custom line of business that maps to multiple standard lines of business.

Method: Map multiple LOBs to a custom LOB

1. Select Admin > Custom Tables > LOB Mappings. 

The LOB Mapping dialog opens.

2. Click Add.

The LOB Mapping – Add dialog displays.

3. Enter the code for this LOB in Custom LOB.

4. Enter the Description for this LOB.

5. Select the lines of business to which you want to map the custom LOB. All 
of the available lines of business are listed in Available Lines of Business. 
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6. Click the right arrow button to include these standard LOBs in your custom 
LOB.

The LOBs are moved to To Map.
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7. Click OK to save the custom mapping.

If you are working with Tracker integrated with SERFF, a warning message 
appears.

8. Click Yes to continue and return to LOB Mapping.

9. Repeat steps 2 to 8 to create other multiple.

10. When finished, click Close.
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Reassigning Activities

This feature allows you to reassign Post Activities to another user.

Method: Reassign an activity

1. Select Admin > Reassign Activities.

Reassign Activities opens.

2. Click the From drop-down menu and select the name of the person from 
whom you want to unassign the activity.

3. Click the To drop down box and select the name of the person to whom you 
want to reassign the activity.

4. Click OK to complete the reassignment (or click Cancel to stop the 
reassignment).

Note The person you reassign the activity to is not automatically notified. You must do 
this by some other method, for example by leaving voice mail, updating your 
intranet portal, sending an email or fax, and so on.
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Administrative Reports

A number of reports are available to summarize various types of administrative 
information in the system. These administrative reports provide administrative 
level information about the companies and users in your system. For example, you 
can produce a report that lists authority information for every company in your 
system.

These reports are available only through the Administration menu, and are 
accessible only to users that have Administrator as their security level. For more 
information about non-administrative Tracker reports, please see Searching, 
Reporting, and Filing Summary on page 375.

The following administrative reports are available in Tracker:

• General Company Listing Report on page 90

• Companies with Authorities Listing Report on page 91

• User Listing Report on page 91

This section also describes Generating Administrative Reports on page 92.

General Company Listing Report

The General Company Listing Report provides general information about each 
company, related department, and user listed in your Tracker system.

This report displays the following fields:

• Company Name

• Company Code

• Name

• Address

• City

• State

• Zip

• Phone

• Fax

• Toll-Free Phone

• URL

• NAIC Group Code

• NAIC Company Code

• FEIN

• State of Domicile

• Country
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• SERFF ID

• Department Name

• Department Address

• Department State

• Department Zip

• Department Phone

• Department Fax

• Department Toll-Free Phone

• User Name

• User Designation

• User Title

Companies with Authorities Listing Report

The Company with Authorities Listing Report provides a list of all companies 
recorded in your Tracker system, together with the states and lines of business for 
which each is licensed.

This report displays the following fields:

• Company Name

• Company Code

• State

• Line of Business

User Listing Report

The User Listing Report provides detailed information about every Tracker user 
listed in your system.

This report displays the following fields:

• User Name

• Department

• Insurance Type

• User Group

• Prefix

• First Name

• Middle Initial

Note Currently, the SERFF IDs of companies are not captured in this report.
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• Last Name

• Initials

• Title

• Access Level

• Phone

• Fax

• Toll-Free Phone

• Email Address

• Professional Designation(s)

• Address

• City

• State

• Zip

• Country

• Signing Authority

Generating Administrative Reports

Administrative Reports are produced in the same manner as all standard Tracker 
reports. (See Searching, Reporting, and Filing Summary on page 375 for more 
information.)

Method: Generate an administrative report

1. Select Admin> Reports.

The Reports dialog displays.

2. Select the report you want to produce.

3. To generate the report with default values, click Preview.

or

(if available) To change the selection criteria and sort order, follow these 
steps:

a. Click Parameters.

The report settings dialog displays.

b. Define the Selection Criteria which you want the report to encompass. 
Here a selection of fields appropriate to the report you are creating are 
presented. You can specify a single member for each field, or select All 
to generate a report for all the members of that field group.
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c. In Sort Order, enter the number corresponding to the field by which 
you want the report to be sorted.

d. Click OK.

Tracker generates the report you have specified using your dates, criteria, 
and sort order, and a preview of the generated report appears in a Crystal 
Reports viewer window.

4. Review the generated report.

If you need to make changes, close the preview window and redefine the 
report criteria.

5. To print the report, click Print.

The report prints to your default printer.
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Chapter 3

Logging into Tracker

When your Tracker administrator sets up your company’s Tracker system, every 
Tracker user’s computer will be provided with a single shortcut which you will 
use to access Tracker.

If the Windows Authentication login option is configured by your administrator, 
you will use your Windows ID and password to log into Tracker. With this option, 
you would therefore not need to enter a separate user ID and password to log into 
Tracker.

If you are not configured to use the Windows Authentication option, you must use 
the Tracker Login method.

Note: You Tracker administrator will implement the login method your organization will 
use based on your company’s requirements.

This chapter describes:

• Tracker Login on page 94

• Changing Your Tracker Login Password on page 95
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Tracker Login

Note: This section applies only if your Tracker administrator has not configured the 
Windows Authentication login option for your organization.

Your Tracker administrator will need to give you a Tracker Username and a 
Password to enter the Tracker system.

Your Username is the name or code which you use to identify yourself to the 
system. It is usually a version of your name, such as your first initial plus your last 
name, but it can be any selected code.

Your Password is a secret 6-20 character code which identifies you to the system. 
It is case-sensitive and can be made up of letters or numbers, or a combination of 
both. Initially, your Tracker administrator will give you your username and a 
temporary password to use when you first access Tracker.

Logging In

Method: Log in to Tracker

1. Double-click the Tracker shortcut on your desktop . The Tracker 
splash screen appears briefly, displaying version and identification 
information about Tracker.

If you are configured to use the Windows Authentication login: you will 
be logged into Tracker automatically.

If you are not configured for Windows Authentication login, the LogIn 
box opens. Follow these steps:

a. Enter your Username and your Password. Note that the password 
appears onscreen as a series of asterisks, to protect your privacy. 
Passwords are case-sensitive.

b. Click OK.

In a few seconds, the Tracker Top Level screen appears.

Note: If you enter your Tracker login username or password incorrectly, an error 
message appears indicating that you have made a mistake. You can then try to 
enter your password two more times; if it is still incorrect, Tracker will close and 
you will need to contact your Tracker Administrator, who will enable you to 
create a new Tracker login password.
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Changing Your Tracker Login Password

Note: This section applies only if your Tracker administrator has not configured the 
Windows Authentication login option for your organization. 

Your Tracker administrator will give you your username and a temporary 
password to use when you first access Tracker.

After entering the Tracker system for the first time, you should change your 
password to something that is meaningful to you. You may change your password 
at any time, from any point in the system.

Method: Change your Tracker login password

1. Select View > Options > Password.

The Change Password dialog displays.

2. Enter your Old Password (it will display as a series of asterisks).

3. Enter the New Password you have chosen (it will display as a series of 
asterisks).

4. Enter your New Password a second time, so that the system can verify it.

5. Click OK.

Your password has been changed.
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Chapter 4

Products and Filing Groups

Products are the top level of Tracker. They contain filing groups, and each filing 
group contains a set of related filings. Each filing is ultimately used to create a 
filing package, which is then submitted to each state Department of Insurance.

You work with products in the Filing Module of Tracker. See Filing Module on 
page 9 for more information.

This chapter describes:

• Working with Company Products on page 98

• Working with Filing Groups on page 102
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Working with Company Products

You must create a company product before you can create any filing groups or 
filings.

This section describes:

• Creating a New Company Product on page 98

• Editing Company Products on page 99

• Deleting Company Products on page 100

Creating a New Company Product

Use the following method to add a company product.

Method: Add a new company product

1. Select File > Company Product.

The Company Product list box displays.

2. Click Add.

3. The New Company Product dialog displays.
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4. Enter the 8-character Code (name) of the new product, and a short 
Description.

5. Click OK to return to the Company Product dialog.

The product you just added will now appear in the list of products.

6. Click Close.

Editing Company Products

Use the following method to edit a company product.

Method: Edit a company product

1. Select File > Company Product.

The Company Product list box displays.

2. Click the product you want to edit and click Edit.



PRODUCTS AND FILING GROUPS

100 TRACKER L&H USER GUIDE

3. Edit the Description as required.

4. Click OK to save the company product.

5. Click Close.

Deleting Company Products

Use the following method to delete a company product.

Method: Delete a company product

1. Select File > Company Product.

The Company Product list box displays.

2. Select the product you want to delete and click Delete.

Note You cannot edit the company product code.
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A confirmation dialog appears.

3. Click Yes to delete the product. Click No to cancel deleting the product.

The appropriate action occurs.

Note If the product has filing groups associated with it and you click Yes, the product will 
not be deleted. You will see the following error message:

Unable to delete company product; it is used by existing filing groups.



PRODUCTS AND FILING GROUPS

102 TRACKER L&H USER GUIDE

Working with Filing Groups

After you have created a company product, you can add filing groups to it to 
organize your filings.

The following tasks deal with filing groups:

• Adding a New Filing Group on page 102

• Viewing the Filing Groups for a Specific Product on page 105

• Accessing a Filing Group Record on page 105

• Viewing Filing Group Tabs on page 106

• Entering a Filing Group Code on page 106

• Overriding the Filing Group Code Number on page 106

• Creating a Filing Group Past 99999 on page 107

• Creating Filing Groups in a Multi-User Environment on page 107

Adding a New Filing Group

You can add a new filing group at any time using the File menu New Filing 
Group command.

The keyboard shortcut Ctrl + N will also access the New Filing Group dialog; it 
can be used from most main screens. It cannot be used when the File menu is 
open.

Method: Add a new filing group

1. Select File > New Filing Group, or click the New Filing Group button. 
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The New Filing Group dialog 
displays.

2. Enter a Product by selecting one from the drop-down list.

3. In Filing Group #, you can:

• let Tracker assign a system-generated filing group code

• select the Override check box and enter a different filing group code

4. Enter the filing group FG Name, FG Description, FG Mgr (Manager), 
and Date information. The FG Mgr and Date fields will be automatically 
filled in with your name and today’s date (which you may change if 
desired).

Tip: FG Name and FG Description should be the same. Product and FG Name 
should be different.

5. Complete the Custom text box, if required.

6. If required, complete the following fields. The values you enter will be 
populated into this filing group’s filings.

• On the Mkt (Market) Type drop-down list, select Franchise, Group, or 
Individual. Making a selection of Group unlocks the drop-down list 
buttons for Grp Mkt (Group Market) Size and Grp Mkt Type.

• If unlocked, on the Grp Mkt Size drop-down list, select Small, Large, 
or Small & Large.

• If unlocked, on the Grp Mkt Type drop-down list, select one or more 
check boxes. The default list includes Association Group, Credit 
Union, Credit/Debtor Group, Dependent Group, Discretionary 
Group, Employer/Employee, Labor Union, and Trustee. (The Non-
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Employer Group option is only available at the Filing level.) Click 
outside the list to close it. The first 30 characters of the list of selected 
group market types is displayed in the Eligible Group field.

Tip: Hold the mouse pointer over the field to display a tooltip with the entire list of 
selected group market types displayed. 

• If required, on the Policy drop down list, select Direct Issue, Trust, or 
Trust & Direct Issue.

• Select the type of Solicitation from the drop down list. The default list 
includes Agent/Broker, Financial Institutions, and Mass Market.

7. To create the filing group and exit the dialog, click Create.

The new filing group is added.

OR

To proceed to create filings for this filing group immediately, ensure you 
have selected a product and click New Filing(s).

8. If you want to exchange of any filing item, select the ‘Yes’ option from  the 
Include Exchange Intentions section. This new field is added to indicate if 
any item is offered on exchange on PPACA eligible filings.

9. The ‘Exchange Intentions’ comment box is enabled where you can fill 
details up to 1000 characters.

Note The default option is set as ‘No’.
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10. Click the pop-up ‘Message box’ to include your comments for the exchange 
option. 

Viewing the Filing Groups for a Specific Product

Follow these steps to view the filing groups for a specific product.

Method: View the filing groups for a specific product

1. Navigate to the Top level.

2. On the Filing Group header, locate the Product field.

3. From the Product field drop-down list select the product whose filing 
groups you want to view. 

The filing groups for this product will appear on the Filing Groups list tab.

4. When you select (highlight) a filing group on the list, the related basic 
information for that filing group will appear in the Filing Group header 
fields.

Changing Filing Group Settings

You can change some of a filing group’s settings (the ones that are not greyed out) 
by selecting or entering new values, and saving.

Accessing a Filing Group Record

You may access a single filing group record from the Tracker Top level via the 
Filing Groups tab.

Note For more information on how to work with filings after clicking New Filing(s), see 
Adding New Filings on page 116.
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On the Filing Groups tab, select the filing group you want to view and double-
click it to view the details of this filing group.

Method: Browse through the filing group files

You can browse through the filing group files, moving from one filing group to 

another, by using the Back  and Forward  toolbar buttons or equivalent 
Edit menu options.

Viewing Filing Group Tabs

In addition to the filing group header, a filing group contains the following tabs:

• The My Filings Tab and Filings Tabs – For details, see Accessing Filing 
Records from the Filing Group Level on page 125.

• The Activities Tab – Filing Group Level on page 211

• The Rates Tab — Filing Group Level on page 151

• The Advertisements Tab — Filing Group Level on page 172

• The Forms Tab — Filing Group Level on page 134

• The Other Attachments Tab – see Other Attachments on page 187

• The NAIC Filing Description Tab – see NAIC Filing Descriptions on page 
193

Entering a Filing Group Code

The Filing Group Code is a five-character numeric code used to identify a group 
of related filings (such as all the filings in a multi-state filing). You can create as 
many filing groups as required within a given product. Tracker will automatically 
provide the next number in the series when a new filing group is created. This 
automatic assignment of numbers can be overridden at the time of creation (see 
details below).

Overriding the Filing Group Code Number

Tracker will automatically choose the next number in the filing group series each 
time you create a new filing group. You will see this in the Filing Group field 
when you access the New Filing Group dialog box. If you want to change this 
code to a different number, click in the Override box, and then manually enter the 
number you want. Note that you cannot enter a number which already exists in the 
system. If you do, an error message appears and you will need to re-enter the 
Filing Group Code.

Note If you override the filing group code with a larger number, Tracker will 
automatically number subsequent filing groups continuing from that new larger 
number.
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Creating a Filing Group Past 99999

When you are creating a filing group and your system has reached 99999, the 
system automatically rolls over and begins searching from 00001 to look for the 
next available filing group number (for example, 00010 might be the next 
available unused number). 

Creating Filing Groups in a Multi-User Environment

You can create a filing group while other users are simultaneously creating filing 
groups. If more than one user creates a filing group at the same time, Tracker 
assigns each user a different number (in sequential order). When the filing group 
is successfully entered, a message box opens indicating the filing group number 
that has been assigned to the group you just created. 
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Chapter 5

Working with Filings

This chapter provides detailed information about working with filings in Tracker, 
whether you are using paper-based filings or working with SERFF. 

This chapter describes:

• Adding New Filings on page 108

• The My Filings — All Tab on page 115

• Filing Header on page 119

• Filing Tabs on page 121

• The Filing Details Tab on page 122

• Forms on page 126

• Rates on page 151

• Advertisements on page 164

• Linking Related Filings on page 177

• Other Attachments on page 179

• NAIC Filing Descriptions on page 185

• Entering Filing Fees on page 187

• Copying Filings on page 190
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Adding New Filings

Typically, you add a new filing or filings while creating a new filing group, or 
from within an existing filing group. (New filings can also be created after 
completing a recurrent activity or while viewing Legislation). Tracker will 
automatically make the new filing a member of whatever filing group you are 
working in. A new filing you add to an existing filing group will automatically 
have all the attachments (schedule items) that are currently in the filing group, as 
well as any added later.

Note: Multi-state filings are created in the same manner as single filings. The process 
simply generates more than one related filing under the same filing group.

New filings are added using the Create New Filing(s) dialog. There are three tabs 
on this dialog:

• Details: used to select Type and CLS combinations

• Product/Filing Group Setup: used to add common settings for filings 
(Filing Type, Start Date, Filing Description, Filing Manager, Custom, and 
Company Reference #)

• Filing Setup: used to add or modify the settings entered on the Product/
Filing Group Setup tab, and to add the Company Reference # and NAIC 
Filing Description.

Important: The Filing Description field plays a critical role in organizing filings. Since a user 
can create filings with the same Company, LOB and State in the same Filing 
Group, a Filing Group may contain several filing projects. The Filing Description 
field is the unique identifier for each filing project in a Filing Group. It is critical 
that a user does not use the same Filing Description for separate filing projects in 
the same Filing Group.

Method: Add a new filing or filings

1. While creating a new filing group (see Adding a New Filing Group on page 
110), click New Filing(s)

OR

At the Filing Group level, click the New Filing button .

The Create New Filing(s) dialog opens, and the Details tab is displayed.
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2. Select the appropriate Type check boxes.

Note: At least one Type must be selected. 

3. Click Add/Modify.

The Add/Modify CLS dialog displays.

4. Enter a Filing Description by doing one of the following:

• To add new filings to a new project, leave the default text “Create New 
Filing Project” in the Filing Description.

OR
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• To add filings to an existing filing project, click the down-arrow button 
to display the list of all filing descriptions in the filing group, and select 
one or more filing descriptions from the list. If you make multiple 
selections, then each selection displays in the field separated by a 
comma.

Note: The Filing Description cannot be changed after selecting one or more CLSs. To 
change the Filing Description after selecting one or more CLSs, remove all CLSs 
from the Selected list.

5. From the Available list on the left, choose the desired company/state/line of 
business (CLS) combination(s) for this filing.

• The CLS combinations shown in the list are determined by the 
administrative setup. They are grouped first by company and then by 
state (default) or by LOB, depending on the position of the By LOB 
button above the Available list. You can toggle between the two views 
as often as you require. 

• Companies listed are licensed for a least one LOB in one state.

• The list shows only those LOBs for which the company is licensed.

• Expand branches of the list by clicking any of the + buttons.

• Select the check box beside each desired CLS combination.

6. When you have finished selecting LOB combinations, click the right arrow. 

The selected combination(s) appear in the Selected list.

Tip: If you double-click a CLS combination in the Available list or the Selected list, it 
will immediately move to the other list. You can also use the double arrow button 
to move all LOB combinations from one list to the other. 

Note: At least one CLS combination must be selected.

7. When you are satisfied with all the information displayed, click OK.

Tracker saves the CLS selections and closes the Add/Modify CLS screen. 
The Details tab displays with the new CLS selections in the CLS table.

8. Click the Product/Filing Group Setup tab.

The Product/Filing Group Setup dialog displays.
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In the filing group, you may optionally complete the following fields:

• Filing Type

• Start Date

• Filing Description

• Filing Manager

• Custom

• Company Reference #

Note: The purpose of these Filing level fields in this dialog are to give you a start on 
populating the Filing level fields on the Filing Setup tab. Each field populated on 
this screen will apply to all filings on the Filings Setup tab. You are not required 
to populate any of these fields on this screen. You can go directly to the Filing 
Setup tab to populate these Filing level fields if desired.

9. When you have finished, click the Filing Setup tab.

The Filing Setup dialog displays.
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A drop-down list of system-numbered CLS combinations is created. 
Selecting a CLS combination from the drop-down list displays that CLS 
combination’s information (the Company, LOB, and States). A table of 
filings for that CLS combination is also displayed.

10. Choose a CLS combination from the CLS drop-down list.

The system displays that CLS combination’s information and populates the 
table with values based on entries made in the Filing section of the Product/
Filing Group Setup tab.

11. Select a filing and click Edit Filing (or double-click on the filing).

The Edit Filing dialog displays.
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12. Complete or revise the fields.

Note: Fields marked with an asterisk are required.

13. When finished, click OK.

The Edit Filing dialog closes, the new or modified entries are saved, and the 
Filing Setup tab displays.

14. Repeat steps 10 to 13 for all CLS combinations and filings until the 
information on all filings is complete.

15. Click Create.

Tracker displays a status box that updates as the filings are created.

16. When the status box indicates that the process is done, click Close. 

The newly created filing(s) will appear on your My Filings tab, My Filings 
— All tab of the Filing Manager, and the Filings tab in the appropriate 
Filing Group.

Each filing is assigned a 14-character Tracker Filing ID based on the 
following:

• 2-character State Code

• 5-digit Filing Group number

• 2-digit Company Code

• 5-digit sequence number (counter of filings created in that filing group)

Notes:

• For states that do not allow combined filings, Tracker will split the filings 
into separate rates, advertisements, and forms where applicable.

• The sequence number portion of the Filing ID does not recycle numbers of 
deleted filings.
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The My Filings — All Tab

The My Filings — All tab displays a list of all of the filings in the system where 
you are assigned as the filing manager. From here, you can directly access the 
filing details for any of your filings.

The My Filings — All tab can show all of your filings, or be filtered to show only 
those filings of a particular status (such as Started, Pending, or Closed) or only 
those with a Suspense Date (pending future action) attached.

Accessing the My Filings — All Tab

The My Filings — All tab can be accessed at any time from any point within 
Tracker using the View Menu option: View My Filings — All.

1. Select the View menu.

2. Select the View My Filings — All option. The Top Level with the My 
Filings — All tab will be displayed. 

Sorting the My Filings — All Tab

The Filing Description field is the unique identifier for each filing project in a 
Filing Group. As a result, the default sort order is first sorted by the Filing 
Description field so that each filing project is displayed together.

The default sort order of the My Filings - All tab is as follows:

• Filing Description (ascending)

• State (ascending)

• LOB (ascending)

• FG # (descending)

• Company Code (ascending)

• Content (ascending)
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You can change the sort order by right-clicking a column header and select a new 
sort order from the context menu.

A sort on any column uses the following sort order where the first sort criterion is 
always the column selected for the sort:

• [column selected] (ascending or descending based on selection)

• State (ascending)

• LOB (ascending)

• FG# (descending)

• Company Code (ascending)

• Content (ascending)

• Filing Description (ascending)

Example #1: a sort initiated on the State column in ascending order is:

• State (ascending)

• LOB (ascending)

• FG # (descending)

• Company Code (ascending)

• Content (ascending)

• Filing Description (ascending)

Example #2: a sort initiated on the LOB column in ascending order is:

• LOB (ascending)

• State (ascending)

• FG # (descending)

• Company Code (ascending)

• Content (ascending)

• Filing Description (ascending)

Example #3: a sort initiated on the Content column in ascending order is:

• Content (ascending)

• State (ascending)

• LOB (ascending)

• FG# (descending)

• Company Code

• Filing Description

Tip: When a custom sort order selection is made, it is maintained until that user logs 
out.



THE MY FILINGS — ALL TAB

TRACKER L&H USER GUIDE  117

Filtering the My Filings — All Tab

You can filter your My Filings — All tab to display only the filings of a certain 
status group (or groups) which you define. On the Filing Group Header, there are 
located several status markers which tell you how many filings of each status 
(such as Started, Pending, Approved) are currently contained within a single 
filing group. Beside each of these status markers is a check box which can be used 
to define the status-types of filings you want to see.

There is also a Suspended button located to the right of these check boxes. If 
pressed, only those filings having the status(es) specified and having a Suspense 
Date (future activity) attached will be listed. By using this feature you can list 
only those filings requiring your immediate attention.

Method: Filter the My Filings — All Tab

1. On the Filing Group Header, locate the Filing Status check boxes.

2. Click in the boxes beside each status type you want to appear in the My 
Filings — All tab.

3. If you want to view only filings having a Suspense Date attached, click the 
Suspended button located to the right of the checkboxes.

4. In the My Filings — All list, only filings having a status which you have 
selected will appear.

Method: Access a single filing

• On the My Filings — All tab select the filing you want to view and double-
click it to open the related details of the filing.

Accessing Filing Records from the Filing Group Level

You can access a single specific filing from its related Filing Group level using the 
My Filings tab or the Filings list tab.

The My Filings tab displays a list of all of the filings in the selected filing group 
where you are assigned as the filing manager. The Filings tab displays a list of all 
of the filings in the selected filing group, including those where others are 
assigned as the filing manager. 

The Filing Description field is the unique identifier for each filing project in a 
Filing Group (see Create Filing Section). As a result, the default sort order is first 
sorted by the Filing Description field so that each filing project is displayed 
together.

See also Sorting the My Filings — All Tab on page 115.
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Method: Access a filing from a Filing Group level

1. Navigate to the filing group with the filing you want to access.

2. On the My Filings tab or Filings list tab, double-click the filing you want to 
view.

The Filing level view of the filing displays.

Browsing through the Filing Records

You can browse through the filing records within a filing group, moving from one 

filing record to another, by using the Back  and Forward  toolbar 
buttons or equivalent Edit menu options.
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Filing Header

This area of the Filing screen contains detailed information about the filing, as 
well as information about the filing group to which the filing belongs.

The Filing level is designed to give you quick and easy access to all your filing 
information.

The Title Bar shows the product code and the Identification Number.

The Filing Group Header shows the associated Filing Group #, FG Name and FG 
Description, the product that the filing group is a part of, and start date.

The Filing Header shows these fields:

• (filing) Description

• (start) Date

• Filing Type

• Filing Manager

• (content) Type — Rate, Advertisement, Form, or a combination

• Mkt Type (Market Type)  — required for PPACA filings.

• Grp Mkt Size (Group Market Size)  — enabled when the Market Type is 
Group; required for PPACA filings.

• Grp Mkt Type (Group Market Type)  — enabled when the Market Type is 
Group; required for PPACA filings.

• Policy

• Ind Mkt Type (Individual Market Type) — enabled when the Market Type is 
Individual.

• Solicitation

• Company

• State

Market 
Fields

Filing 
Header

Tabs

Title Bar
Menu Bar
Toolbar

Filing
Group 
Header 
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• Line of Business

• File Status

• Related Filings for this filing.

Below the Filing Header are various tabs that contain additional information. The 
tabs shown at the Filing level are as follows:

• Filing Details

• Resources

• Comments

• Activities

• Forms (if it is a form filing)

• Rates (if it is a rate filing)

• Advertisements (if it is an advertisement filing)

• Filing Package

• Other Attachments

• NAIC Filing Description

• Filing Fee

• SERFF (if viewing a SERFF filing)

The Tracker Filing ID

Each filing in the system is assigned a unique identification code to help you keep 
track of your filings.

This Tracker identification code is comprised of four elements:

• a State code (two digits)

• a Filing Group number (five digits)

• a Company Code (two digits)

• a Sequence number (five digits)

Note: The sequence number is a running count of all filings in a filing group. When a 
new filing is created in an existing group, the system assigns the next sequential 
number.
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Filing Tabs

Below the filing header are various tabs which contain additional information.

The filing tabs are described in the following sections:

• The Filing Details Tab on page 122

• The Resources Tab on page 204

• The Comments Tab on page 205

• The Activities Tab – Filing Level on page 206

• The Forms Tab — Filing Group Level on page 126

• The Rates Tab – Filing Level on page 151

• The Advertisements Tab — Filing Group Level on page 164

• The Filing Package Tab – see Activities and the Filing Package Tab on page 
229

• The Other Attachments Tab – see Other Attachments on page 179

• The NAIC Filing Description Tab – see NAIC Filing Descriptions on page 
185

• The Filing Fee Tab – see Entering Filing Fees on page 187
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The Filing Details Tab

The Filing Details tab records additional general, date, and progress tracking 
information about a single filing. It is specific to one filing alone, even if that 
filing is part of a group of related multi-filings. You should add information to this 
tab as it becomes available, throughout the course of the filing process.

Note: The Filing Details tab contains a lot of information, and depending on the size of 
your monitor and your desktop set-up, you may need to use the vertical scroll bar 
located on the right-hand side of the tab to see all of the available fields.

Entering Filing Details Information

Note: Some of the fields (including most date fields) on the Filing Details tab will be 
filled in automatically by the system as different activities are performed and 
posted for the filing, as the filing process progresses. Many fields can be changed 
if necessary.

Method: Enter filing details

1. In the References information section:

• Enter the Insurance Department File #, if any, assigned by the DOI.

• Enter the Company Reference #, if your company will be using another 
number different than, or in addition to, the Tracker filing identification 
number to identify this filing.

• Select the Statute. The default is No Statue.

• If necessary, enter text in the Custom field.

2. In the Date Status information section:

• The Start Date will be automatically filled in when you create the 
filing.

• The Approved, Approval Received, Disapproved, Deemer, Filed, 
Approved Effective, Withdrawn, Resubmitted, Respond By, 
Objection, Implementation, and Custom Date fields will be updated 
as you perform the activities associated with them over the course of the 
filing process and by certain messages received from SERFF.

Note: For PPACA filings, Implementation date is required; you will need to perform an 
activity that sets this date before you can submit the filing.
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• In the Days option, enter the number of days after submission that you 
want this filing to take effect.

• The field names for the four Custom Dates are assigned in System 
Defaults: see Performing Custom Table Tasks on page 78.

3. In the Print/Mail/Automation Status information section:

• The Scheduled Mail, Actual Mail, Rate Built, and EDP Rate 
Effective dates will be updated as you perform the activities associated 
with them over the course of the filing process.

• Update the Print Status as necessary.

4. At the bottom of the Filing Details tab:

• The Tracker Reference # refers to the identification number for this 
filing if it was transferred from a version of Tracker before 4.0.
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Schedule Items Overview

When it comes to adding schedule items to your filings, Tracker offers great 
flexibility. Schedule items—that is, forms, rates, advertisements, and other 
attachments—can be added to filings of any type. For convenience, if they are 
added at the Filing Group level, each filing in the filing group with a status of 
Start will automatically contain a linked copy of the schedule item, complete with 
any changes made at the Filing Group level at a later time (though this link can be 
broken by making certain changes at the Filing level).

Adding Schedule Items

Adding a schedule item to a filing is as simple as navigating to the filing and 
clicking the appropriate button on the toolbar.

Note: If you start adding a schedule item to a filing that has a different type (for 
example, adding a rate schedule item to an advertisement filing), Tracker will 
check to see if combined filings are allowed in that state. If they are not, you are 
prompted to cancel the addition or continue anyway. 

After the schedule item is added:

• Tracker adds the appropriate Form/Rate/Adv tab. If the filing is in Start 
status, also adds the appropriate Filing Group level items to the newly 
created tab.

• Tracker checks the appropriate Type check box in the filing banner. 

• Tracker locks the corresponding Related Filing field (regardless of whether 
the filing was sent to SERFF or not).

For SERFF filings:

• SERFF functionality for the new filing type will apply, that is, use of the 
SERFF/Supporting Documentation tab, the View Schedule button, Public 
Access functionality, and others.

• Users will need to send newly added Form/Rate/Adv schedule items to 
SERFF via an Initial Submission, Filing Amendment, or Objection 
Response.

• If additional Supporting Doc schedule requirements are needed as a result of 
the newly added Form/Rate/Adv schedule item, User will need to create 
User Added requirements to be sent as part of the Initial Submission, Filing 
Amendment or Objection Response. Tracker will not refresh the Supporting 
Doc schedule requirements.

• For Filing Amendments and Objection Responses, only the Rate Schedule 
item information is sent to SERFF. (Rate data is only sent with the initial 
submission or as part of a Post Submission Update after the initial filing 
submission.

Refer to the following topics for details on adding and editing schedule items at 
the Filing Group and Filing level:
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Forms

• Adding a New (or Editing an Existing) Filing Group Level Form on page 
126

• Adding a New (or Editing an Existing) Filing Level Form on page 141

Rates

• Adding a New (or Editing an Existing) Filing Group Level Rate on page 143

• Adding a New (or Editing an Existing) Filing Level Rate on page 156

Advertisements

• Adding a New (or Editing an Existing) Filing Group Level Advertisement on 
page 164

• Adding a New (or Editing an Existing) Filing Level Advertisement on page 
170

Other Attachments

• Adding a New (or Editing an Existing) Filing Group Level Other 
Attachment on page 179

• Adding a New (or Editing an Existing) Filing Level Other Attachment on 
page 182
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Forms

In Tracker, the term forms refers to insurance policies, endorsement forms, riders, 
and so on, used to construct and contain the criteria of the insurance coverage 
being provided. New forms, form alterations, and form exceptions must often be 
filed with individual state insurance departments, with references made to the 
existing forms affected, in order to meet compliance regulations.

The Forms Tab — Filing Group Level

The Filing Group level Forms tab lists all of the forms, endorsements and other 
items attached to this filing group.

From this tab, you can access the details for any of the forms listed.

1. On the Forms tab, select the form record you want to view and double-click 
it to open the related Form Details dialog.

2. Click a tab title to view information on that tab screen.

Adding a New (or Editing an Existing) Filing Group Level 
Form

When you add a form at the Filing Group level, all filings with a Start status in 
that filing group will automatically contain the form. You can see these Filing 
Group level forms at the Filing level, and any changes made at the Filing Group 
level will appear in filings at the Filing level with a status of Start. If a filing that 
is not in Start status changes back to Start status (as a result of performing or 
deleting an activity), then any new or modified forms that were not previously 
included in that filing are still not included in the filing after the status change. 
Adding forms at the Filing Group level then making required changes at the Filing 
level may save you time compared to adding forms individually at the Filing 
level.

Method: Add a new or edit an existing Filing Group level form

1. Navigate to the Filing Group level for the desire filing group.

2. To create a new form, click the New Form toolbar button  or select 
Insert > New Form.

The New Form dialog opens (shown below).

Alternatively:
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To edit an existing form, double-click the desired form on the Forms tab.

The Form Details dialog opens (not shown, but similar to New Form 
dialog box).

3. The basic information fields at the top of the dialog will be automatically 
filled with information from the filing group record. Check these to ensure 
that you are adding the form to the desired record.

4. On the General tab:

• The Entered By and Date Entered fields will automatically be filled in 
with your name and today’s date.

• In the Form # field, enter the code/number assigned to this form by 
your company.

• To make this the Lead Form (main form), select the Lead Form check 
box.

Note: When a form is added at the FG level, the Lead Form check box is always 
unlocked and able to be selected. Multiple lead forms can be added at the FG level 
resulting in more than one lead form in a filing.

• In the Title field, enter a brief title for this form.

• In the Revision Date field, enter the revision date for this form.

• In the Type field, select the form type from the drop-down list.

• In the Action area, select whether this is an Initial, Revised or Other 
form. If Other, enter an explanation.
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5. On the Attachments tab:

• To add a new attachment to the form, click Add, and using the file 
browser that opens, locate the required document. Double-click the 
required document, or select the document and click Open. If you have 
a DMS, select Browse DMS if the attachment is located in aDMS.

Tip: Select a file on a shared network drive or a DMS, not a local drive. This will help 
prevent problems if other users work with this filing.

• To view an existing attachment, select the document and click View 
Attachment, or double-click the attachment.

• To replace an existing attachment, select the attachment in the 
Attachments table and click Modify, and using the browser that opens, 
locate the required document. Double-click the required document, or 
select the document and click Open. If you have a DMS, select Browse 
DMS if the attachment is located in a DMS.

• In the No. of Pages field, enter the number of pages in the attached 
document.

• Repeat above steps for additional attachments.

• Use the up and down arrows above the Attachments table to move the 
entries within this table so that the list of attachments are in the correct 
order.
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6. On the Memo tab:

• The Form # field displays the form number.

• The Title displays the form title.

• In the Memo field, enter a comment or description of the form. This text 
is included in the long filing letter. (See Understanding Filing Letters on 
page 341.)
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7. On the Misc. tab:

• In the Custom field, you can add more information about the form. 
Information in this field will not appear in the final filing package.

• If this form is severable, select the Severable check box. 

Note: Severable means that the form will still apply to the fullest extent that it could if 
laws change. For example, a state can change a requirement which makes the 
form in its entirety no longer correct. If it’s a severable form, it means that until a 
revised form is received, the parts that are still applicable to state law apply.

• If this form is non-standard, select the Non Standard check box.

Note: Non-standard means the terms of the form were developed entirely by the 
company – i.e. they didn’t adopt someone else’s wording or recommended 
wording from an organization such as ACLI, etc.
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8. On the Readability tab:

• In the Sentence Count field, enter the number of sentences in the text of 
the form.

• In the Word Count field, enter the number of words in the text of the 
form.

• In the Syllable Count field, enter the number of syllables in the text of 
the form.

• In the Flesch Score field, enter the Flesch Score (readability score) of 
the form.
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9. On the Replacement tab:

• Click Add.

The Replacement Attachment Selection dialog displays. 

The Available Attachments table displays a list of all the forms in the system 
that this new forms may be replacing. 

To move one or more forms from the list of Available Attachments to the 
Selected Attachments table, highlight the applicable forms, then use the >, 
>>, <, << buttons to move your selections.

Enter the applicable replaced information as follows:
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a. Enter the Replaced Form #.

b. Click the V button to add your manual entry to the Selected 
Attachments table.

c. Repeat steps (a) and (b) as necessary to add additional replaced rates.

d. Use the up and down arrows above the Selected Attachments table to 
move the entries within this table so that the list of attachments are in 
the correct order.

 

10. To add another new form, click Next. 

OR

To finish, click OK. 

The new form(s) will be added (or the existing form updated), and the dialog 
will close.

The Forms Tab — Filing Level

The Filing level Forms tab lists all of the forms for this filing, both Filing Group 
level forms and Filing level forms.

From this tab, you can access the details for any of the forms listed.

1. On the Forms tab, select the form record you want to view and double-click 
it to open the related Form Details dialog.

2. Click a tab title to view information on that tab screen.

Adding a New (or Editing an Existing) Filing Level Form

When you add a form at the Filing Group level, all filings with a Start status in 
that filing group will automatically contain the form. You can see these Filing 
Group level forms at the Filing level, and any changes made at the Filing Group 
level will appear in filings at the Filing level with a status of Start. If a filing that 
is not in Start status changes back to Start status (as a result of performing or 
deleting an activity), then any new or modified forms that were not previously 
included in that filing are still not included in the filing after the status change. 
However, if you change certain fields at the Filing level, marked in this guide with 

a broken link icon, , the form will become independent of changes at the 
Filing Group level, in effect becoming a Filing level form.
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Notes:

• Filing level forms can be edited if the filing has not been submitted.

• Forms attached at the Filing level only apply to that filing.

Add and edit forms at the Filing level

Method: Add a new or edit an existing Filing level form

1. Navigate to the Filing level for the desired filing.

2. Click the New Form toolbar button  or select Insert > New Form.

The New Form dialog displays (shown below).

Alternatively:

To edit an existing form, double-click the desired form on the Forms tab.

The Form Details dialog box opens (not shown, but similar to New Form).

3. The basic information fields at the top of the dialog box will be 
automatically filled with information from the filing record. Check these to 
ensure that you are adding the form to the desired record.

4. On the General tab:

• The Entered By and Date Entered fields will automatically be filled in 
with your name and today’s date.
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•  In the Form # field, enter the code/number assigned to this form by 
your company.

•  If this is the Lead Form for this filing, select the Lead Form check 
box.

Notes:

• If you attempt to designate a second lead form in an unsubmitted filing, 
an error message will be displayed with the following text: “A lead form 
has already been designated. Please review as only one lead form is 
permitted in a filing.” You will need to clear the Lead Form check box 
for the first lead form before selecting the Lead Form check box for the 
newly added form.

• When editing a form that was added at the FG level, the behavior of the 
Lead Form check box will depend on whether the filing has been 
submitted to SERFF or not:

• If the filing has been submitted to SERFF, the Lead Form check 
box will be locked. Also, lead form information will not be passed 
to SERFF when the user sends a Filing Amendment, Objection 
Response, or a Note to Reviewer.

• If the filing has not been submitted to SERFF, the Lead Form 
check box will be fully editable so the user can select it or clear it 
as desired. If it is checked and another form in the filing is already 
designated as lead form, a warning message with the following text 
is displayed when the user attempts to close the New Form dialog 
box: “Two or more forms in the filing have been designated as lead 
forms. Please review the forms and ensure that you only have one 
lead form.”

•  In the Title field, enter a brief title for this form.

•  In the Revision Date field, enter the revision date of this form.

•  In the Type field, select the form type from the drop down list.

•  In the Action area, select whether this form attachment is Initial, 
Revised or Other. Note that this is a mandatory field for SERFF filings.

If Revised, enter the Previous State Filing #. (This is the DOI file 
number assigned by the state to the previous filing.) 

If Other, enter an explanation.
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5. On the Attachments tab:

•  To add a new attachment, click Add, and using the file browser that 
opens, locate the required document. Double-click the required 
document, or select the document and click Open. If you have a DMS, 
select Browse DMS if the attachment is located in a DMS.

Tip: Select a file on a shared network drive or a DMS, not a local drive. This will help 
prevent problems if other users work with this filing.

• To view an existing attachment, select the document and click View 
Attachment, or double-click the attachment.

•  To replace an existing attachment, select the attachment in the 
Attachments table and click Modify, and using the browser that opens, 
locate the required document. Double-click the required document, or 
select the document and click Open. If you have a DMS, select Browse 
DMS if the attachment is located in a DMS.

•  In the No. of Pages field, enter the number of pages in the attached 
document.

• Repeat above steps for additional attachments.

•  Use the up and down arrows above the Attachments table to move 
the entries within this table so that the list of attachments are in the 
correct order.
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6.  On the Memo tab:

You can enter a comment or description of the form. Text entered here is 
included in the long filing letter. (See Understanding Filing Letters on page 
341.)

7. On the Misc. tab:

•  If this form is severable, select the Severable check box.
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•  If this form is non-standard, select the Non Standard check box.

•  In the Custom field, you can add more information about the form. 
Information in this field will not appear in the final filing package.

8. On the Readability tab:

•  In the Sentence Count field, enter the number of sentences in the 
text of the form.

•  In the Word Count field, enter the number of words in the text of 
the form.

•  In the Syllable Count field, enter the number of syllables in the 
text of the form.

•  In the Flesch Score field, enter the Flesch Score (readability score) 
of the form.
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9.  On the Replacement tab:

10. Click Add/Lookup.

The Replacement Attachment Selection dialog opens.

The Available Attachments table displays a list of all the forms in the system 
that this new form may be replacing. 

To move one or more forms from the list of Available Attachments to the 
Selected Attachments table, highlight the applicable form, then use the >, 
>>, <, << buttons to move your selections.
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If the list of Available Attachments is blank or does not contain the form to 
be replaced, enter the replaced information.

a. Enter the Replaced Form #.

b. Click the V button to add your manual entry to the Selected 
Attachments table.

a. Repeat steps (a) and (b) as necessary to add additional replaced forms.

b. Use the up and down arrows above the Selected Attachments table to 
move the entries within this table so that the list of attachments are in 
the correct order.

 

11. On the Status tab:

• On the Tracker Status drop-down list, you can select a status for this 
form only, independent of the status of the filing, but use with caution.

•  If you want the form to be included in the overall filing, select the 
Enable check box.

•  If this form is specific for this state, select the State Specific check 
box.

• The Replacement Effective Date will be automatically entered by the 
system in the future when this new form is replaced, but only if the form 
was added to the Replacement tab of the new form.

12. To add another new form, click Next.
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OR

To finish, click OK. 

The new form reference(s) will be added (or the existing form reference 
updated), and the dialog will close.

Enabling Forms

Tracker provides the ability to selectively enable forms.

When a form is enabled (Enable set to Yes), it will be sent to SERFF with the 
initial filing or it can be added to a Filing Amendment or Objection Response, or 
it will be included in a paper filing (will print as part of the filing package). When 
a form is not enabled (Enable set to No), it is not available for a SERFF filing nor 
will it be included in a paper filing.

Method: Disable a form

By default, most forms will be enabled—form part of the filing package. To 
disable a form and not include it in the filing package you must perform the 
following steps:

1. On the Forms tab, highlight the form that you would like to disable. 

2. Right-click the form that is selected.

A dialog displays.

 

3. By default, the form will already have a checkmark to the left of the Enable 
option.

4. Click Enable. 

The dialog closes and No appears in the Enable column in the table of 
forms.

Note: You must repeat the Generate Complete Filing Activity for this change to take 
effect in the print process.

This form 
will not be 
included 
in the 
filing 
package.
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Method: Enable a form

If you have disabled a form and you want to enable it, follow these steps:

1. On the Forms tab, highlight the form that you would like to enable. 

2. Right-click the form that is selected. 

A dialog displays.

 

3. Click Enable. 

The dialog closes and Yes appears in the Enable column in the table of 
forms.

Note: You must repeat the Generate Complete Filing Activity for this change to take 
effect in the print process.
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Rates

Rates are the premium amounts which insurance companies charge their 
customers. New rates and rate alterations must often be filed with individual State 
Insurance Departments in order to meet regulations.

The Rates Tab — Filing Group Level

The Filing Group level Rates tab lists all of the rates attached to this filing group.

From this tab you can access the rate details for any of the rates listed.

1. On the Rates tab for the desired filing group, double-click any rate in the 
Rate List subtab to open the related Rate Details dialog.

2. On the Rate Details dialog, click a tab to display its information.

Setting the Filing Group Level Rate Information

The values in these fields flow through to the filings unless these fields are 
changed at the Filing level.

Method: Set the Filing Group level rate information

At the Filing Group level for the desired filing group, on the Rates tab:

• Select a Rate Change Type from the drop-down list: Decrease, Increase, 
Rate Neutral. or leave the default value of blank.

• In the Rate Impact field, enter a positive or negative percentage value. The 
value cannot exceed 3 decimal places, for example 5.793.

Adding a New (or Editing an Existing) Filing Group Level 
Rate

When you add a rate at the Filing Group level, all filings in that filing group with 
a status of Start will automatically contain the rate. You can see these Filing 
Group level rates at the Filing level, and any changes made at the Filing Group 
level will appear at the Filing level. If a filing that is not in Start status changes 
back to Start status (as a result of performing or deleting an activity), then any new 
or modified rates that were not previously included in that filing are still not 
included in the filing after the status change. Adding rates at the Filing Group 
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level then making required changes at the Filing level may save you time 
compared to adding rates individually at the Filing level.

Method: Add a new (or edit an existing) Filing Group level rate

1. Navigate to the Filing Group level for the desire filing group.

2. To create a new Filing Group Level Rate, click the New Rate toolbar 

button  to open the New Rate dialog, or select Insert > New Rate.

The New Rate dialog displays.

Alternatively:

To edit an existing Filing Group Level Rate, double-click the rate 
attachment on the Rate List on the Rates tab.

The Rate Details dialog displays (similar to New Rate).

3. The basic information fields at the top of the dialog will be automatically 
filled with information from the filing group record. Check these to see that 
you are adding the rate to the desired filing group.

Begin entering information on the General tab for the next rate.

4. On the General tab:

• The Entered By field will automatically be filled in with your name. 
The Date Entered field will have the rate’s creation date. The date can 
be changed by clicking the drop-down button and selecting a date from 
the calendar.
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• In the Company Rate # field, enter the code/number assigned to this 
rate by your company.

• Populate the Affected Form #s field by following these steps:

a. Click the [...] button to the right of the Affected Form #.

The Forms Affected By Rate Filing dialog opens.

b. In the Available Form # field, enter the form number for a form 
that is affected by the rate filing, then click Add.
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The number is added to the Affected Form #s list.

c. Repeat the above step until all the forms affected by the change 
have been added.

d. Use Delete Selected and Delete All to remove forms that have 
already been added to the list.

e. Click Cancel to close the dialog without making any changes to 
the information in the Affected Form #s field.

f. Click OK.
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The Forms Affected By Rate Filing dialog closes, and the list of 
affected forms is displayed in the Affected Form #s text box.

• In the Title field, enter a brief title for this rate attachment.

• In the Action area, select whether this is an Initial, Revised or Other 
rate attachment. Note that this is a mandatory field for SERFF filings.

If Revised, select Increase or Decrease from the drop-down list, and 
enter the % change in the text box. 

If Other, enter an explanation.

5. On the Attachments tab:

• To add a new attachment to the rate, click Add, and using the file 
browser that opens, locate the required document. Double-click the 
required document, or select the document and click Open. If you have 
a DMS, select Browse DMS if the attachment is located in aDMS.

Tip: Select a file on a shared network drive or a DMS, not a local drive. This will help 
prevent problems if other users work with this filing.

• To view an existing attachment, select the document and click View 
Attachment, or double-click the attachment.
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• To replace an existing attachment, select the attachment in the 
Attachments table and click Modify, and using the browser that opens, 
locate the required document. Double-click the required document, or 
select the document and click Open. If you have a DMS, select Browse 
DMS if the attachment is located in a DMS.

• In the No. of Pages field, enter the number of pages in the attached 
document.

• Repeat above steps for additional attachments.

a. Use the up and down arrows above the Attachments table to move the 
entries within this table so that the list of attachments are in the correct 
order.

 

6. On the Memo tab:

• The Rate # and Title are automatically filled in.

• The Memo field provides room for a lengthy comment or background 
description of the attachment. Text entered here is included in the long 
filing letter. (See Understanding Filing Letters on page 341.)
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7. On the Misc. tab:

The Custom field allows you to add more information about the rate. 
Information in this field will not appear in the final filing package.

8. On the Replacement tab:

9. Click Add, and the Replacement Attachment Selection dialog displays.
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The Available Attachments table displays a list of all the rate attachments in 
the system that this new rate attachment may be replacing. 

To move one or more rate attachments from the list of Available 
Attachments to the Selected Attachments table, highlight the applicable rate 
attachment, then use the >, >>, <, << buttons to move your selections.

If the list of Available Attachments is blank or does not contain the rate to be 
replaced, enter the replaced information.

a. Enter the Replaced Rate #

b. Click the V button to add your manual entry to the Selected 
Attachments table.

a. Repeat steps (a) and (b) as necessary to add additional replaced rates.

b. Use the up and down arrows above the Selected Attachments table to 
move the entries within this table so that the list of attachments are in 
the correct order.

 

10. Click Next.

The information on all the tabs will be saved, the new rate reference will be 
added to the main Rate tab at Filing Group level, and another New Rate 
dialog will open.

OR

Click OK. 

The information on all the tabs will be saved, the new rate item will be 
added to the main Rate tab at Filing Group level, and the New Rate dialog 
will close.

OR
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Click Cancel to close the New Rate dialog without saving.

The Rates Tab – Filing Level

The Filing level Rates List tab lists all of the rates for this filing; both Filing 
Group level filings and Filing level filings.

From this tab you can access the rate details for any of the rates listed.

1. On the Rates tab for the desired filing, double-click any rate in the Rate 
List subtab to open the related Rate Details dialog.

2. Click a tab title to view information on that tab screen.

Viewing or Changing Rates at the Filing Level 

On the Rates tab for a filing, you can access the details for any of the rates or 
listed, and enter or change the information for this filing.

Note: When changed at the Filing level, a filing’s Rate Change Type will become 
independent of the Rate Change Type setting at the Filing Group level. When 
changed at the Filing level, a filing’s Rate Impact will become independent of the 
Rate Impact setting at the Filing Group level.

Entering Filing Level Rate Information

You can enter or change the rate information that applies to this filing only. This 
can include performing a rate action to request an increase or decrease in a rate.

If this is a PPACA filing, you can enter values for # of Policy Holders and # of 
Covered Lives for the following product types:

Product Type Description

HMO Health Maintenance Organization

PPO Preferred Provider Organization

EPO Exclusive Provider Organization

POS Point of Service

HSA Health Savings Account
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Method: Enter Filing level rate information

1. Navigate to the Filing level for the desired filing.

2. Click the Rates tab.

3. If required, select an entry from the Rate Change Type drop-down list 
(blank, Increase, Decrease, or Rate Neutral). 

Note: When changed at the Filing level, a filing’s Rate Change Type will become 
independent of the Rate Change Type setting at the Filing Group level.

• If required, in the Rate Impact field, enter a positive or negative percentage 
value.

Note: When changed at the Filing level, a filing’s Rate Impact will become 
independent of the Rate Impact setting at the Filing Group level.

4. Select an entry from the Filing Method drop-down list, which by default 
shows Prior Approval, File and Use, or Use and File. (This list can be 
customized by the Tracker Administrator. See Filing Method (Rate) on page 
98.)

5. Click the Rate Change Details tab. This tab contains the Public Access 
section (which indicates whether the rate data (and the PPACA/HIPR Rate 
Review Detail) affiliated with the filing can be publicly accessed) and a grid 
with company-specific rate change information for the filing.

6. Double-click a row containing data.

The Rate Change Details dialog opens.

HDHP High Deductible Health Plan

FFS Fee for Service

Product Type Description
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7. Enter (or view) the company-specific rate change information for the filing, 
as follows:

a. The Company Name field is read-only.

b. In the Company rate change? field, select a value from the drop-down 
list. For PPACA filings, this field is required. 

c. In the % Indicated change, enter a positive or negative percentage 
value. 

d. In the Overall % Rate Impact field, enter a positive or negative 
percentage value.

e. In the Written premium change for this program field, enter a 
positive or negative dollar value. The value cannot exceed ten digits and 
must be a whole number; the maximum value that can be entered is 2 
billion.

f. In the # of policyholders affected for this program field, enter a value. 
It cannot exceed ten digits or 2 billion and must be a whole number.

g. In the Written premium for this program field, enter a dollar value.

h. In the Max % change requested for this program field, enter a 
positive percentage value.

i. The Max % approved for this program is the maximum percentage 
increase allowed by the state. The approved values for SERFF filings 
will be shown on the disposition report and will be populated into the 
approved fields by the system for SERFF filings. This field is read-only.

j. In the Min % change requested for this program field, enter a 
positive percentage value.
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k. The Min % approved for this program is the minimum percentage 
increase allowed by the state. The approved values for SERFF filings 
will be shown on the disposition report and will be populated into the 
approved fields by the system for SERFF filings. This field is read-only.

8. If this is a PPACA filing, and you did not select New Product for Company 
rate change?, click Product Types.

The Product Types dialog displays.

a. Enter # of Policy Holders and # of Covered Lives for desired product 
types.

Note: Data is required for at least one Product Type. Zero is a valid value for either field 
(# of Policy Holders or # of Covered Lives). If one field is zero, a value greater 
than zero is required in the remaining field for at least one Product Type.

b. Click OK.

9. To complete the HIPR fields for a PPACA filing, click Rate Review Detail.

The Rate Review Detail dialog displays.
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a. Enter HIPR values in the fields. Asterisks identify fields that are 
always required, and the fields that are only required when 
Existing Products is selected for Company Rate Change? on the 
Rate Change Details dialog. Ensure you complete at least one 
field in the Forms area.

b. Click OK.

10. Click the Save button on the Tracker toolbar to save your changes.

11. Click OK to save your changes.

12. Click the Last Revision tab.

13. In this tab, enter the following information for the previous rate revision:

• Overall percentage

• Effective Date – click the drop-down arrow to select a date from the 
calendar

• Filing Method – Prior Approval, File and Use, or Use and File. (This 
list can be customized by the Tracker Administrator. See Filing Method 
(Rate) on page 290.)

14. Click the Save button on the Tracker toolbar to save your changes.
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Adding a New (or Editing an Existing) Filing Level Rate

When you add a rate at the Filing Group level, all filings in that filing group with 
a status of Start will automatically contain the rate. You can see these Filing 
Group level rates at the Filing level, and any changes made at the Filing Group 
level will appear at the Filing level. If a filing that is not in Start status changes 
back to Start status (as a result of performing or deleting an activity), then any new 
or modified rates that were not previously included in that filing are still not 
included in the filing after the status change. However, if you change certain fields 

at the Filing level, marked in this guide with a broken link icon, , the rate 
attachment will become independent of changes at the Filing Group level, in 
effect becoming a Filing level rate attachment. If a filing that is not in Start status 
changes back to Start status (as the result of an activity being run), then any new 
or modified Filing Group level rate attachments that were not previously included 
in that filing are still not included in the filing after the status change.

Method: Add a new (or edit an existing) Filing level rate

1. Navigate to the desired filing.

2. To create a new Filing Level rate attachment, click New Rate  to 
open the New Rate dialog, or select Insert > New Rate.

The New Rate dialog opens (shown below).

Alternatively:

To edit an existing Filing Level rate attachment, double-click the rate 
attachment on the Rate List on the Rates tab.

The Rate Details dialog displays (not shown, but similar to New Rate).
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The basic information fields at the top of the dialog will be automatically 
filled with information from the filing record. Check these to see that you 
are adding the rate attachment to the desired record.

3. On the General information tab:

• The Entered By and Date Entered fields will automatically be filled in 
with your name and today’s date. The date can be changed by clicking 
the drop-down button and selecting a date from the calendar.

•  In the Company Rate # field, enter the code/number assigned to 
this rate by your company.

•  Populate the Affected Form #s field by following these steps:

a. Click expand [...] to the right of the Affected From # field.

The Forms Affected By Rate Filing dialog opens.

b. In the Available Form # field, enter the form number for a form 
that is affected by the rate filing.

c. Click Add.

The number is added to the Affected Form #s list.

d. Repeat the above three steps until all the forms affected by the 
change have been added.

e. Use Delete Selected and Delete All to remove forms that have 
already been added to the list.
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f. Click Cancel to close the dialog without making any changes to 
the information in the Affected Form #s field.

g. Click OK.

The Forms Affected By Rate Filing dialog closes, and the list of 
affected forms is displayed in the Affected Form #s field.

• In the Title field, enter a brief title for this rate attachment.

• Note that this is a mandatory field for SERFF filings.  In the Action 
area, select whether this is an Initial, Revised or Other rate attachment. 
Note that this is a mandatory field for SERFF filings.

If Revised, select Increase or Decrease from the drop-down list, and 
enter the % change in the text box. Enter the Previous State Filing #. 
This is the DOI file number assigned by the state to the previous filing. 

If Other, enter an explanation. 

4. On the Attachments tab:

•  To add a new attachment, click Add, and using the file browser that 
opens, locate the required document. Double-click the required 
document, or select the document and click Open. If you have a DMS, 
select Browse DMS if the attachment is located in a DMS.

Tip: Select a file on a shared network drive or a DMS, not a local drive. This will help 
prevent problems if other users work with this filing.
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• To view an existing attachment, select the document and click View 
Attachment, or double-click the attachment.

•  To replace an existing attachment, select the attachment in the 
Attachments table and click Modify, and using the browser that opens, 
locate the required document. Double-click the required document, or 
select the document and click Open. If you have a DMS, select Browse 
DMS if the attachment is located in a DMS.

•  In the No. of Pages field, enter the number of pages in the attached 
document.

• Repeat above steps for additional attachments.

•  Use the up and down arrows above the Attachments table to move 
the entries within this table so that the list of attachments are in the 
correct order.

 

5.  On the Memo tab:

• The Rate # and Title are automatically filled in.

• The Memo field provides room for a lengthy comment or background 
description of the attachment. Text entered here is included in the long 
filing letter. (See Understanding Filing Letters on page 341.)
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6. On the Misc. tab:

 The Custom field allows you to add more information about the rate. 
Information in this field will not appear in the final filing package.

7.  On the Replacement tab:
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8. Click Add/Lookup, and the Replacement Attachment Selection dialog 
opens.

The Available Attachments table displays a list of all the rate attachments in 
the system that this new rate attachment may be replacing. 

To move one or more rate attachments from the list of Available 
Attachments to the Selected Attachments table, highlight the applicable rate 
attachment, then use the >, >>, <, << buttons to move your selections.

If the list of Available Attachments is blank or does not contain the rate to be 
replaced, enter the replaced information:

a. Enter the Replaced Rate #

b. Click the V button to add your manual entry to the Selected 
Attachments table.

c. Repeat steps (a) and (b) as necessary to add additional replaced rates.

d. Use the up and down arrows above the Selected Attachments table to 
move the entries within this table so that the list of attachments are in 
the correct order.

 

9. On the Status tab:

Enter the following information:

• The Status field allows you to enter a status for this rate attachment 
only, independent of the status of the filing. However, use this field with 
caution if you chose to manually manipulate the status for a rate 
attachment.
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• The Effective Date is the Approved Effective Date of the filing. It will 
be populated by the system when you perform the activity to approve 
the filing.

•  If you want the rate attachment to be included in the overall filing, 
select the Enable check box.

•  If this rate is specific for this state, select the State Specific check 
box.

• The Replacement Effective Date will be automatically entered by the 
system in the future when this new rate is replaced, but only if the rate 
was added to the Replacement tab of the new rate.

10. To add another new rate attachment, click Next. 

The New Rate dialog will re-appear ready for another new rate attachment.

OR 

To finish, click OK. 

The new rate attachment(s) will be added, (or the existing rate attachment 
will be updated) and the dialog will close.

Enabling Rates

Tracker provides the ability to selectively enable filing rates.

When a rate is enabled (Enable set to Yes), it is available for a SERFF filing 
(available to satisfy filing requirements) or will be included in a paper filing (will 
print as part of the filing package). When a rate is not enabled (Enable set to No), 
it is not available for a SERFF filing (it is not available to satisfy filing 
requirements) or it will not be included in a paper filing (it will not print as part of 
the filing package).

Method: Disable a rate

By default, most rates will be enabled—form part of the filing package. To disable 
a rate and not include it in the filing package you must perform the following 
steps:

1. Navigate to the Filing level of the desired filing.

2. Click the Rates tab.

3. Right-click the rate that you would like to disable. 

This rate 
will not be 
included 
in the 
filing 
package.
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A dialog displays.

 

4. By default, the rate will already have a checkmark to the left of the Enable 
option.

5. Click Enable.

The dialog closes and No appears in the Enable column in the table of rates.

Note: You must repeat the Generate Complete Filing Activity for this change to take 
effect in the print process.

Method: Enable a rate

If you have disabled a rate and you want to enable it, follow these steps:

1. Navigate to the Filing level of the desired filing.

2. Click the Rates tab.

3. Right-click the rate that you would like to enable. 

A dialog displays.

 

4. Click Enable. 

The dialog closes and Yes appears in the Enable column in the table of 
rates.

Note: You must repeat the Generate Complete Filing Activity for this change to take 
effect in the print process.
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Advertisements

Advertisements are composed of any flyers, brochures, jacket copy, marketing 
materials, commercials, and so on, used in the insurance industry to promote and 
sell insurance coverage. New advertisements, and changes to existing 
advertisements, must often be filed with individual State Insurance Departments 
in order to meet compliance regulations, depending on the product, method of 
distribution, and advertising medium used.

The Advertisements Tab — Filing Group Level

The Filing Group level Advertisements tab lists all of the advertisements attached 
to this filing group.

From this tab, you can access the details for any of the Filing Group level 
advertisements.

1. On the Advertisements tab for the desired filing group, double-click any 
advertisement to open the related Advertisementsdialog.

2. Click a tab title to view information on that tab.

Adding a New (or Editing an Existing) Filing Group Level 
Advertisement

The Advertisements tab at the Filing Group level lists all of the advertisements 
added to the selected filing group. 

When you add an advertisement at the Filing Group level, all filings in that filing 
group with a status of Start will automatically contain the advertisement. You can 
see these Filing Group level advertisements at the Filing level, and any changes 
made at the Filing Group level will appear at the Filing level. If a filing that is not 
in Start status changes back to Start status (as a result of performing or deleting an 
activity), then any new or modified advertisements that were not previously 
included in that filing are still not included in the filing after the status change. 

Tip: Adding advertisements at the Filing Group level then making required changes at 
the Filing level may save you time compared to adding advertisements 
individually at the Filing level. 

Method: Add a new (or edit and existing) Filing Group level 
advertisement

1. Navigate to the desired filing group.
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2. To add a new Advertisement to a filing group, click the New 

Advertisement toolbar button or select Insert > New Advertisement.

The New Advertisement dialog opens (shown below).

Alternatively: 

To edit an existing Advertisement, double-click the desired advertisement.

The Advertisement Details dialog opens (not shown, but similar to New 
Advertisement).

3. The basic information fields at the top of the dialog will be automatically 
filled with information from the filing group record. Check these to ensure 
that you are adding the advertisement to the desired record.

4. On the General tab:

• The Entered By and Date Entered fields will automatically be filled in 
with your name and today’s date. The date can be changed by clicking 
the drop-down button and selecting a date from the calendar.

• In the Product field, enter the product to which the advertising applies.

• In the Ad. Form # field, enter the code/number assigned to this 
advertisement by your company.

• In the Form Title field, enter a brief title for this advertisement.

• In the Means of Distribution field, enter the distribution method for 
this advertisement.

• In the Audience field, enter the target audience for this advertisement.
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• In the Action area, select whether this is an Initial, Revised, or Other 
advertisement. If Other, enter an explanation.

5. On the Attachments tab:

• To add a new attachment to the advertisement, click Add, and using the 
file browser that opens, locate the required document. Double-click the 
required document, or select the document and click Open. If you have 
a DMS, select Browse DMS if the attachment is located in aDMS.

Tip: Select a file on a shared network drive or a DMS, not a local drive. This will help 
prevent problems if other users work with this filing.

• To view an existing attachment, select the document and click View 
Attachment, or double-click the attachment.

• To replace an existing attachment, select the attachment in the 
Attachments table and click Modify, and using the browser that opens, 
locate the required document. Double-click the required document, or 
select the document and click Open. If you have a DMS, select Browse 
DMS if the attachment is located in a DMS.

• In the No. of Pages field, enter the number of pages in the attached 
document.

• Repeat above steps for additional attachments.

• Use the up and down arrows above the Attachments table to move the 
entries within this table so that the list of attachments are in the correct 
order.
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6. On the Memo tab:

• The Adv. Form # field displays the advertisement number entered on 
the General tab.

• The Title field displays the advertisement title entered on the General 
tab.

• In the Memo field, enter a comment or background description of the 
advertisement. This text is included in the long filing letter. (See 
Understanding Filing Letters on page 341.)
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7. On the Misc. tab:

The Custom field allows you to add more information about the 
advertisement. Information in this field will not appear in the final filing 
package.

8. On the Replacement tab:

9. Click Add, and the Replacement Attachment Selection dialog displays. 
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The Available Attachments table displays a list of all the advertisements in 
the system that this new advertisement may be replacing. 

To move one or more advertisements from the list of Available 
Attachments to the Selected Attachments table, highlight the applicable 
advertisement, then use the >, >>, <, << buttons to move your selections.

If the list of Available Attachments is blank or does not contain the 
advertisement to be replaced, enter the replaced information.

a. Enter the Replaced Adv. Form #.

b. Click the V button to add your manual entry to the Selected 
Attachments table.

c. Repeat steps (a) and (b) as necessary to add additional replaced 
advertisements.

d. Use the up and down arrows above the Selected Attachments table to 
move the entries within this table so that the list of attachments are in 
the correct order.

 

e. Click OK when done.

10. To add another new advertisement reference, click Next. 

The New Advertisement dialog opens

OR

To finish, click OK. 

The new advertisement will be added (or the existing advertisement 
updated), and the dialog will close.

The Advertisement Tab – Filing Level

The Filing level Advertisements tab lists all of the advertisements for this filing 
at both the Filing Group and Filing levels.
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From this tab, you can access the details for any of the advertisements listed.

1. On the Advertisements tab, double-click the Advertisement record to open 
it.

2. Click a tab title to view or change information.

Adding a New (or Editing an Existing) Filing Level 
Advertisement

When you add an advertisement at the Filing Group level, all filings in that filing 
group with a status of Start will automatically contain the advertisement. You can 
see these Filing Group level advertisements at the Filing level, and any changes 
made at the Filing Group level will appear at the Filing level. If a filing that is not 
in Start status changes back to Start status (as a result of performing or deleting an 
activity), then any new or modified advertisements that were not previously 
included in that filing are still not included in the filing after the status change. 
However, if you change certain fields at the Filing level, marked in this guide with 

a broken link icon, , the advertisement will become independent of changes at 
the Filing Group level, in effect becoming a Filing level advertisement.

Method: Add a new (or edit an existing) Filing level advertisement

1. To add a new Advertisement, at the Filing level, click the New 

Advertisement toolbar button or select Insert > New Advertisement.

The New Advertisement dialog displays (shown below).

OR

To edit an existing Advertisement, double-click the desired advertisement.

The Advertisement Details dialog displays (not shown, but similar to New 
Advertisement).
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2. The basic information fields at the top of the dialog will be automatically 
filled with information from the filing record. Check these to ensure that you 
are adding the advertisement to the desired record.

3. On the General tab:

• The Entered By and Date Entered fields will automatically be filled in 
with your name and today’s date.

• In the Product field, enter the specific product to which the advertising 
applies. 

•  In the Ad. Form # field, enter the code/number assigned to this 
advertisement form by your company.

•  In the Form Title field, enter a brief title for this advertisement 
form.

•  In the Means of Distribution field, enter the distribution method 
for this advertisement.

•  In the Audience field, enter the target audience for this 
advertisement.

• Note that this is a mandatory field for SERFF filings.  In the Action 
area, select whether this is an Initial, Revised or Other advertisement. 
Note that this is a mandatory field for SERFF filings.

If Revised, enter the Previous State Filing #. (This is the DOI file 
number assigned by the state to the previous filing.) 
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If Other, enter an explanation.

4. On the Attachments tab:

•  To add a new attachment, click Add, and using the file browser that 
opens, locate the required document. Double-click the required 
document, or select the document and click Open. If you have a DMS, 
select Browse DMS if the attachment is located in a DMS.

Tip: Select a file on a shared network drive or a DMS, not a local drive. This will help 
prevent problems if other users work with this filing.

• To view an existing attachment, select the document and click View 
Attachment, or double-click the attachment.

•  To replace an existing attachment, select the attachment in the 
Attachments table and click Modify, and using the browser that opens, 
locate the required document. Double-click the required document, or 
select the document and click Open. If you have a DMS, select Browse 
DMS if the attachment is located in a DMS.

•  In the No. of Pages field, enter the number of pages in the attached 
document.

• Repeat above steps for additional attachments.

•  Use the up and down arrows above the Attachments table to move 
the entries within this table so that the list of attachments are in the 
correct order.
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5. On the Memo tab:

• The Adv. Form # field displays the Advertisement number.

• The Title displays the advertisement’s title.

•  In the Memo field, enter a comment or background description of 
the advertisement. This text is included in the long filing letter. (See 
Understanding Filing Letters on page 341.)
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6. On the Misc. tab:

 In the Custom field, you can add more information about the 
advertisement. Information in this field will not appear in the final filing 
package.

7. On the Replacement tab:
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• Click Add/Lookup, and the Replacement Attachment Selection dialog 
appears. The Available Attachments table displays a list of all the 
advertisements in the system that this new advertisement may be replacing. 

To move one or more advertisements from the list of Available 
Attachments to the Selected Attachments table, highlight the applicable 
advertisement, then use the >, >>, <, << buttons to move your selections.

If the list of Available Attachments is blank or does not contain the 
advertisement to be replaced, enter the replaced information.

a.  Enter the Replaced Adv. Form #.

b. Click the V button to add your manual entry to the Selected 
Attachments table.

c. Repeat steps (a) and (b) as necessary to add additional replaced 
advertisements.

d. Use the up and down arrows above the Selected Attachments table to 
move the entries within this table so that the list of attachments are in 
the correct order.

 

e. Click OK when changes to this window are complete, or click Cancel 
to close this window without making any changes.
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8. On the Status tab:

• On the Tracker Status drop-down list, you can select a status for this 
advertisement only, independent of the status of the filing, but use with 
caution.

•  If you want the advertisement to be included in the overall filing, 
select the Enable check box.

•  If this advertisement is specific for this state, select the State 
Specific check box.

• The Replacement Effective Date will be automatically entered by the 
system in the future when this new advertisement is replaced, but only if 
the advertisement was added to the Replacement tab of the new 
advertisement.

9. To add another new advertisement, click Next.

OR

To finish, click OK. 

The new advertisement reference(s) will be added (or the existing 
advertisement reference(s) updated), and the dialog will close.
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Linking Related Filings 

Sometimes, you may need to file related filings (of different types) separately. 
You may be doing this because certain states do not allow you to, for example, file 
forms and rates together, or because your company may not allow combined 
filings as a general business practice. In cases where you submit related filings 
separately, states may require a cross-reference (or “link”) in each filing to any 
related filings.

You add these cross-references to the Related Filings section in one of three 
ways:

• by selecting a filing from a list of filings that Tracker has determined may be 
related

• by searching the system and selecting from the search results

• by typing in a value (You would do this if a state requires data in these fields 
that differs from the data that Tracker provides using the other two 
methods.)

After the ID has been entered, the filings are effectively linked to each other. 

Notes

• The ID that is used is the related filing’s Company Reference # if one 
exists at the time the filing is sent to SERFF. If no Company Reference # is 
present in the related filing, then the field will be populated with the 
Tracker Filing ID of the related filing. If the related filing’s Company 
Tracking # changes prior to submitting the filing to SERFF (because the 
user added, changed, or deleted the Company Reference #), then the 
number shown in the Related Filings area will be updated. After the filing 
is submitted to SERFF, the value in the field will be updated in Tracker, but 
not passed to SERFF.

• After performing the activities SERFF: Generate SERFF Filing or 
Generate Complete Filing, the values for Related Filings are not editable.

Method: Link related filings

1. In the Related Filings section of the filing header at the Filing level, click 

the  button next to the filing type you want to search.

The Related Filings dialog displays. Any potentially related filings are 
listed.
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2. If the related filing you are searching for is listed, double-click it to add it to 
the respective Related Filings type.

If the related filing you are searching for is not listed, you can search for the 
filing manually.

a. Click Search.

b. Enter your search criteria, then click Search again. (For more 
information about searching Tracker, see Performing Tracker Searches 
on page 376.)

Any filings matching your search criteria are displayed in the Search 
Results tab.

c. If the related filing you are searching for is listed, double-click it to add 
its filing ID to the respective Related Filings type.

After the filing ID has been entered, the related filing is now linked to the filing 
you are working on. You can double-click the filing ID of the related filing to 
quickly open the related filing.

Note: If the related filing is a combined filing, two of the Related Filings fields will be 
populated with the related filing values. For example, if the related filing is a 
combined Rate and Form filing, then both the Form and Rate fields in the 
Related Filings section will be populated with filing numbers.
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Other Attachments

In addition to rates, advertisements, and forms, filings usually require other 
supporting documentation (for example, actuarial memorandums, exhibits, 
certifications, and so on). SERFF uses fillable filing forms for this purpose. For 
SERFF filings, you can access the fillable filing forms by clicking View 
Requirements on the filing’s SERFF tab, Supporting Documentation sub-tab. 
After opening a fillable filing form and saving it to your file system or DMS, it 
can be opened outside of Tracker, completed, then saved. The completed fillable 
filing form can then be used as an attached document for Other Attachments at the 
filing group or filing level.

Tip: You can enter data into the fields on the fillable filing form using Adobe Reader (a 
free download). You can also use Adobe Reader to sign the document by using the 
Sign Document command. If you don’t already have a digital signature, Adobe 
Reader will guide you through the steps to create one when you perform the Sign 
Document command.

The Other Attachment Tab — Filing Group Level

The Other Attachments tab is the area within Tracker in which any supporting 
documentation you want to include in the filing should be attached. You can add 
these other attachments at either the Filing Group or Filing level. The Other 
Attachments tab at the Filing Group level lists all of the Other Attachments 
added to the selected filing group. 

Adding a New (or Editing an Existing) Filing Group Level 
Other Attachment

If you add Other Attachments at the Filing level, you can choose whether they 
print with the filing.

If you add an Other Attachment at the Filing Group level, then for each filing in 
the filing group, the new attachment will be automatically set to print with the 
filing.

When you add an Other Attachment at the Filing Group level, all filings in that 
filing group with a status of Start will automatically contain the Other Attachment. 
You can see these Filing Group level other attachments at the Filing level, and any 
changes made at the Filing Group level will appear at the Filing level in filings 
with a status of Start. If a filing that is not in Start status changes back to Start 
status (as a result of performing or deleting an activity), then any new or modified 
Filing Group level items that were not previously included in that filing are still 
not included in the filing after the status change.
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Tip: Adding Other Attachments at the Filing Group level then making required 
changes at the Filing level may save you time compared to adding Other 
Attachments individually at the Filing level.

Method: Add a new or edit an existing Filing Group level Other 
Attachment

1. Navigate to the Filing Group level of the desired filing group.

2. To create a new Other Attachment, click the New Other Attachment 

toolbar button  or select Insert > New Other Attachment.

The New Attachment dialog opens (shown below).

OR

To edit an existing Other Attachment, double-click the attachment on the 
Other Attachments tab.

The Attachment Details dialog opens (not shown, but similar to New 
Attachment).

3. On the General tab:

• The Entered By and Date Entered fields will automatically be filled in 
with your name and today’s date. The date can be changed by clicking 
the drop-down button and selecting a date from the calendar.

• Enter the Title of the new attachment, or edit the existing Title.

• Select an attachment Type from the drop-down menu.

• If required, enter (or edit) text in the Memo box to describe this 
attachment. Text entered here will not appear in the final filing.
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4. On the Attachments tab:

• To add a new Other Attachment, click Add, and using the file browser 
that opens, locate the required document. Double-click the required 
document, or select the document and click Open. If you have a DMS, 
select Browse DMS if the attachment is located in a DMS.

Tip: Select a file on a shared network drive or a DMS, not a local drive. This will help 
prevent problems if other users work with this filing.

• To view an existing attachment, select the document and click View 
Attachment, or double-click the attachment.

• To replace an existing attachment, select the attachment in the 
Attachments table and click Modify, and using the browser that opens, 
locate the required document. Double-click the required document, or 
select the document and click Open. If you have a DMS, select Browse 
DMS if the attachment is located in a DMS. 

• In the No. of Pages field, enter the number of pages in the attached 
document.

• Repeat above steps for additional attachments.

• Use the up and down arrows above the Attachments table to move the 
entries within this table so that the list of attachments are in the correct 
order.

 

5. To add another Other Attachment, click Next. 

OR

• To finish, click OK.
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The new Other Attachment(s) will be added (or the existing Other 
Attachment updated), and the dialog will close.

Note: For SERFF filings: If you attempt to delete or modify an Other Attachment that 
has been affiliated with a SERFF requirement in a filing that has been submitted, 
you will get a warning message.

The Other Attachments Tab — Filing Level

The Other Attachments tab is the area within Tracker in which any supporting 
documentation you want to include in the filing should be attached. You can add 
these other attachments at either the Filing Group or Filing level.

Adding a New (or Editing an Existing) Filing Level Other 
Attachment

If you add other attachments at the Filing level, you can choose whether they print 
with the filing.

Important: When you add an Other Attachment at the Filing Group level, all filings in that 
filing group with a status of Start will automatically contain the Other Attachment. 
You can see these Filing Group level other attachments at the Filing level, and any 
changes made at the Filing Group level will appear at the Filing level in filings 
with a status of Start. If a filing that is not in Start status changes back to Start 
status (as a result of performing or deleting an activity), then any new or modified 
Filing Group level items that were not previously included in that filing are still 
not included in the filing after the status change. However, if you change certain 

fields at the Filing level, marked in this guide with a broken link icon, , the 
other attachment will become independent of changes at the Filing Group level, in 
effect becoming a Filing level other attachment. 

Method: Add a new or edit an existing Filing level Other Attachment

At the Filing level:

1. To create a new Other Attachment, click the New Other Attachment 

toolbar button  or select Insert > New Other Attachment.

The New Attachment dialog displays.

OR

To edit an existing Other Attachment, double-click the attachment on the 
Other Attachments tab.

The Attachment Details dialog displays.
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2. On the General information tab:

• Enter the Title of the new attachment, or edit the existing Title.

• Select an attachment Type from the drop-down menu.

• If required, enter (or edit) text in the Memo box to describe this 
attachment. Text entered here will not appear in the final filing.

• If required, select Enable.

3. On the Attachments tab:
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•  To add a new attachment, click Add, and using the file browser that 
opens, locate the required document. Double-click the required 
document, or select the document and click Open. If you have a DMS, 
select Browse DMS if the attachment is located in a DMS.

Tip: Select a file on a shared network drive or a DMS, not a local drive. This will help 
prevent problems if other users work with this filing.

• To view an existing attachment, select the document and click View 
Attachment, or double-click the attachment.

•  To replace an existing attachment, select the attachment in the 
Attachments table and click Modify, and using the browser that opens, 
locate the required document. Double-click the required document, or 
select the document and click Open. If you have a DMS, select Browse 
DMS if the attachment is located in a DMS.

•  In the No. of Pages field, enter the number of pages in the attached 
document.

• Repeat above steps for additional attachments.

•  Use the up and down arrows above the Attachments table to move 
the entries within this table so that the list of attachments are in the 
correct order.

 

4. To add another Other Attachment, click Next. 

OR

To finish, click OK. The new Other Attachment(s) will be added, and the 
dialog box will close.
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NAIC Filing Descriptions

You can enter the NAIC filing description at the Filing Group level or Filing level. 
For SERFF filings, the information is sent with the filing electronically to the 
state.

When you add a NAIC filing description at the Filing Group level, all filings in 
that filing group with a status of Start will automatically contain the NAIC filing 
description. You can see the Filing Group level NAIC filing description at the 
Filing level, and any changes made at the Filing Group level will appear at the 
Filing level in filings with a status of Start. If a filing that is not in Start status 
changes back to Start status (as a result of performing or deleting an activity), then 
any new or modified Filing Group level items that were not previously included in 
that filing are still not included in the Filing after the status change.

Method: Enter (or edit) the NAIC filing description at the Filing Group 
level

1. Navigate to the Filing Group level of the desired filing group.

2. Click the NAIC Filing Description tab.

3. Enter (or edit) the NAIC Filing Description, then click the Save button on 
the Tracker toolbar.

The filing description is saved and is copied into the filings in this filing 
group. If you change this description later, the change will automatically 
appear in the filings in this filing group, unless you have edited the 
description at the Filing level.

Method: Enter (or edit) the NAIC filing description at the Filing level

If you add or modify the NAIC filing description at the Filing level, the filing 
description will become independent of changes at the Filing Group level, in 
effect becoming a Filing level NAIC filing description, as indicated below by the 

broken link icon.  

If a filing that is not in Start status changes back to Start status (as a result of 
performing or deleting an activity), then the NAIC Filing Description that was not 
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previously included in that filing will still not be included in the filing after the 
status change. 

1. Navigate to the Filing level of the desired filing.

2. Click the NAIC Filing Description tab.

3.  Enter (or modify) the NAIC Filing Description, then click the Save 
button on the Tracker toolbar.

The filing description is saved.
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Entering Filing Fees

Use the Filing Fee tab to enter fee payment information for a filing. If you are 
using SERFF, you can pay by check or EFT: see Paying Filing Fees via EFT on 
page 268.

Entering Filing Fees Paid by Check

If you are paying filing fees by check, complete the following procedure to enter 
the filing fee payment information.

Method: Enter filing fees paid by check

1. Navigate to the desired filing

2. Click the Filing Fee tab.

3. Under Payment Method, select Check.

4. If any portion of the fee is being paid on a retaliatory basis, click Yes in the 
Is Fee Retaliatory? section.

5. Click Add Payment.

The Check Details dialog displays.
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6. Enter the Check Date, Check # and Check Amount.

7. Enter any descriptive notes in the Comments field.

8. To enter another payment, click Next, otherwise click OK.

The check payments you entered are displayed in the Payment History 
Details table at the bottom of the Filing Fee tab.

9. Enter any descriptive information in the Fee Explanation field.

10. Click the Save button on the Tracker toolbar to save your changes.

Editing Filing Fee Check Payments

Note: You can edit all the fields in the Check Details dialog box before submitting the 
filing. Once submitted, only the Comments field and Fee Explanation field can 
be edited.

Method: Edit check filing fee payments

1. Navigate to the desired filing.

2. Click the Filing Fee tab.

3. Scroll down to the Payment History Details table.
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4. Double-click any of the payments listed in the Payment History Details 
table. 

5. Make any required changes.

6. Click OK.
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Copying Filings

Tracker supports the ability to create new filings based on existing filings.

This section includes the following topics:

• Copying Attributes on page 190

• Copying Multiple Filings on page 191

• Copying Schedule Items on page 191

• Copying Filings on page 191

Copying Attributes

The new filings you create by copying will have the following attributes copied 
from the original (not revised) version of the selected filing(s):

• Filing Group-level NAIC filing description

• Filing Group-level Market Type fields

• Product field

• State field

• LOB field

• Group # field

• Company field

• Project Start Date field

• Filing Type field

• Custom field

• Description field

• Filing Statute field

• All comments in the Comments tab

• All users in the Resources tab

The new filings you create by copying will not have the following attributes 
copied from the original (not revised) version of the selected filing(s):

• Filing Status is set to Start

• A unique Filing ID is assigned (the sequence number component of the 
Filing ID is incremented)

• Filing Manager is set to current user

• Retaliatory is set to blank

• PaymentMethod is set to blank
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For SERFF filings:

• Copy Filing functionality does not copy public access information, nor does 
it copy TOI, SubTOI or Filing Type information.

• The SERFF status of copied items (including the SERFF status) is empty or 
blank.

Copying Multiple Filings

To create multiple filings when you copy, select multiple filing types in the dialog 
and Tracker will create a copy of the original filing with each of your selected 
filing types. These copies are usually separate filings, but Tracker will combine 
filings based on type of filing and the rules for combined filings in the states 
selected.

When copying combined filings, if you select the filing types for your copy that 
are the same as the original, Tracker will create a combined filing like the original; 
it will not split the combined filing into multiple, separate filings.

Copying Schedule Items

When copying filings, you have the following mutually exclusive options 
regarding the schedule items:

1. Include Group level items

2. Include Group and Filing level items

With option 2, the new filings will contain all Filing-level forms, rates, 
advertisements, and other attachments associated with the filing(s) being copied, 
including all metadata for each attachment, attachment paths, sub-tabs and data on 
sub-tabs, and so on—everything for each attachment. The following also results:

• The Filing level attachments in the new filing(s) have the same relationship 
with the filing group as the original filing, that is, if the link with the Filing 
Group attachment is broken, the link in the copy is also broken. 

• The Filing level-NAIC Filing Description from the filing(s) is copied and 
its relationship with the filing group is maintained, that is, if the link with 
the filing group is broken, the link in the copy is also broken.

• The Enable setting is copied.

• On the Status sub-tab, the State Specific indicator and the Enabled 
indicator are copied, all other fields will be empty or blank.

• All Related Filings information is copied.

Copying Filings

When creating copies of existing filings, you can choose to use new or existing 
Filing Group-level attachment types.
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Method: Copy a filing

1. Navigate to the Filing Group level and highlight a filing.

2. Click Insert > Copy Filing.

The Copy Filing dialog displays.

3. Complete one of the following steps:

To create copies with the same filing type and Group-level items:

a. Select Include Group Level Items

The default No Change is selected.

b. Click OK.

The Copy Filing dialog closes. The result of the copy is displayed. 

c. Click OK.

The list of filings is updated with the new filing(s).

OR

To create copies with different filing types:

a. Select Change Type.

The filing type selectors become active.

b. Select the filing type(s) for the new filing(s).

c. Click OK.

The Copy Filing dialog closes. The result of the copy is displayed. 

d. Click OK.

The list of filings is updated with the new filing(s).

OR
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To create copies with the same filing type using Group-level and 
Filing-level items:

a. Select Include Group & Filing Level Items.

b. Click OK.

The Copy Filing dialog closes. The result of the copy is displayed. 

c. Click OK.

The list of filings is updated with the new filing(s).
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Chapter 6

Working with Common Filing
Tasks

This chapter deals with tasks you will perform when you are creating filings 
within Tracker.

This chapter describes:

• Filing Resources on page 196

• Filing Letter Comments on page 197

• Activities on page 198

• Related Legislation on page 199
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Filing Resources

This section describes resources and how they relate to filings. Resources refer to 
employees at your company who are involved in the filing process. 

The Resources Tab

The Resources tab displays a list of company personnel responsible for various 
facets of the filing and the product to which it belongs. 

Resources are entered into the system via the administrative User and Company 
functions. See User Profiles on page 68 and Adding New Companies on page 43 
for more information on how to add users and companies to Tracker.

Entering Filing Resources

When you create a filing, the Resources tab will be automatically populated with 
the resources listed for the company to which the filing pertains. You may, 
however, choose to change the resources listed for a particular filing.

Method: Enter filing resources

1. Navigate to the filing where you want to enter resources.

2. Select the Resources tab.

3. For each applicable personnel type field select a name from the related drop 
down list.

4. Click Save to save your resources information.

Resources may be edited at any time. Always click Save  when you have 

finished editing to ensure that your changes are preserved.
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Filing Letter Comments

This section describes filing letter comments and how they relate to filings.

The Comments Tab

The Comments tab provides a number of large text fields in which you can enter 
comments to add extra information to your filing letters. Any information entered 
here will automatically be added in the appropriate places to any relevant filing 
letters created for that filing.

Adding Filing Letter Comments

At the Filing level:

1. Select the Comments tab.

2. Locate the text field for the type of comment you want to add.

3. In the text field type the comment as you want it to appear on the letter.

4. Repeat steps 2 and 3 for all comments required.

5. Click Save to save your comment information.

Note: Comments may be edited at any time. Always click Save  when you have 

finished editing to ensure that your changes are preserved.
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Activities

This section describes activities at the Filing level:

• Specific Filing Level Activities on page 198

• The Activities Tab – Filing Level on page 198

Specific Filing Level Activities

A number of specialized functions are accessed and performed via the Filing level 
Perform Activity function.

Filing letters can be accessed within certain types of activities. The activity dialog 
box then allows you to select the type of letter required. Information to populate 
the letter is automatically taken from the administrative, regulatory, and filing 
specific information (such as letter comments) already entered into the system.

Any additional documents required for a filing, such as actuarial proofs, or 
marketing brochures, can also be accessed and attached via the Activities 
function. You simply choose an Attachment activity, and then browse for, and 
attach, your file. You can even make notes regarding the attachment in the 
activity’s memo field. Document attachments can also be edited via the Activities 
function, as long as the software used to create those attachments is available on 
the system running Tracker.

The generation of completed filings is also done via the Perform Activity 
function. The generate filing activity gathers together all of the documents 
specified for the filing.

The Activities Tab – Filing Level

The Filing level Activities tab lists all activities that have been performed upon 
(or are pending performance upon) this filing. From this tab you can access the 
activity details for any of the activities listed.
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Related Legislation

This section describes legislation at the Filing level. These topics include:

• The Legislation Tab on page 199

• Adding a Legislation Reference on page 199

The Legislation Tab

Filings are often created in response to the receipt of legislation bulletins from an 
advisory organization or legislative body. The Filing level Legislation tab 
displays information about a legislation record in the system related to or 
pertaining to this particular filing. The information contained on this tab is 
identical to the information presented on the related legislation record’s details 
screen; see The Legislation Details Tab on page 354 for more information.

Note that the Legislation tab appears at the Filing level only if that filing was 
created or referenced in relation to a particular legislation record in your system.

Adding a Legislation Reference

A legislation reference can be added to a filing only from the originating 
legislation details screen. This occurs automatically when a filing is created 
directly from a legislation record. A reference can also be created manually from a 
legislation detail record by using the Insert > New Filing Reference option. See 
Linking Legislations to Filings on page 360.
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Chapter 7

Working with Activities

This chapter provides detailed information about performing, posting, and 
working with activities in the Tracker system. Instructions for performing 
activities for filing groups, filings, multi-filings, and legislation are also contained 
here, including instructions for attaching filing letters and actuarial exhibits to a 
filing, and procedures for generating and printing filings.

This chapter describes:

• Tracker Activities on page 202

• Standard Tracker Activities on page 204

• Standard SERFF Activities on page 206

• Performing Basic Activity Procedures on page 207

• Performing Filing Activity Procedures on page 218

• Working with Attachments on page 225

• Performing Activity Searches on page 229

• Multi-Filing Activities on page 231



WORKING WITH ACTIVITIES

202 TRACKER L&H USER GUIDE

Tracker Activities

In the Tracker system, an Activity is any action related to or performed upon a 
filing group, filing, or Legislation record. These actions can be anything: 

• creating a memo or a note-to-self

• recording a phone call to/from a state insurance department

• generating a filing, and so on.

All of these actions can be recorded and kept as a history within the activity 
function. The Filing Level Activity function encompasses a wide range of 
passive and active activities, including generating, editing, and printing filing 
documents. 

Passive Activities

Passive activities are usually related to recording information (for example, the 
recording of a memo or phone call in relation to a record). They do not change any 
documents related to a filing.

Active Activities

Active activities are usually related to generating documents (for example, 
creating a filing letter, or generating and printing a complete filing). They 
generally update or create documents related to a filing.

Status Changes and Active Activities

Some activities update status fields or dates in the system, so that your record is 
automatically updated when you perform that activity. For example, when you 
perform an activity to record the receipt of DOI approval for a filing, the activity 
automatically updates the status of the filing record to Approved and updates the 
Approval Date of the filing record to the date specified in the activity). 

Activities and Post Activities

Activities can be Performed (performed and recorded under today’s date or given 
a past date) or Posted (recorded with a future date or suspense date to act as a 
reminder); each function has a separate menu option and toolbar button accessible 
on any of the Filing Group level, Filing level, or Legislation Activity tab screens. 
The Post Activity function is especially useful for setting Suspense Dates to 
remind yourself (or your co-workers) about due dates and tasks which need to be 
completed on or by a certain date.

Any record having a future or suspense dated activity attached to it is flagged with 
the date and activity description where it is listed in the main tab screens (such as 
the Filing Groups tab, the My Filings – All tab, the Filings tab, the My Filings 
tab, and the Legislations tab). Also, the Suspended button located above each of 
these tab screens can be pushed to show only those records having a future or 
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suspense activity attached, so that you can view only those records that need to be 
worked with, and can see what tasks you have upcoming.

The Activities Tab – Filing Group Level

The Filing Group level Activities tab lists all activities that have been performed 
upon (or are pending performance upon) this filing group. From this tab, you can 
access the activity details for any of the activities listed.
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Standard Tracker Activities

Tracker comes with a set of over thirty standard activities covering most of the 
activities you will want to perform in relation to your filing group, filing, and 
legislation records. If there are other activities you want to be able to perform 
through this function, or if you want to tailor some of the activities to your own 
needs, this can be done through the Tracker administrative Custom Tables 
function, or by an Tracker Support Representative. Contact your Tracker 
administrator, or see Activity Codes on page 80.

The following table lists of all the standard activities in the Tracker system, and a 
brief description of their function.

Activity Description

Approve Filing in System Use this activity to record the receipt of a DOI’s approval of a 
filing.
It updates the status of the filing to Approved.

Attach Exhibit/
Backup Material

This activity allows you to attach a document, exhibit, or other 
backup material to a filing.

Background Information This allows you to enter background or extra information 
about a record.

Build Rate for EDP System Use this activity to enter/update your Build Rate for EDP date 
for a filing.

Correspondence for Filing Use this activity to generate a correspondence letter to a DOI 
(Department of Insurance) for a filing. It updates the status of 
the filing to Pending.

Form Development Record information regarding form development using this 
activity.

Form Revision Use this activity to enter and track form revision information.

Generate Complete Filing This activity lets you generate a complete filing, view it, and 
then print it out.
It updates the status of the filing to Pending.

Generate Letter This activity lets you generate, view, and print a filing letter; 
you may choose from several types of letter.

Instructions for Filing Use this activity to record instructions for tasks to be 
performed upon this filing at a later date.
This activity can be post-dated. It will appear on the Filing 
Approval Notification Report.

Instructions for Legislation Use this activity to record instructions for tasks to be 
performed upon this filing at a later date.
This activity can be post-dated. It will appear on the Filing 
Approval Notification Report.
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Note: Not all activities are available at every level of the system. Filing Group level and 
Legislation activities are generally limited to information-recording activities 
(such as memos and notes, background information, and suspense dates), while a 
much wider of activities may be performed upon at the Filing level (such as 
generating letters and filings).

Inter-Department Request Use this activity to record a request for action or information 
to another department.
This activity can be post-dated.

Mail Filing to DOI Use this activity to record the date that a filing was sent to a 
state DOI (Department of Insurance).

Memo/Notes The Memo/Notes activity allows you to enter notes and 
information about a record as you work with it.

Respond to DOI – 
Objection

Use this to create a response letter following a DOI 
(Department of Insurance) Objection.
Updates the status of the filing to Pending.

Respond to DOI – 
Resubmit Filing

Use this to create a re-filing letter following a response from a 
DOI (Department of Insurance).
Updates the status of the filing to Pending.

Response from DOI – 
Disapproved Filing

Records the date of the receipt of a Disapproval from a DOI 
(Department of Insurance).
Updates the status of the filing to Disapproved.

Response from DOI – 
General

Records the receipt of a Response from a DOI (Department of 
Insurance).

Response from DOI – 
Objection

Records the date of the receipt of an Objection from a DOI 
(Department of Insurance).
Updates the status of the filing to Objection.

Schedule Mailing Date
to DOI

Use this activity to set a scheduled mailing date.
This activity can be post-dated.

Set Suspense Action Date This activity allows you to post a future suspense (reminder) 
date.

Update Objection Respond by 
Date

Use this activity to document a change to the Respond by Date

Withdraw Filing Use this to create a withdrawal letter and record the date when 
you withdraw a filing from a DOI.
Updates the status of the filing to Withdrawn.

Activity Description
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Standard SERFF Activities

If you are using Tracker with SERFF, the following standard activities are 
included to help you manage and submit your SERFF filings. 

Activity Description

SERFF: Generate SERFF 
Filing

Use this activity to generate and submit a filing to SERFF after 
you have finished developing it.

SERFF: Get Filing 
Requirements

Use this activity to retrieve the requirements for a SERFF filing 
from the given state for your selected combination of TOI, sub 
TOI and filing type for that state.

SERFF: Submit Note to 
Reviewer

Use this activity to submit a note to the state reviewer for an open 
or closed filing (if allowed by the state).

SERFF: Submit Additional 
Fee

Use this activity to allocate and submit EFT fee payments.

SERFF: Submit Filing 
Amendment

Use this activity to submit an amendment to a filing. This can 
include revised or additional schedule items.

SERFF: Submit Objection 
Response

Use this activity to submit a objection response to an objection 
letter. 

An objection response may include revised and/or additional 
schedule items.

SERFF: Submit 
Confidentiality Request

Use this activity to request confidentiality for all or part of a 
filing.

SERFF: Submit Post 
Submission Update

Use this activity to submit changes to a filing after submission.
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Performing Basic Activity Procedures

This section describes basic procedures used with activities:

• Performing an Activity on page 207

• Performing Activities with an On Approval Option on page 209

• Posting an Activity on page 210

• Accessing a Single Activity Detail Record on page 212

• Editing an Activity Detail Record on page 213

• Completing an Activity on page 214

• Completing a Recurrent Activity on page 216

• Deleting an Active Activity Detail Record on page 216

• Deleting a Passive Activity Detail Record on page 216

Performing an Activity

Use the following method to perform an activity from a Filing Group or Filing 
level, or Legislation screen Activities tab screen.

Method: Perform an activity

1. Click Perform Activity on the toolbar. 

The Perform Activity dialog displays.

2. In the Perform Activity dialog, select the activity you want to perform.
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3. Click Perform. 

The Perform Activity dialog for the selected activity displays.

Note: The following describes the steps in the Generate Letter activity. Each activity 
dialog will look slightly different.

4. Enter information in the applicable fields:

• Usually, the default Description should be used.

• The Date field will automatically be filled in with today’s date.

• The Performed By field will automatically be filled in with your name.

• Indicate the Priority of the activity by clicking in one of the Low, 
Medium, or High selection buttons (the default priority is Medium).

• If you are generating a filing letter, select a Letter Type from the drop-
down list to the right of the field.

• Clear the View, Print, Draft, and Print One Copy check boxes as 
required.

If you select the View check box, the generated letter will open in a 
Microsoft Word window for viewing. You may then use Word’s print 
command to print the letter, if desired.

If the Print check box is selected, the letter will automatically be 
printed following generation.

If you select the Draft check box, the letter will be generated, but will 
not be saved for future viewing in the activity record.
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If you select the Print One Copy check box, only one copy of each 
document in the filing package will be printed. You might do this if you 
wanted to review the entire filing package and did not want to print out 
the multiple copies of each document that are usually required with a 
complete filing package.

• Use the View/Draft check combination to generate and preview draft 
filing letters. If you want to generate and save a letter, and have it 
generate and print as part of the final Complete Filing generation, make 
sure that you clear the Draft check box.

Generated (non-draft) letters will be saved, and will be accessible later 
from the activity detail record.

• Use the Attach File field to enter the location (path) of a document file 
you want to attach to the filing (such as an extra form or exhibit). You 
can type in the path (to a maximum of 255 characters) or click the 

browse button  located to the right of the field to locate and select 
the correct path. The attached document will then be accessible from the 
activity detail record.

All attachments that you want to have generated and printed as part of 
the final filing must be performed with both View and Print selected, 
and Draft cleared.

• Use the large Memo field to record the main text or information such as 
a note, memo, or phone message. This field can also be used to add 
extra text to any filing letter.

5. Click Perform. 

The activity will be performed and will appear on the related Filing Group, 
Filing, or Legislation Activity list tab.

6. To finish, click OK. 

The new activity will be performed or recorded, and the dialog will close.

Performing Activities with an On Approval Option

The Implementation Date may be affiliated with an activity by the Tracker 
Administrator. (See Adding Active Activity Codes on page 82.) In some cases, you 
will have an On Approval option in addition to the default calendar setting.
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If the Administrator has not configured the activity for the On Approval option, 
when you perform the activity, you will see a date selection button, but not the On 
Approval checkbox.

If the Administrator has configured the activity for the On Approval option, the 
default option is with the calendar unlocked and the On Approval check box not 
selected. If you select the On Approval check box, the system will clear the 
calendar and lock it. If you want to revert back to an actual date, you need to clear 
the On Approval check box. The system will then unlock the calendar and allow 
you to pick a specific date.

Posting an Activity

Posting an activity allows you to specify a future target date on which that activity 
should be performed. This is very useful when posting suspense dates, or giving 
instructions which need to be performed at a future date.

Method: Post an activity

1. From a Filing Group or Filing Level, or Legislation Activities tab screen, 

click the Post Activity toolbar button  to open the Post Activity list 
box.
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2. In the Post Activity list box, select the activity you want to post.

3. Click Post.

The Post Activity dialog displays. (The example below is for the Set 
Suspense Action Date activity. Each activity window will look slightly 
different):



WORKING WITH ACTIVITIES

212 TRACKER L&H USER GUIDE

4. Enter information in the applicable fields.

Use the Description field to enter a brief description of the activity you are 
posting. Usually, the default Description can be used. 

In the Suspense Date field, enter the date on which you want this activity to 
be performed (such as the suspense dates, reminder dates, due dates, and so 
on).

The Due Date field is the actual date on which this activity must be 
completed. This field allows you to bring up activities by suspense date 
before the due date.

The Performed By field will automatically be filled in with your name; you 
may select a different name if someone else is to perform the posted activity.

Indicate the Priority of the activity by clicking in one of the Low, Medium, 
or High selection buttons (the default priority is Medium).

Use the Memo field to record the main text or information of a suspense 
note, memo, or instruction.

5. Click Post.

The activity will be posted and will appear on the related Filing Group, 
Filing, or Legislation Activity list tab.

Accessing a Single Activity Detail Record

You can display the details of any activity record.
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Method: Access an activity detail record

1. Navigate to the required filing group, filing or Legislation.

2. Click the Activities tab.

3. Select the activity record you want to complete, and double-click it to open 
the related Edit Activity dialog.

4. Click OK or Cancel when finished viewing the record.

Editing an Activity Detail Record

You may edit, change, or add to the information on an activity detail record at any 
time (provided that you have a system security level which permits editing).

Method: Edit an activity record

1. Navigate to the required filing group, filing or Legislation.

2. Click the Activities tab.

3. Select the activity record you want to complete, and double-click it to open 
the related Edit Activity dialog.

It will look like the original Perform Activity or Post Activity dialog, but 
will have additional fields. (The example below is for the Generate 
Complete Filing activity. Each Edit Activity box will look slightly 
different.)
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4. Make any necessary changes or additions to the information displayed on 
the screen.

Note that:

• The Post Activity Memo field allows you to store information pertinent 
to the completion or results of an activity.

• The Documents field will list any documents generated in the original 
posting.

To view one of these documents, select it from the list and click View 
Document. The document opens in its native application.

5. Click OK to save your changes and exit the dialog.

Completing an Activity

When you post an activity for a future date, you leave it open until that activity 
has been performed, for example, until you’ve forwarded the necessary 
documents, made the required phone call, finished the task, and so on. When you 
have finished a posted activity, you should open the related activity record and 
note that it has been completed, and then close the record. It will then appear as 
Completed in the related Activities list tab.
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Method: Complete an activity

1. Navigate to the required filing group, filing or Legislation.

2. Click the Activities tab.

3. Select the activity record you want to complete, and double-click it to open 
the related Edit Activity dialog.

It will look like the original Post Activity dialog, but will have additional 
fields. (The example below is for the Set Suspense Date activity. Each Edit 
Activity box will look slightly different):

4. In the Post Activity Memo field, enter any information relating to the 
performance or completion of the original posted activity.

5. When you have added any necessary notes, click OK.

If today’s date is equal to or later than the original suspense date, a message 
appears asking if you want to complete the activity.

6. Click Yes to complete the activity, or click No to leave the activity open if 
you haven’t yet completed all required tasks.

Your changes will be saved and Edit Activity will close.
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Completing a Recurrent Activity

Follow this method to complete a recurrent activity. After you complete a 
recurrent activity you can optionally create a new filing.

Method: Complete a recurrent activity

1. Navigate to the desired filing, open the activity, on the due date, that you 
want to complete.

2. Click OK.

A dialog displays asking you if you want to complete the activity.

3. Click Yes.

A dialog displays.

4. Click No to complete the recurrent activity but not create a new filing.

OR

Click Yes to complete the recurrent activity and to create a new filing.

5. If you click Yes, you are prompted to choose the filing group in which the 
new filing is created.

Once the new filing is created, the recurrent activity is created for this filing. 
The suspense date and due date of the recurrent filing are incremented by the 
period specified by the activity type.

Deleting an Active Activity Detail Record

Activities should only be deleted when absolutely necessary. Only the most 
recently performed (or posted) activity attached to a record may be deleted. 
Therefore, to delete the third last active activity performed, you need to delete 
every activity which followed it as well. Deleting an activity reverses any actions 
performed in the system (such as status or date updates) as a result of that activity.

Method: Delete an activity detail record

1. Navigate to the required filing group, filing or Legislation.

2. Click the Activities tab.

3. Select the activity you want to delete.

4. Click Delete on the toolbar.

5. Click Yes to delete the activity, or No to cancel.

Deleting a Passive Activity Detail Record

Passive activities can be deleted in any order.
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Method: Delete a passive activity detail record

1. Navigate to the required filing group, filing or Legislation.

2. Click the Activities tab.

3. Select the activity you want to delete.

4. Click Delete.

5. Click Yes to delete the activity, or No to cancel.

Note: Because the activity feature helps you to track, as a history, all actions performed 
during the filing process, it is recommended that you perform a new activity each 
time you perform an action, or that you edit an existing activity only by 
responding to and adding to the information already recorded, rather than deleting 
existing activity information.
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Performing Filing Activity Procedures

This section describes activities specific to filings:

• A Sample Filing Letter on page 218

• Information In the Filing Letter on page 220

• Filing Letter Comments on page 221

• Activities and the Filing Package Tab on page 221

A Sample Filing Letter

On the following page is a sample of a Long Filing Letter, containing all possible 
elements. In this example, filing letter Comments information appears on a gray 
background (this information is entered via the Filing level Comments tab; see 
The Comments Tab on page 205 for details). Other portions of the letter are 
generated automatically by the system from information previously entered for 
the filing, and from the Regulatory Specialist records that you entered for that 
state and line of business.
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Information In the Filing Letter

The following information is included in a typical filing letter. This information is 
drawn from various data already entered in connection to the filing, and from the 
Regulatory Specialist records you entered for that state, line of business, and filing 
type.

Note: Each letter format contains slightly different information, depending on its scope 
and purpose.

• Date
Tracker checks for any filing date first. If there is no filing date, then Tracker 
looks for the activity date. Either of these dates could be the current date. 
This date can be edited in Microsoft Word if required.

Note: When generating a letter using the Generate Complete Filing activity, the letter 
uses the filing date that is entered in the activity, not today’s date.

• Name and Address
The name and address of the State Insurance Department are generated 
automatically. If you are creating multiple filing letters, each one will have a 
different Insurance Department name and address.

• Attention Line
The attention line is generated automatically.

• Reference
Reference information includes the NAIC Number, FEIN Number, Tracker 
Filing Identification Number, and the State ID. It is automatically generated.

• Salutation Line
The title of the recipient is automatically generated.

• Introductory Paragraph
The first paragraph is automatically generated.

• Activity Memo
Any information from the activity memo field is included in the letter.

• Form Information
If the filing includes Forms, this section is included in the letter. For each 
entry identified as a form, the system automatically includes the form 
number, revision date, and description. If this is a replacement form, the 
replaced form number is identified if it has been entered in Tracker. If it is a 
new form, it is identified as an introductory filing.

If you want to include descriptive information for each form, such as its 
purpose or deviations from industry standard form provisions, you can add 
an explanatory comment from the form detail memo field. 

• Rate Information
If the filing includes Rates, this section is included in the letter. For each 
entry identified as a manual rate page, the system automatically includes the 
rate page number, edition, and description. If this is a replacement page, the 
replaced page is identified. If it is a new page, it is identified as an 
introductory filing.
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If you want to include supporting arguments to explain or justify a rate 
filing, you can add an explanatory comment. If you want to include 
comments about the specific rate effect for the proposed rate change, you 
can add such comments in the memo field of each rate.

• Advertisement Information

If the filing includes advertisements, this section is included in the letter. For 
each entry identified as a advertisement, the system automatically includes 
the advertisement title, name, and the advertisement number. If this is a 
replacement advertisement, the replaced advertisement number is identified. 
If you want to include comments about the advertisement, you can add such 
comments in the memo field of each advertisement.

Filing Letter Comments

Depending on what has been specified in your filing, you may need to enter some 
comment information as part of the filing letter creation process. Filing letter 
comments are added in at the Filing level. See Filing Letter Comments on page 
344.

Activities and the Filing Package Tab

Activities can be added to the Filing Package tab, as well as any supporting 
documentation for those activities. Any files attached to them will be converted to 
Portable Document Format (PDF). All files converted in this fashion will also be 
printed when you generate the complete filing package.

Note: Once you have moved activities to the filing package, you cannot modify or delete 
the activities or their supporting documents. However, you can edit text in the 
Post Activity Memo field.

Method: Add an activity to the Filing Package

1. Click the Perform Activity button. 

2. Select the activity you want to perform and click Perform.

The activity dialog displays.
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3. On the Perform Activity dialog, attach the file you want to associate with 
this activity and print in the filing package by clicking the Browse button.

The Activity File Attachment file browser displays.

4. In the Activity File Attachment file browser, choose the file you want to 
attach and click Open.

5. Click Move to Filing Package.

6. Click Perform.
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7. On the message box that opens (text below), click Yes.

Option “Move To Filing Package” has been chosen. Once the activity 
has been moved to the Filing Package tab, you will not be able to edit or 
delete the activity not will you be able to edit, replace or delete any of 
the documents(s) contained within the activity. Do you want to proceed?

The PDF printer creates a PDF copy of the attachment and saves the copy in 
the directory where the attachment is located.

8. After the Status window that opens has finished updating, click Close.
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The PDF file you created will be printed out on all subsequent printings of 
the complete filing package and appears in the Filing Package tab.
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Working with Attachments

The following section deals with using attachments with filings:

• Attaching Documents to a Filing on page 225

• Generating and Printing Filings on page 225

• Performing the Filing Approval Activity on page 226

Attaching Documents to a Filing

You may add extra documents to a filing using an attachment activity.

Method: Attach a document to a filing

1. Navigate to the filing you want to attach a document to.

2. Click the Perform Activity button  to open the Activity List box.

3. Click the desired attachment activity.

4. Click Perform to open the related Activity dialog.

5. Enter any required information in the fields provided.

6. Click the  button beside Attach File field to open a file browser.

7. Select the file path for the document you want to attach. (The path name 
cannot exceed 255 characters.)

8. Click Open to confirm the file path and return to the activity dialog.

The selected file path will now appear in the Attach File field.

9. Click Perform to save the activity and exit the dialog.

Note: This attached document will be printed as part of the entire filing, but only when 
the Generate Complete Filing activity is performed.

Generating and Printing Filings

Once you have added and completed all the components of a filing, the entire 
filing can be generated and printed using a single activity command. When you 
generate and print a filing, all documents related to or attached to the filing will be 
generated and printed, including:

• any filing letters created for the filing

• any attached rate, advertisement, or form pages (as specified)

• any additional documents or exhibits which you have attached in either the 
Other Attachments tab or within the activity of Generate Complete Filing.
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Method: Generate and print a filing

1. Navigate to the filing you want to generate and print.

2. Click the Perform Activity toolbar button  to open the Activity List 

box.

3. Select the Generate Complete Filing activity.

4. Click Perform to open the related New Activity box.

5. Enter information in the applicable fields:

• Use the large Memo field to record any notes regarding the filing. This 
text will appear in the generated letter.

• Attach documents such as actuarial memorandum (if desired), using the 

Browse button  in conjunction with the Attach File field.

6. Click Perform.

The filing generates. During the generation process, a Document Generation 
window appears, tracking the generation in progress (this may take a while, 
depending on the size of the filing). The document then opens in Microsoft 
Word. Here you can view and print the filing letter, as required.

7. Close Microsoft Word.

8. Click OK to finish.

The activity will be saved and listed on the filing’s Activity tab. The filing 
documents will remain available via the corresponding activity detail 
record.

Performing the Filing Approval Activity

Use this method to approve a filing’s Rate/Form/Advertisement.

Method: Perform the Filing Approval activity

1. Navigate to the filing where you want to perform the Approve Filing in 
System activity.

2. Click the Perform Activity button. 

The Perform Activity window opens.
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3. Select Approve Filing in System and click the Perform button.

The Perform Activity – Approve Filing in System window opens.

4. Using the calendar popup boxes, select the Approval Eff. Date and 
Approval Date.

5. Click Perform. 



WORKING WITH ACTIVITIES

228 TRACKER L&H USER GUIDE

A Status Message window opens indicating whether the activity was 
performed successfully. 

6. Click Close.

You can see that the status for the filing is changed to Approved. As well, 
the status for the Rate/Form/Advertisement is changed to Approved.
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Performing Activity Searches

You can search for activities using the Search function. When you find the 
appropriate activity, you can open the filing, filing group, or legislation with the 
Activities tab visible when you select this activity from the search window.

The following tasks deal with activity searches:

• Activity Search Options on page 229

• Searching for Activities on page 229

Activity Search Options

The following options are available to you when a search is performed on 
activities. Each description of the option also contains the details provided in the 
search results:

Activities: When this option is selected from the Search For drop-down box, all 
activities that meet the defined criteria are displayed in the search results. The 
results provide you with the activity description, who initiated the activity, the 
status, the activity code, and the source type (filing group, filing, or legislation).

Activities – Filing Groups: When this option is selected from the Search For 
drop-down box, all of the activities in filing groups that meet the defined criteria 
are displayed in the search results. The results provide you with the filing group 
number, the activity description, who initiated the activity, the status, and the 
activity code.

Activities – Filings: When this option is selected from the Search For drop-down 
box, all of the activities in filings that meet the defined criteria are displayed in the 
search results. The results provide you with the filing number, the activity 
description, who initiated the activity, the status, and the activity code.

Activities – Legislations: When this option is selected from the Search For drop-
down box, all of the activities in filings that meet the defined criteria are displayed 
in the search results. The results provide you with the legislation number, the 
activity description, who initiated the activity, the status, and the activity code.

Note: Because all of the headings cannot fit into the Search Result tab, you must use the 
scroll bar if you want to view the complete result details.

Searching for Activities

To search for an activity, complete the steps described in Performing Tracker 
Searches on page 376. The activity search options in the Search For drop-down 
box are described in Activity Search Options on page 229.

After performing the search, the Search Results dialog displays, from which you 
can select an activity.When selecting an activity from the Search Results tab of 
the Tracker Search window, you can view the associated filing, filing group, or 
legislation for that activity immediately, allowing you to determine if this is the 
appropriate activity. Because the Tracker Search window remains open, you 
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have the option to continue selecting activities from the search results until you 
find the right activity.

Method: Select and open a filing, filing group, or legislation from an 
activity search

1. Perform a search for an activity as described above.

2. Select an activity from the Search Results tab and click OK.

The associated filing, filing group, or legislation is displayed behind the 
Tracker Search window with the Activities tab visible.

3. If the selected activity is not the activity you are looking for, repeat the 
above step until you have found the appropriate activity. 

4. Once you find the activity you are looking for, click the Close button on the 
Tracker Search window.
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Multi-Filing Activities

The following sections describe multi-filing activities:

• Performing Activities for a Multi-Filing on page 231

• Posting Activities for a Multi-Filing on page 231

• Generating and Printing Activities on Multiple Filings on page 232

Performing Activities for a Multi-Filing

The Perform Activities function works the same for multi-filings as it does for 
single filings; the activity is simply applied across more than one filing.

Method: Perform an activity for a multi-filing

1. Navigate to the filing group where you want to perform an activity on a 
multi-filing.

2. On either the My Filings or the Filings tab, select all of the filings to which 
you want this activity to apply. You can select multiple filings by holding 
down the Shift (to select a series) or Control (to select random multiples) 
key while you click them.

3. Click the Perform Activity button .

The Activities List dialog displays.

4. Select the activity you want to perform and click Perform.

The related New Activity dialog displays.

5. Enter information in the applicable fields.

Note that:

• The Performed By field will automatically be filled in with your name.

• The Date field will automatically be filled in with today’s date.

• Use the large Memo field to record the main text or information about a 
note, letter, or phone message.

6. To finish, click OK.

The new activity will be performed or recorded, and the dialog box will 
close. The activity record will be added to the activity tabs of all the selected 
filings. These activity details records can now be treated and updated 
individually.

Posting Activities for a Multi-Filing

The Post Activities function works the same for multi-filings as it does for single 
filings; the activity is simply applied across more than one filing.
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Method: Post an activity to a multi-filing

1. Navigate to the filing group where you want to post an activity on a multi-
filing.

2. On either the My Filings or the Filings tab, select all of the filings to which 
you want this activity to apply. You can select multiple filings by holding 
down the Shift (to select a series) or Control (to select random multiples) 
key while you click them.

3. Click the Post Activity button  to open the Activities List box.

4. Click the activity you want to post.

5. Click Post to open the related New Activity dialog.

6. Enter information in the applicable fields.

Note that:

• The Performed By field will automatically be filled in with your name.

• Use the Suspense Date field to enter Suspense Dates, reminder dates, 
due dates, and so forth. You can sort your My Filings and My Filings 
— All tabs by these activity dates.

• Use the large Memo field to record the main text or information about a 
note, letter, or phone message.

7. To finish, click Post. The new activity will be posted, and the dialog will 
close.

The activity record will be added to the activity tabs of all the selected 
filings. These activity details records can now be treated and updated 
individually.

Generating and Printing Activities on Multiple Filings

Generating and printing activities can be performed on multiple filings in the 
same manner as single filings, using the method described for Performing 
Activities for a Multi-Filing on page 231.

Follow the directions above, selecting a generation activity (such as Generate 
Filing – Complete, Generate Filing – Cover Letter Only, and so on) from the 
activity list. The generation will be performed for all of the filings, and the 
documents will be opened in Microsoft Word so that you can view, print, and then 
close the generated documents as required.

Note: Each document generated will contain information specific to that filing, as drawn 
from that filing’s record information. The generation activities will then be added 
to each of the filings’ activity tabs, where the related activity detail records, and 
the generated documents, can later be accessed and modified individually.
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Note: To print a complete filing package, you would not use Microsoft Word. You would 
click the Print Package button on the Edit Activity window.
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Chapter 8 

Working with SERFF Filings

This chapter describes:

• SERFF on page 234

• The SERFF Tab (Filing Level) on page 235

• Working with SERFF Filings En Masse on page 237

• Working with SERFF Filings at the Filing Level on page 246

• Reviewing SERFF Filings on page 265

• Submitting Filings to SERFF on page 275

• Monitoring SERFF Filings and Working with Messages on page 283

• Working with Submitted Filings on page 284

• Working with Closed Filings on page 310

• Working with Public Access/Confidentiality Requests on page 325

• Working with Post Submission Updates on page 312

• Filing Summary for SERFF Filings on page 329

Note: Before performing the procedures described in this chapter, you would need to 
have completed the procedures described in the previous chapter, Working with 
Filings on page 115.
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SERFF

SERFF is the system designed and maintained by the NAIC that allows insurance 
companies to send filings electronically to states that participate in SERFF. In 
contrast to traditional paper-based filings, submitting a filing through SERFF 
allows you to send all required filing documentation electronically. 

Tracker integrates with SERFF to allow you to access the most current state 
requirements for filings as stored in the SERFF filing rules database, including all 
required fillable filing forms. 

The previous chapter (Working with Filings on page 115) described the following 
steps performed in Tracker to create a traditional paper-based or SERFF filing:

• Create your filing groups

• Create your filings 

• Add the filing content of rates/advertisements/forms to your filing

• Add other attachments to your filing under the Other Attachments tab

This chapter describes how to use Tracker to submit filings electronically to 
SERFF and to manage the filing process for electronic filings. You need to 
perform the following procedures, but note that their order depends somewhat on 
your own business process.

1. Selecting the TOI, the sub TOI, and the filing type.

2. Retrieving and reviewing the SERFF supporting documentation filing 
requirements

3. Reviewing the General Instructions.

4. Satisfying or bypassing filing requirements.

5. Creating any user added requirements.

6. Entering State-Specific values.

7. Setting Public Access values.

8. Selecting the filing fee payment method (check or EFT) and entering the 
payment details.

9. Reviewing the SERFF filing details.

10. Generating a draft of the SERFF filing.

11. Reviewing the generated filing.

12. Submitting your filing to SERFF.

13. If necessary, revising or amending submitted filings.
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The SERFF Tab (Filing Level)

Initially, no SERFF tab appears in filings. On the Filing Details tab, a SERFF area 
includes fields (initially blank) for TOI, Sub TOI, and Filing Type. After selecting 
values for these fields, and performing the activity to get the filing requirements, a 
SERFF tab is added to the filing.

SERFF Tab Banner

The SERFF tab contains a banner with the following read-only fields:

• Type of Insurance, Sub TOI, Filing Type – These fields are populated 
with your previous selections for these values.

• SERFF Filing ID – Prior to the submission of the filing via SERFF, the 
system generates the SERFF Filing ID after the SERFF: Get Filing 
Requirements activity is performed.

• SERFF Status – A value does not appear here until the filing is successfully 
submitted via SERFF. The status will change as the filing progresses 
through the review process at the state.

• State Status – A value does not initially appear here but will be populated 
by the system with the value sent from SERFF as the filing moves through 
the review process at the state.

• Submitted – This read-only check box is selected after the filing has been 
successfully submitted via SERFF.

• Public Access – This read-only check box is initially not selected, 
indicating that the filing is not Public Access. The system will select the 
check box when the state sets the public access status of the filing to Yes 
(which occurs when the Public Access status of any item in the filing is set 
to True).

• Primary Reviewer and Other Reviewers – names and phone numbers, if 
available, provided by SERFF

Related topics:

• Working with General Instructions at the Filing Level on page 253

SERFF Tab Subtabs

The SERFF tab contains the following subtabs:
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• Supporting Documentation – Contains the supporting documentation 
schedule item requirements for this filing. From this tab, you can view the 
SERFF filing details, SERFF-specific requirements, form schedules, and 
rate schedules.

• State Specific – From this tab, you can enter any required state values for an 
individual filing.

• Correspondence – This tab displays a table of all correspondence 
associated with this filing, such as Notes to Filers, Objection Letters, Post 
Submission Updates, and Disposition Reports. Double-click an item to open 
it. From this tab, you can also create a Filing Amendments, Notes to 
Reviewers, Post Submission Updates, and Objection Responses.

By default, the entries in the table are sorted by Date Received/Sent, newest 
first (ascending). Right-clicking on the date of an entry displays a context 
menu where you can select to sort the table by that date in ascending or 
descending order. 

• Public Access – From this tab, you can mark certain parts of the filing or the 
filing itself as confidential to request that the state keep these items 
confidential and not make them available via Public Access.

• Log Entries – From this tab, you can view the various SERFF messages 
associated with this filing.

From the SERFF tab and its subtabs, you will perform a variety of tasks to 
prepare the filing for submission to SERFF, as well as to manage the filing 
through the review process. 
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Working with SERFF Filings En Masse

You can work with SERFF filings in two ways:

• en masse (working with multiple filings within a filing group at the same 
time)

• at the Filing level

Initially, you will work with filings en masse because it allows you to enter 
information much more quickly and efficiently. Later in the process, you will 
work with filings at the Filing level. Changes you make at the Filing level will 
appear when working with that filing group en masse.

The procedures that you can perform for filings en masse are:

• Selecting TOI, Sub TOI and Filing Type for Filings En Masse on page 237

• Retrieving Requirements for Filings En Masse on page 239

• Satisfying Requirements for Filings En Masse on page 241

• Bypassing Requirements for Filings En Masse on page 243

Selecting TOI, Sub TOI and Filing Type for Filings En 
Masse

The initial step in preparing a filing for submission to SERFF involves selecting a 
filing’s Type of Insurance (TOI), a sub TOI, and a Filing Type for filings within a 
particular Tracker Line of Business (LOB). The Product Coding Matrix (also 
called simply “the matrix”) is maintained by the NAIC and contains the uniform 
classifications for TOIs, sub TOIs, and Filing Types. The matrix represents a more 
exact and detailed classification than the Tracker LOB.

SERFF assumes that all states are using the matrix. By using the en masse 
procedure below, you can make TOI, sub TOI and filing type selections for all 
states using the matrix by making a single selection.

States where no values are returned are, by definition, non-matrix states. For these 
states, you will have to select the TOI, sub TOI and filing type on a state-by-state 
basis. You can do this within the en masse screen (as described below) or at the 
Filing level, as described in Selecting the TOI, Sub TOI and Filing Type at the 
Filing Level on page 246.

Method: Select a TOI, sub TOI and filing type for filings en masse

1. Navigate to the desired filing group.

2. Click the Select TOI, Sub TOI and Filing Type button on the toolbar  or 
select Insert > TOI Selection.

The TOI, Sub TOI and Filing Type Selection dialog displays. 
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The LOB for this filing group is automatically selected in the Available 
LOBs drop-down list. If there is more than one LOB in this filing group, 
then the LOBs are displayed in the Available LOBs drop-down list in 
alphabetical order, and the first LOB in this list is automatically selected.

3. If there is more than one LOB in this filing group, from the Available LOBs 
drop-down list, select an LOB.

Filings belonging to the LOB you selected are displayed.

4. Ensure that all the filing(s) for which you want to make the TOI, Sub TOI 
and Filing Type selection are selected in the Check Applicable Filing(s) 
column. If this is the first time you are accessing the en masse selection 
screen, by default, all the filings are marked as selected. You can clear or 
select the individual check boxes as necessary. To quickly clear all the 
selected filings, click Uncheck.

5. In the Product Coding Matrix section, first select the TOI, then Sub TOI 
and finally the Filing Type which corresponds to the LOB of your filings.

6. Click Match.

The system compares the selections for TOI, Sub TOI and Filing Type 
with each state’s list of active TOIs, sub TOIs and filing types. Matches for 
each state using the matrix are displayed.
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If no match is found, no value is displayed for the selected state. (If no 
matches are found for any selected filings, a message box appears.) You can 
then manually select a value from a drop-down list in each cell.

Note that the system may find a match for the TOI, but not for the Sub TOI 
or Filing Type. If so, you would then have to make a selection in those cells.

7. When you are done making your selections, click Save.

8. Click Close to exit.

Retrieving Requirements for Filings En Masse

After you have selected a TOI, sub TOI, and filing type, you need to retrieve the 
supporting documentation filing requirements from SERFF.

Note: Supporting documentation filing requirements are referred to as requirements in 
this documentation.

Complete the following procedure to simultaneously retrieve the requirements for 
more than one filing in the same filing group. This is known as working with 
retrieving filing requirements en masse. (See also: Retrieving Requirements at the 
Filing Level on page 250.)

Method: Retrieve the requirements for filings en masse

1. Navigate to the filing group that contains the filings for which you want to 
retrieve the filing requirements.
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2. Click the Retrieve Filing Requirements button in the SERFF tool bar. 

The Retrieve Filing Requirements screen opens.

The Available Filings list includes filings from this filing group

• that have a TOI, sub TOI, and Filing Type populated; and

• for which no filing requirements have been retrieved, whether at the en 
masse level or Filing level

3. In the Available Filings area, select (using click, Ctrl-click or Shift-click) 
the filings for which you want to get the filing requirements.

4. Click the right arrow button. 

The selected filings are moved to the Selected Filings table. The Retrieve 
and Retrieve and Satisfy/Bypass buttons then become active.

5. Click Retrieve.

Tracker displays progress messages as it attempts to download the filing 
requirements for each of the selected filings.

(To retrieve and satisfy or bypass the requirements in one step, you can click 
Retrieve and Satisfy/Bypass. For additional information, see Satisfying 
Requirements for Filings En Masse on page 241 and Bypassing 
Requirements for Filings En Masse on page 243.)

6. Click Close on the message box.

If Tracker finds a direct match between a filing’s TOI, sub TOI, and filing type 
and the state’s current active list, it performs the following actions for that filing:

• retrieves the Filing Requirements
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• performs the Filing Level activity assigned to get the SERFF Filing 
Requirements (this may be a custom activity)

• retrieves the SERFF Tracking ID

• displays the activity on the Activities tab at the Filing level

• locks the TOI, sub TOI and Filing Type values at the Filing level

Tracker will normally find a match, but if it does not, possibly because during the 
time interval between 

a. retrieving the TOI, and

b. retrieving the filing requirements

the state had changed its TOIs, Tracker deletes that filing’s TOI, sub TOI, and 
filing type choices.

When complete, Tracker displays the SERFF Activity Status Message window 
listing success or failed for each filing involved. 

The failed filings will need to have new TOI, sub TOI, and filing type values 
selected before you can repeat this procedure. (See Selecting TOI, Sub TOI and 
Filing Type for Filings En Masse on page 237, or Selecting the TOI, Sub TOI and 
Filing Type at the Filing Level on page 246.)

Note: A SERFF tab will now appear on the filings for which you successfully retrieved 
their requirements.

Satisfying Requirements for Filings En Masse

Note: Supporting documentation filing requirements are referred to as requirements in 
this documentation.

After retrieving the requirements, you can then satisfy the requirements for the 
unsubmitted filings en masse using the Filing Requirements screen.

Using the en masse method, you can only satisfy requirements for which the 
document which applies is an Other Attachment that has been added at the Filing 
Group level. (See Other Attachments on page 187.) To satisfy a requirement with 
just a comment but no Other Attachment, you must use the Filing level method. 
(See Satisfying Requirements at the Filing Level on page 255.)

Method: Satisfy the requirements for filings en masse

1. Navigate to the desired filing or filing group, and click the Satisfy/Bypass 

Requirements button on the Tracker toolbar. 

The Filing Requirements screen opens. It contains a table with the 
following columns:
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• Filings from that filing group that have had their requirements retrieved 
are listed in alphanumeric order by an ID that includes a two-digit state 
code, a two-digit LOB code, a two-digit company code, and a five-digit 
sequence number

• filing Requirements and their corresponding Status

• Satisfy/ByPass Details

Tip: This screen provides a summary of where you are in the process of working with 
requirements. It shows previous work done to filings in this filing group using this 
en masse process, and any work done at the Filing level. However, filings that 
have been submitted to SERFF are not shown.

2. From this screen, you can quickly access additional information:

• To view the details of a requirement, mouse over or double-click the 
Requirement name.

• To view the general instructions of a filing, click General Instructions 
under the corresponding filing ID.

Note: You can quickly open a filing by double-clicking the filing ID. This closes the 
Filing Requirements dialog box, however you can quickly open it again by 
clicking the Satisfy/Bypass Requirements button on the Tracker toolbar. In this 
way, you can quickly toggle between the en masse view and an individual filing.

3. To satisfy requirements by affiliating them with Other Attachments you 
have previously added to this filing group, click Satisfy.

The Satisfy Requirements dialog opens.
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Note: Requirements in bold must be satisfied and cannot be bypassed.

4. Select a document from the Available Supporting Documents drop-down 
list.

The check boxes in the Check column and the Comments box become 
available.

5. Select the check boxes beside the requirements that you want to satisfy with 
the Available Supporting Document you selected.

Note: If a check box is greyed out, you will not be able to affiliate the selected Other 
Attachment with that requirement. This is because the Other Attachment has been 
modified at the Filing level.

6. Enter any optional notes or description in the Comments box.

7. Click Satisfy.

The requirements’ corresponding Status is updated to Satisfied.

8. Repeat steps 4 through 7 to satisfy any other requirements with another 
Available Supporting Document.

9. If you want, you can bypass requirements at this point by clicking Bypass 
and following the steps beginning with step 3 in Bypassing Requirements 
for Filings En Masse on page 243.

10. When you are done, click Close.

Bypassing Requirements for Filings En Masse 
Note: Supporting documentation filing requirements are referred to as requirements in 

this documentation.

After retrieving the requirements, you can then bypass the requirements for the 
unsubmitted filings en masse using the Filing Requirements screen.
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Note: Certain requirements may be designated by the state as “non-bypassable.” You 
cannot bypass these requirements; you can only satisfy them. These requirements 
will be displayed in bold.

Method: Bypass the requirements for filings en masse

1. Navigate to the desired filing or filing group, and click the Satisfy/Bypass 

Requirements button on the Tracker toolbar. 

The Filing Requirements screen opens. It contains a table with the 
following columns:

• Filings from that filing group that have had their requirements retrieved 
are listed in alphanumeric order by an ID that includes a two-digit state 
code, a two-digit LOB code, a two-digit company code, and a five-digit 
sequence number

• filing Requirements and their corresponding Status

• Satisfy/ByPass Details

Tip: This screen provides a summary of where you are in the process of working with 
requirements. It shows previous work done to filings in this filing group using this 
en masse process, and any work done at the Filing level. However, filings that 
have been submitted to SERFF are not shown.

2. From this screen, you can quickly access additional information:

• To view the details of a requirement, mouse over or double-click the 
Requirement name.
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• To view the general instructions of a filing, click General Instructions 
under the corresponding filing ID.

Note: You can quickly open a filing by double-clicking the filing ID. This closes the 
Filing Requirements dialog box, however you can quickly open it again by 
clicking the Satisfy/Bypass Requirements button on the Tracker toolbar. In this 
way, you can quickly toggle between the en masse view and an individual filing.

3. To bypass requirements and provide a reason, click Bypass.

The Bypass Requirements dialog displays. All the check boxes and the 
Bypass Reason box become available.

4. Enter a reason in the Bypass Reason box.

5. Select all the requirements that you want to bypass using this reason.

6. Click Bypass.

The requirements’ corresponding Status is updated to Bypass, and the 
reason is displayed in the Satisfy/Bypass Details column.

7. Repeat steps 4 through 6 to bypass any other requirements.

8. If you want, you can satisfy requirements at this point by clicking Satisfy 
and following the steps beginning with step 3 in Satisfying Requirements for 
Filings En Masse on page 241.

9. When you are done, click Close.
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Working with SERFF Filings at the Filing Level

You can work with SERFF filings in two ways:

• en masse (working with multiple filings within a filing group at the same 
time)

• at the Filing level

Initially, you will work with filings en masse because it allows you to enter 
information much more quickly and efficiently. Later in the process, you will 
work with filings at the Filing level. Changes you make at the Filing level will 
appear when working with that filing group en masse.

This section describes the procedures that you can perform for individual SERFF 
filings:

• Selecting the TOI, Sub TOI and Filing Type at the Filing Level on page 246

• Clearing the TOI, Sub TOI, and Filing Type at the Filing Level on page 249

• Working with Supporting Documentation Filing Requirements at the Filing 
Level on page 249

• Creating a User Added Requirement at the Filing Level on page 258

• Entering State-Specific Values at the Filing Level on page 267

• Setting Public Access Values on page 268

• Paying Filing Fees on page 260

Note: See also: Working with SERFF Filings En Masse on page 237.

Selecting the TOI, Sub TOI and Filing Type at the Filing 
Level 

You initiate the process of working with a SERFF filing by selecting the TOI, sub 
TOI, and filing type at the Filing level.

Note: You can also select the TOI, sub TOI, and filing type for multiple filings within a 
filing group at one time: see Selecting TOI, Sub TOI and Filing Type for Filings 
En Masse on page 237.

Method: Select the TOI, Sub TOI and Filing Type at the Filing level

1. Navigate to the filing you want to work on as a SERFF filing.

2. In the SERFF area of the Filing Details tab, click Select.
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Tracker connects directly to SERFF and returns the list of Active TOIs, sub 
TOIs, and Filing Types for that state.

The SERFF Filing Information dialog box opens.

3. Expand the TOI entries by double-clicking on the desired TOI, or clicking 

on the  to the left of the desired TOI.
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4. Expand the sub TOI entries by double-clicking on the desired sub TOI or 

clicking on the  to the left of the desired Sub TOI.

5. Click the desired filing type under the Sub TOI.

The OK button becomes active.
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6. Click OK.

The SERFF area displays the selected TOI, sub TOI, and Filing Type for 
this filing.

At the bottom of the SERFF area, Tracker displays other information about 
the filing that is obtained from SERFF at the time the user selects the TOI, 
sub TOI, and Filing Type:

• State Accepts EFT

• State Charges Fee Per Company

• State is HIPR enabled. 

Clearing the TOI, Sub TOI, and Filing Type at the Filing 
Level

If you have entered an incorrect TOI, sub TOI or filing type, you can clear these 
values at the Filing level before you retrieve the requirements for this filing.

Important: If you have already obtained the filing requirements for this filing, then you 
cannot clear the TOI, sub TOI, and filing type for this filing. If you want to clear 
the TOI, sub TOI, and filing type for a filing where you have already obtained the 
filing requirements, you must delete the SERFF: Get Filing Requirements 
activity: see Deleting an Active Activity Detail Record on page 224.

Method: Clear the TOI, sub TOI, and filing type at the Filing level

In the SERFF area of the Filing Details tab, click Clear. The TOI, Sub TOI, and 
Filing Type are cleared. 

Alternatively, you can click Select and select a new TOI, sub TOI, and filing type.

Working with Supporting Documentation Filing 
Requirements at the Filing Level

The Supporting Documentation tab within the SERFF tab of a filing contains 
the current list of filing requirements for the TOI, sub TOI, and filing type that 
you have selected for this SERFF filing. You must either bypass or satisfy each 
requirement in order to submit the filing to SERFF.

This section describes:

• Retrieving Requirements at the Filing Level on page 250

• Viewing Requirements at the Filing Level on page 252
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• Working with General Instructions at the Filing Level on page 253

• Satisfying Requirements at the Filing Level on page 255

• Removing Requirements Attachments at the Filing Level on page 256

• Bypassing Requirements at the Filing Level on page 257

Retrieving Requirements at the Filing Level

Supporting documentation filing requirements are referred to as requirements in 
this documentation. You can retrieve the SERFF filing requirements at the Filing 
level by performing the SERFF: Get Filing Requirements activity.

Note: You can also retrieve the SERFF filing requirements for multiple filings within a 
filing group at one time: see Retrieving Requirements for Filings En Masse on 
page 239.

Method: Retrieve the filing requirements at the Filing level

1. Open the SERFF filing for which you have already selected a TOI, sub TOI, 
and filing type.

2. Click the Perform Activity button on the toolbar. 

3. From the list of activities, click SERFF: Get Filing Requirements, then 
click Perform.

The Perform Activity – SERFF: Get Filing Requirements dialog opens.
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4. Change the Priority if necessary, and enter a Memo if required.

5. When you are done, click Perform.

Tracker displays progress messages as it attempts to download the filing 
requirements.

If Tracker finds a direct match between the filing’s TOI, sub TOI, and filing 
type and the state’s current active list, it performs the following actions for 
the filing:

• retrieves the Filing Requirements

• performs the activity assigned to get the SERFF Filing Requirements 
(this may be a custom activity)

• retrieves the SERFF Tracking ID

• displays the activity on the Activities tab at the Filing level

• locks the TOI, sub TOI and Filing Type values at the Filing level

Note: Tracker will normally find a match, but if it does not—possibly because the state 
had changed its TOIs during the time interval between retrieving the TOI and 
retrieving the filing requirements—Tracker deletes that filing’s TOI, sub TOI, and 
filing type choices. You need to choose new TOI, sub TOI, and filing type values 
for the filing before you can repeat this procedure. (See Selecting the TOI, Sub 
TOI and Filing Type at the Filing Level on page 246.)

When complete, Tracker displays the SERFF Activity Status Message 
window listing success or failed.
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6. Click Close.

The filing requirements have been downloaded for this filing, and are ready 
to be either satisfied or bypassed.

Note: A SERFF tab will now appear on this filing.

Viewing Requirements at the Filing Level

Note: Supporting documentation filing requirements are referred to as requirements in 
this documentation.

Before associating any documents you have entered into Tracker with a 
requirement, you should first view the requirement to see its details.

Method: View a requirement at the Filing level

1. Navigate to the filing where you want to view the SERFF filing 
requirements, and click the SERFF tab.

2. Click the Supporting Documentation subtab.

The Supporting Documentation subtab lists the supporting documentation 
filing requirements in a table that contains the following columns:

• Requirement – the name of the supporting documentation filing 
requirement; you can mouse over the Requirement name to view its 
description as a pop-up

• Status – the status of the supporting documentation filing requirement 
(Bypassed or Satisfied)

• Rev – identifies revisions to supporting documentation schedule items 
with an R.

• Document Name(s)/Comments/Bypass Reason – the name of the 
associated document (attachment), any relevant comments, or the 
reason a bypassed requirement was bypassed

• State Status – a value can appear here after the state processes the 
filing, however, not all states update this field, in which case this value 
will remain blank

• Public Access – indicates whether the document affiliated with the 
requirement can be publicly accessed; the value for this field will 
remain blank until it updated by the state when they process the filing
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3. In the Supporting Documentation subtab, click the Requirement you 
want to view from the requirements table to highlight it.

4. Click View Requirement.

The View Requirement dialog displays.

5. If you click a URL in the Description field, your default browser opens and 
the selected page displays. If you click a file in the Select a file to view 
field, and click View, the selected file will download from SERFF and open 
on your computer. 

6. When you have finished viewing this supporting documentation filing 
requirement, click Close.

Working with General Instructions at the Filing Level

The SERFF General Instructions contain all general regulatory information and 
state requirements. You can view, print or save the general instructions from the 
state for a SERFF filing. You can also view, print or save any documents that the 
state has attached to the general instructions.

Note: You can view the General Instructions of multiple filings within a filing group at 
one time when satisfying or bypassing requirements en masse: see Satisfying 
Requirements for Filings En Masse on page 241 and Bypassing Requirements for 
Filings En Masse on page 243.
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Method: View, print or save general instructions at the Filing level

1. Within a filing, on the Filing Details or SERFF tab, click View General 
Instructions.

Tracker connects to SERFF and returns the general instructions for that 
state. View SERFF General Instructions opens.

Description contains the overall set of general instructions (such as fee 
information, filing mode, status in domicile, general guidelines, etc.) from 
the state. When you click a URL in the Description area, your default 
browser will open, and the selected page will display.

2. To print the general instructions, click the printer button in the upper-right 
corner of the dialog box.

3. To save the general instructions to a file, click the Save button in the upper-
right corner of the dialog box.

4. Under Select a file to view: click a file name and click View to open the file. 

The file opens in the corresponding application. You can then print or save 
the file.

5. Click Close when you have finished viewing the general instructions from 
the state for this filing. 
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Satisfying Requirements at the Filing Level

Note: Supporting documentation filing requirements are referred to as requirements in 
this documentation.

You satisfy a given state’s supporting documentation filing requirements by 
affiliating one or more Tracker attachments with that requirement. You can also 
satisfy a requirement with a comment about why no attachment is necessary.

Tip: You can also use this procedure to edit a requirement’s comments, or edit the list 
of affiliated attachments.

Note: You can also satisfy multiple requirements for multiple filings within a filing 
group at one time: see Satisfying Requirements for Filings En Masse on page 241.

Method: Satisfy requirements at the Filing level

1. In the filing, click the SERFF tab.

2. In the Supporting Documentation tab, double-click the Requirement you 
want to satisfy. 

The Supporting Documentation Details dialog displays.

3. From the Status drop-down list, select Satisfied.
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4. In the Comments box, enter any additional information about the 
requirement or the attachment.

5. Click the attachment type in Available Attachments. If necessary, expand 

the list of attachments by clicking on the  to the left of the source of 
attachments.

6. Click the attachment and click the right arrow  to move the attachment to 
the Selected Attachments list.

7. Click OK to save your changes and close the dialog.

Removing Requirements Attachments at the Filing Level

Note: Supporting documentation filing requirements are referred to as requirements in 
this documentation.

You can remove any or all attachments you have associated with a supporting 
documentation filing requirement before or after submitting to SERFF.

Method: Remove requirement attachments

1. Double-click the requirement from which you want to remove an associated 
attachment.

2. In the Selected Attachments list, click the attachment you want to remove 

from this requirement, then click the left arrow button. 
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3. To remove all attachments from this requirement, click the double left arrow 

button. 

4. Click OK to save changes and close the dialog.

Bypassing Requirements at the Filing Level

Note: Supporting documentation filing requirements are referred to as requirements in 
this documentation.

You can bypass a requirement—including bypassing a revised supporting doc that 
was previously satisfied—however, you must provide a reason. If you do not 
provide a reason, you will get an error message when you attempt to submit the 
filing to SERFF.

You can remove any or all attachments you have associated with a supporting 
documentation filing requirement before submitting to SERFF. 

Method: Bypass a requirement at the Filing level

1. In the filing, click the SERFF tab.

2. In the Supporting Documentation tab, double-click the Requirement you 
want to bypass.

Note: You cannot bypass requirements which are displayed in bold; you can only satisfy 
them: see Satisfying Requirements at the Filing Level on page 255.

The Supporting Documentation Details dialog displays.

3. From the Status drop-down list, select Bypassed.

The Bypass Reason box is displayed.
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4. In Bypass Reason, enter the reason why you are bypassing this requirement.

5. Click OK when you are done. 

Note: You can also bypass multiple requirements on multiple filings within a filing 
group at one time: see Bypassing Requirements for Filings En Masse on page 243.

Creating a User Added Requirement at the Filing Level

If you have a filing that needs a requirement that is not listed in the Supporting 
Documentation tab, you can add it. This type of supporting document 
requirement is called a User Added Requirement. An example of this is a 
document that was requested in the General Instructions but not included in the 
list of Filing Requirements.

Method: Create a user added requirement

1. In the filing, click the SERFF tab.

2. Click the User Added button  on the SERFF toolbar.

The User Added Requirement dialog displays.
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3. In the Comments box, enter any notes or information about this 
requirement or attachment.

4. Click the attachment type in Available Attachments. If necessary, expand 

the list of attachments by clicking on the  to the left of the source of 
attachments.

5. Click the attachment and click the right arrow  to move the attachment to 
the Selected Attachments list.

6. When you are done, click OK.

Entering State-Specific Values at the Filing Level

State-specific values represent other information required by the state for a 
SERFF filing. There are three ways you can add this information to Tracker:

• You can select matching data for these values from pre-existing data in 
Tracker.

• You can enter free-form data for values without defaults.

• You can edit or overwrite the default values provided.

Note: You must complete the state-specific fields.

Method: Enter state-specific values at the Filing level

1. Navigate to the filing where you want to enter state-specific values

2. Click the SERFF tab, then click the State Specific subtab.
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3. In State Specific Fields Selection, click the Description for the state-
specified field you need to enter.

4. Select the source of the field value from the drop-down list.

The value of the source you have selected is displayed to the right of the 
source name.

5. To use a different value, edit the value in the text box. No Save or Enter is 
required.

Setting Public Access Values

For details on public access settings and confidentiality requests, see Working with 
Public Access/Confidentiality Requests on page 325

Paying Filing Fees

You can pay filing fees by check or EFT. For payment by check, see Entering 
Filing Fees Paid by Check on page 195. For EFT payments, see Paying Filing 
Fees via EFT.

Paying Filing Fees via EFT

For SERFF filings, you can pay filing fees via EFT for states that allow EFT. The 
EFT payment option is available exclusively for SERFF filings. For details on a 
state’s acceptance of EFT, see Regulatory Specialist, on the General subtab of the 
SERFF tab, on page 366.

Note: Once an EFT payment is made, subsequent payments must be made using EFT.

In order for fees to be paid via EFT, there are several items that must first be 
configured in the Administration section of Tracker. These include the Payer 
UNID, the EFT authorization levels, and—in some states—the Advisory/Rating 
Organization setting. See Company Information on page 43 and SERFF Settings 
on page 56.

When you make your selection of the TOI, sub TOI and filing type, whether the 
state accepts EFT payments or not is passed to Tracker and displayed on a filing’s 
Filing Fee tab as follows:

• If the state accepts EFT payments, EFT is enabled in the Payment Method 
section and the State Accepts EFT field is displayed.

• If the state does not accept EFT payments, then the EFT payment method is 
grayed out.



WORKING WITH SERFF FILINGS AT THE FILING LEVEL

TRACKER L&H USER GUIDE  261

• If the State Charges Fee Per Company field is displayed, it indicates that 
state charges the filing fee on a per company basis.

On the SERFF toolbar, the color of the EFT icon indicates the EFT payment 
status. 

As well, when EFT payment information is added to a filing’s Payment History 
Details table, the corresponding entry in the EFT column on the Filing Group 
level – My Filings, Filing Group level – Filings, or Top Level – My filings - All 
tabs display Yes, otherwise they display No.

Method: Pay the filing fee via EFT

1. Navigate to the filing where you want to pay the filing fee via EFT.

2. Click the Filing Fee tab.

3. In the Payment Method section, select EFT.

The Payment History Details table will display.

Payment Status Icon Color

EFT payment information is added to the Payment 
History Details table

Green

EFT payment information is removed from the 
Payment History Details table, also the default status

Red

No filing or multiple filings are highlighted at the 
Filing Group level or Top level 

Grey
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Note: An error message will be displayed if the Tracker Administrator has not 
configured a valid Payer UNID for the company. To configure a company’s 
UNID, see Entering or Editing General Information for Companies on page 45.

4. If any portion of the fee is being paid on a retaliatory basis, click Yes in the 
Is Fee Retaliatory? section.

5. Enter any descriptive information (such as how the fee is calculated) in the 
Fee Explanation field.

6. Click Add Payment.

The EFT Fee Allocation dialog displays.

7. Enter the Fee Amount.

8. Enter any descriptive notes in the Comments field.

9. Click Allocate.

The fee is added to the Fee Allocation table at the bottom of the dialog.

Note: If the fee amount you enter exceeds the maximum allowed for your EFT 
authorization level, a message will be displayed. In this case, you will not be able 
to proceed with the EFT payment for this filing. You will need to contact your 
Tracker Administrator to continue, or you will need to have another user with the 
appropriate EFT authority level complete the EFT information.

10. Click OK to save you work.

The filing fee you entered is displayed in the Payment History Details table 
at the bottom of the Filing Fee tab. (For more information about this table, 
see Viewing EFT Transaction Information at the Filing Level on page 263.)
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The color of the EFT icon on the SERFF toolbar becomes green. On all 
screens where filings are listed, the corresponding entries in the EFT column 
display Yes.

Viewing EFT Transaction Information at the Filing Level

The Payment History Details table (displayed on a filing’s Filing Fee tab after a 
payment type has been selected) displays each payment for a filing. The 
information displayed includes:

• Transaction Date

• EFT Status – Pending, Successful or Failed

• EFT Transaction ID – provided by SERFF after a successful EFT payment

• Company Name – the name of the company that the transaction applies to

• Amount – the amount of the EFT transaction

• Type - the EFT transaction type: Initial or Additional: Initial means the 
EFT request was sent with the initial filing; Additional means additional 
fees were sent on the filing

• Authorized By

• Comments

See also: Paying Filing Fees via EFT on page 260.

Note: For a Company Group filing, in order for EFT to be an option, the Advisory/
Rating Organization check box on the General tab of the Company Information 
dialog would have to be selected for all of the companies in the Company Group. 
If the Advisory/Rating Organization check box is not selected for any of the 
companies in the Company Group, then Check is the only option available for 
filing fees – EFT will not be an option.

Method: Make the EFT payment

Perform the SERFF: Generate SERFF Filing activity and click the Move to 
Filing Package and Submit to SERFF option.

The EFT information you entered in the EFT Fee Allocation dialog will 
automatically be transmitted with the filing to SERFF

Adjusting EFT Filing Fee Details Before Submitting

If, at any point before submitting a filing to SERFF, you need to adjust the EFT 
filing fee details, you can edit them.

Note: All fields in the EFT Fee Allocation dialog box can be edited before submitting 
the filing. Once submitted, only the Comments field and Fee Explanation field 
can be edited.
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Method: Edit EFT filing fee payments

1. In the Filing Fee tab of a filing, double-click any of the payments listed in 
the Payment History Details table.

2. Make your required changes.

3. When you are done, click OK.

The dialog box closes, and the payment details will be updated.

EFT Transaction Status

When you have made your EFT selections, the EFT information (including the 
EFT status) will appear in the Payment History Details table on the Filing Fee 
tab. After the filing has been sent to SERFF, the EFT statuses will be as follows:

• Pending – The EFT status will be remain as Pending if the filing fails to go 
to SERFF. In this case, you will receive a log entry indicating that the filing 
failed, which also means the EFT submission failed. In this case, you will 
need to make the necessary corrections to the filing and submit it to SERFF 
again. You do not need to reenter the EFT information. Your original 
selections will be retained and sent to SERFF when you perform the activity 
to submit to SERFF. 

• Failed – If the filing itself is successfully sent to SERFF, but there is a 
problem with the EFT information, you will receive a log entry stating that 
the EFT transaction failed, and the EFT status will appear as Failed. In this 
situation, you will need to make the necessary corrections to the EFT 
information and then perform the activity of SERFF: Submit Additional 
Fee.

• Successful – The EFT status will appear as Successful when the EFT 
transaction is successfully transmitted to the DOI. 
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Reviewing SERFF Filings

Before submitting filings to SERFF, you should review the details of the filing. 
This involves:

• Viewing and Editing SERFF Filing Details on page 265

•  on page 271

• Viewing Rate Schedules on page 272

• Generating a Draft SERFF Filing on page 280

Viewing and Editing SERFF Filing Details

Once you have satisfied or successfully bypassed each filing requirement, you are 
ready to review and verify the SERFF filing details. Some of this data is entered 
automatically by Tracker, and all you need to do is verify that it is correct. Some 
of this data is configurable in the Tracker system defaults. (See System Defaults 
on page 31 for more information.)Some final settings are required at this point as 
well. 

Method: View and adjust SERFF filing details

1. Navigate to the filing where you want to view SERFF filing details. 

2. Click the SERFF tab.

3. Click View SERFF Filing Details.

The SERFF Filing Details dialog displays.
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4. On this dialog, review the default values, or, for the fields that are editable, 
you can enter different values. The fields are described in the next section: 
SERFF Filing Details Fields on page 267.

5. Ensure that you have entered or chosen values for mandatory fields. 
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Note: If the filing’s selected TOI/sub-TOI is designated by SERFF as a PPACA sub-
TOI, the PPACA field on the SERFF Filing Details screen becomes active and is 
mandatory. When the PPACA drop-down list is selected, Tracker accesses SERFF 
and displays the current list of PPACA options. 

Important: When an activity is run that submits a SERFF filing, Tracker checks with SERFF 
to see if the value selected in the PPACA field is still a valid value. If it is not, and 
an error message results, return to the SERFF Filing Details dialog and display the 
PPACA list (which will immediately update the setting). In some situations, this 
may be sufficient to correct error condition.

6. When you are done, click OK to save your changes, or click Cancel to exit 
without making changes.

SERFF Filing Details Fields

The following table describes the section and fields of the SERFF Filing Details 
screen and contains three columns:

• The Field or Section Name column lists the name of the fields and sections.

• The Description column describes each the fields.

• The Data Source / Data Entry Instructions column describes where the 
defaults values are obtained from and how to select or enter values for fields 
that are editable. Note that you edit only certain fields, while others are read-
only and cannot be edited.

    

Field or Section 
Name Description

Data Source / Data Entry 
Instructions

SERFF Filing ID The tracking ID for 
this filing (from 
SERFF).

Populated by the system after 
the SERFF: Get Filing 
Requirements activity is 
performed.

TOI The TOI for this 
filing.

The TOI as entered in 
Tracker.

Sub TOI The sub TOI for this 
filing.

The sub TOI as entered in 
Tracker.

Filing Type The filing type. The Filing Type as entered in 
Tracker.
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Project Name The name of the 
project containing this 
filing.

This field obtains data 
automatically from one of the 
following fields, based on 
what has been entered in 
SERFF System Defaults:

• Product Name
• Filing Group Name
• Filing Group Description
• Filing Description
• Custom Field, Filing Group 

Level
• Custom Field, Filing Level
• Company Reference 

Number

Project # The project number 
containing this filing.

This field obtains data 
automatically from one of the 
following fields, based on 
what has been entered in 
SERFF System Defaults:

• Tracker Filing ID
• Filing Group Name
• Filing Group Description
• Filing Description
• Custom Field, Filing Group 

Level
• Custom Field, Filing Level
• Company Reference 

Number

Product Name The name of the 
product associated 
with this filing.

This field obtains data 
automatically from one of the 
following fields, based on 
what has been entered in 
SERFF System Defaults:

• Product Description
• Filing Group Name
• Filing Group Description
• Filing Description
• Custom Field, Filing Group 

Level
• Custom Field, Filing Level

Requested Impl. 
(Implementation) 
Date

The implementation 
date that was 
requested for this 
filing.

Populated based on the 
activity which is performed to 
populate this value for the 
filing. Read only.

Field or Section 
Name Description

Data Source / Data Entry 
Instructions
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Company Tracking # The Tracker filing 
identification number.

• Company Reference # 
field (if a value for 
Company Reference # is 
present at the point the 
filing is sent to SERFF)

• Tracker Filing ID (if a 
value for Company 
Reference # is not present 
at the point the filing is sent 
to SERFF)

Company in Filing The company 
associated with this 
filing.

System generated

Submission Type 
(Section)

PPACA SERFF is accessed in 
real time, and a drop-
down list of current 
PPACA options based 
on filing’s TOI/sub-
TOI.

When enabled, this is a 
mandatory field.

Multiple selections can be 
made.

If Not PPACA-related is 
selected, all other items in the 
drop down menu are de-
selected. You need to de-
select Not PPACA-related to 
select other items on the drop-
down list. 

Return to this list again if an 
activity that submits a filing 
results in an error message 
that indicates the PPACA 
field is no longer valid.

Type Indicates whether this 
is a new or 
resubmitted filing.

Select New or Resubmission 
from the drop-down list. 
Mandatory.

Previous Filing # The previous filing 
number (if any).

If you select a Type of 
Resubmission, enter the 
Previous File # or, if the 
previous filing number is not 
available, select Not 
available.

Requested Filing 
Mode (Section)

Field or Section 
Name Description

Data Source / Data Entry 
Instructions
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Mode The requested filing 
mode.

Select a value from the Mode 
drop-down list. Mandatory.

Explanation The description if a 
Mode type of Other 
selected.

If you select a Mode of 
Other, you need to enter an 
description.

Fee Details (Section)

Amount The amount of the fee 
being sent with the 
filing. 

Obtained automatically from 
the filing fee information 
entered.

Explanation A description or 
additional information 
about the filing fee.

Obtained automatically from 
the filing fee information 
entered.

Market Information 
(Section)

Market Type The specific market 
type that the coverage 
being provided will be 
sold in.

Obtained from the Market 
Type field.

Eligible Groups The groups eligible 
for this type of 
coverage.

Obtained from the Eligible 
Groups field.

Market Size The size of the market 
for this type of 
coverage.

Obtained from the Market 
Size field.

Domiciliary 
Information 
(Section)

Status The status of the filing 
in the domiciliary 
state

Select a value from the drop-
down list.

Approval Date The date that the state 
approved the 
domiciliary filing.

Enter a date.

Comments Information about the 
status of the filing in 
the domiciliary state.

Enter any details that you 
want the state to know about 
the filing in your domiciliary 
state.

Field or Section 
Name Description

Data Source / Data Entry 
Instructions
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Note: Tracker supports Product Names up to 254 characters in length.

Viewing Form Schedules

Each enabled form in Tracker is, by default, a form schedule item for a SERFF 
filing. Tracker will pass information from the following fields to SERFF for each 
enabled form in Tracker:

• Form Name

• Form Number

• Form Type: see Form Types on page 76

• Flesch Score

• Form Action

• Replaced Form # (if applicable)

• Previous State Filing # (if applicable.

If an attachment is added in Tracker, it will also be passed to SERFF.

Advertisements are considered a form, therefore data of advertising records in 
Tracker are displayed on the form schedule and are considered a form schedule 
item.

If a filing contains both forms and advertising, the form information will appear 
first followed by the advertising information.

Method: View a form schedule

1. Navigate to the filing where you want to view a form schedule.

2. Click the SERFF tab. Click the Supporting Documentation subtab

Include Exchange 
Intentions

This new field is 
available under the 
field column for 
initial filing 
submission 

It provides two options; Yes 
and No

Exchange Intentions This field is added to 
add the description of 
the exchange 
information

If “Include Exchange 
Intentions” is set to ‘Yes’, 
then the “Exchange 
intentions”

field is mandatory for the 
user.

Field or Section 
Name Description

Data Source / Data Entry 
Instructions
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3. Within the Supporting Documentation subtab, click View Form 
Schedule.

The Form Schedule is generated and displayed in Microsoft Word.See Form 
Types on page 76 for information about how to map the Form Type 
Description to SERFF. 

Viewing Rate Schedules

Each enabled rate in Tracker is, by default, a rate schedule item for a SERFF 
filing. Tracker will pass information from the following fields to SERFF for each 
enabled rate in Tracker:

• Document Name

• Description

• Affected Form Numbers

• New / Revised (% Increase or Decrease) / Other

• Previous State Filing Number

• Rate Change Type

• Rate Change Details

• Company name

• % Indicated change

• Written premium change for this program

• # of policyholders affected for this program

• Written premium for this program

• Maximum % Change (proposed)

• Maximum % Change (approved)

• Minimum % Change (proposed)

• Minimum % Change (approved)

If the filing is a PPACA filing, the Rate Schedule will include the filing’s PPACA 
Product Types table and the Rate Review Detail table.

Method: View a rate schedule

1. In the filing, click the SERFF tab.

2. Within the Supporting Documentation tab, click the View Rate Schedule 
button.

The rate schedule is generated and displayed in Microsoft Word.
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Generating a Draft SERFF Filing

Before submitting the filing to SERFF, you need to generate a draft of the filing 
and review the generated filing.

Method: Generate a draft SERFF filing

After building the SERFF filing with Tracker, you will perform an Tracker 
activity to verify whether the requirements you initially downloaded from SERFF 
are still current and complete.

1. Click the Perform Activity button. 

The Perform Activity screen opens.

2. Select SERFF: Generate SERFF Filing, and click Perform.

3. The Perform Activity - SERFF: Generate SERFF Filing dialog displays.

4. Enter any relevant information into the Memo area.

5. Because this only a draft copy, do not select the Move to Filing Package 
and Submit to SERFF check box. Leave it cleared in order to generate the 
filing without sending it to SERFF.

6. Click Perform.

The Activity is processed, and if successfully completed, will be visible 
from the Activities tab. 
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Submitting Filings to SERFF

After you have generated a draft of the SERFF filing and are satisfied with it, you 
can submit it to SERFF.

Note: You can only submit individual filings to SERFF; you cannot submit filings en 
masse.

Prior to submitting the filing to SERFF, Tracker completes PDF conversion for 
each attachment and checks the size of each. If one of the PDF attachments is 
larger than 3MB in size, Tracker displays a warning message that the filings that 
contain oversized attachments will not be submitted. If the message appears after 
attempting to submit multiple filings, it should be noted that filings where the 
PDF attachments did not exceed the 3MB limit will be submitted. 

Method: Submit your filing to SERFF

1. Navigate to the filing you want to submit to SERFF, or navigate to the filing 
group and select multiple filings on the Filings or My Filings tab.

2. Click the Activities tab.

3. Double click the SERFF: Generate SERFF Filing activity you have just 
performed.

The Edit Activity-SERFF: Generate SERFF Filing dialog displays.

4. At the bottom of the dialog, select Move to Filing Package and Submit to 
SERFF.

5. Click OK.

The filing is submitted to SERFF. The Filing Status is now Pending. 

When the initial filing submission is performed, Tracker also checks to see if 
the state allows Post Submission Updates (PSUs). If PSUs are allowed, all 
fields that can be updated using a PSU are also locked and can only be 
changed by using a PSU. See Working with Post Submission Updates on 
page 312.
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Monitoring SERFF Filings and Working with 
Messages

As you work with SERFF filings and submit them to SERFF, Tracker creates and 
receives messages from the states about these filings. These messages are 
available in:

• the Top Level of Tracker

• the Log Entries subtab within a filing’s SERFF tab 

Message Types and Content

The messages that are displayed within the messages tabs at the Top Level and 
within the Log Entries tab within the SERFF tab of a filing are categorized by 
type within Tracker for easy identification. The message types are:

• Log Entries on page 276

• SERFF Status Filing Updates on page 278

• Schedule Item State Status Updates on page 279

• Note to Filer on page 280

• Objection Letters on page 280

• Reports on page 280

Log Entries

For each interaction between Tracker and SERFF, including the status updates and 
reports, a log entry is created. Log entries are maintained for each filing on the 
Log Entries tab within the SERFF tab. They represent the history of this SERFF 
filing, starting with the initial submission of the filing to SERFF. No events are 
recorded on this tab while you are working with the filing before submitting it to 
SERFF.

Log entries for all filings are available at the Top Level of Tracker, but entries on 
this tab may be removed from view.

The log entries indicate if:

• the initial filing and any subsequent correspondence was successfully 
submitted
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OR

• the initial filing and any subsequent correspondence was not successfully 
submitted, and must be resubmitted

Note: If you fail to receive a log entry when you have sent the filing or filing amendment 
or objection response, your filing may be in limbo. See SERFF — Filing in Limbo 
on page 423.

Log entries will be automatically generated when any of the following activities 
are performed:

• Submit Filing to SERFF

• Submit Note to Reviewer

• Submit Additional Fee (EFT)

• Submit Filing Amendment

• Submit Objection Response Letter

• Submit Confidentiality Request

• Submit Post Submission Update
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SERFF Status Filing Updates

A SERFF status update occurs either automatically (system-generated) or from 
some action taken by the state.

Note: SERFF status updates apply to the entire filing and not at the schedule item level. 

The following table describes the types of SERFF status updates and how they are 
triggered.

SERFF Status Triggered By Description

Submitted System-generated When you perform the 
activity which submits the 
filing to SERFF, you will 
receive a status update 
message of Submitted when 
the filing is received by the 
state.

Assigned A reviewer being assigned 
by the state to work with 
this filing

When the state assigns a 
reviewer to review the filing, 
the SERFF status update of 
Assigned is triggered and sent 
to Tracker.

Pending Industry 
Response

The state sending an 
Objection Letter.

When the state sends an 
Objection Letter because of a 
problem they have found in 
your filing, a SERFF status 
update will be triggered and 
sent to Tracker, changing the 
SERFF status of the filing to 
Pending Industry Response.

Pending State 
Review

A user sending an 
Objection Response.

When a user sends an 
Objection Response in 
response to an Objection 
Letter, a SERFF status update 
will be triggered and sent to 
Tracker, changing the SERFF 
status of the filing to Pending 
State Review.
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Note: When Tracker receives a SERFF status update, it will compare the current SERFF 
status and the state status to determine if a status has changed as a result of the 
update. If there is a change, then Tracker will save the modified date for the 
change (separate date fields for SERFF status and state status since they may be 
updated independent of each other).

Schedule Item State Status Updates

A state status update message in Tracker is triggered when the state updates the 
state status of the filing, or updates the state status of one or more schedule items. 

Unlike SERFF status update messages, which are automatically generated, when a 
state performs specific functions or creates reports, a state status update message 
is only triggered when the state manually updates the state status in SERFF. State 
status update messages inform you about the progress of the filing and/or schedule 
items as the state conducts its review.

Closed-State 
Specific Action

The state taking final action 
on the filing: approval, 
disapproval, filed, 
acknowledged, and so on.

When the state takes final 
action on a filing, they will 
create a Disposition Report 
which gives the action they 
have taken on the filing. The 
final dispositions include 
approval, disapproval, 
acknowledgment the filing as 
filed, and so on. The 
terminology can vary 
significantly from state to 
state.

When the state sends the 
disposition report, this 
automatically triggers a 
corresponding SERFF status 
update to be sent to Tracker. 
The SERFF status update 
message that is sent to 
Tracker in this instance will 
be Closed - State specific 
status.

Re-opened The state re-opening the 
filing

If the state re-opens a closed 
filing, you will receive a 
SERFF status update message 
for the filing.

Closed-Rejected The state rejecting the 
filing.

If the state rejects the filing 
you will receive a SERFF 
status update of Closed - 
Rejected. 

SERFF Status Triggered By Description
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There are no standard state status update messages. Each state has its own set of 
these messages.

Note to Filer

Note to Filer messages are created by the state and are used to communicate with 
you about some aspect of your SERFF filing. Essentially, they act as an email 
where the state can ask for:

• clarification on something in the filing

• additional information

• additional documents

Objection Letters

If the state that you submitted your SERFF filing to finds a problem with your 
filing that requires further explanation or revisions, the state may send an 
Objection Letter (previously called a Problem Report) detailing the problems they 
have found. For more information, see Viewing Objection Letters on page 280.

Reports

As of this release, there is only one type of SERFF report available: a disposition 
report. A disposition report advises the filer of the disposition of the filing, and is 
generated when the state closes a filing and changes the filing’s status to Closed 
[–State Specific] (i.e. Closed - Approved).

If the state rejects your filing, you will no longer receive a rejection report. 
Instead, you will receive a disposition report with the disposition of Closed-
Rejected.

For more information, see Viewing Disposition Reports on page 307.

Managing Messages in the Message Center

There are various ways to control and manage the various messages coming in 
from SERFF on your filings. Most of these functions apply to the My SERFF 
Messages and All SERFF Messages tabs, collectively referred to as the Message 
Center. The functionality includes: 

• Viewing messages and reports on the My SERFF Messages and All SERFF 
Messages Tabs (Top Level) on page 281

• Identifying New Messages on page 282

• Viewing Messages on page 282

• Deleting Messages (from the Message Center) on page 283
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My SERFF Messages and All SERFF Messages Tabs 
(Top Level)

As you work with SERFF filings and submit them to SERFF, Tracker both creates 
messages and receives messages from the states about these filings. These 
messages are available in:

• the Top Level of Tracker

• the Log Entries tab within the SERFF tab of a filing

Messages at the Top Level of Tracker are in the My SERFF Messages and All 
SERFF Messages tabs.

These tabs also display generic messages from the states (messages not related to 
a specific filing). The Tracker Administrator configures for which states and 
business types (L&H, P&C, or both) you will receive state messages. (See 
Configuring Display of State Messages on page 76.) 

My SERFF Messages

This tab contains all SERFF messages for the filings where you are the filing 
manager.

All SERFF Messages

This tab contains all SERFF messages for filings for all users.

On the My SERFF Messages and the All SERFF Messages tabs—collectively 
called the Message Center—messages are displayed only for the number of days 
that have been configured in the SERFF Defaults. For more information, see 
Understanding the SERFF System Defaults on page 56 and Hide All Messages 
After [ ] Days on page 57.

You can also delete messages from these tabs without waiting for the specified 
display period to expire (with the appropriate permission) as described in Deleting 
Messages (from the Message Center) on page 283. 
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Identifying New Messages

You can easily identify any new messages that have arrived from SERFF since the 
last time you were in the Message Center. All new messages appear in bold, and 
remain in bold until they are opened. Once you open a message, it changes to non-
bold when you close the message or choose to go directly to the filing. Bold, 
therefore, indicates an unread message, while non-bold indicates a read message.

If a message is opened under the ALL SERFF Messages tab, it will also appear 
as unbold (read) under the My SERFF Messages tab. Similarly, if a message is 
opened under the My SERFF Messages tab, it will also appear as unbold under 
the ALL SERFF Messages. That is, the read or unread status of a message is not 
controlled on a per-user basis, but by whoever opens the message first.

Important: We strongly recommend that you only open messages that apply to your filings. If 
you mistakenly open a message for another user’s filing, you should restore the 
message to its unread status by right-clicking the message and selecting the Mark 
as Unread.

Viewing Messages

To view a message, simply double-click it. The message opens.

From this dialog, you can perform the following procedures:

• To save the text of the message to a file, click the Save icon. You are 
prompted to enter the path name of the file to save the text.

• To print the message, click the Print icon. The message prints.

• To view the filing associated with this message, click the View Filing 
button. The associated filing opens.
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• To view any attachments associated with this message, double-click the file 
name in the Attachments section.

Deleting Messages (from the Message Center) 

You can delete messages from the Message Center. However, your ability to 
delete messages from the My SERFF Messages tab or the ALL SERFF 
Messages tab is controlled by the permission settings for the user security access 
level to which you belong.

There are two permissions: Delete My SERFF Messages and Delete All SERFF 
Messages:

• If the security access level you belong to has the permission to Delete My 
SERFF Messages, then you will be able to delete messages for filings 
where you are the filing manager.

• If the security access level to which you belong has the permission to Delete 
ALL SERFF Messages, then you will be able to delete messages for all 
filings, not just those where you are the filing manager.

• If the security access level to which you belong has neither permission, then 
you cannot delete messages for any filings. 

Important: The ability to delete SERFF messages pertains solely to deletion within the 
Message Center. A message deleted from the Message Center will still appear 
within the Log Entries tab within the filing the message pertains to and under the 
Correspondence tab in the filing.

Method: Delete a message from the Message Center

1. In the My SERFF Messages tab or the All SERFF Messages tab, select the 
message(s) you want to delete. 

To select a continuous range of messages, press and hold the Shift key, click 
the first message and then click the last message in the range of messages 
that you want to delete.

To select a non-continuous number of messages, press and hold the Ctrl 
key, then click each message which you want to delete.

2. Click the  in the toolbar.

A message appears asking if you are sure you want to delete the highlighted 
message(s).

3. Click OK to delete the message(s) or click Cancel to cancel the deletion.

Tip: If you try to delete a message and the  in the toolbar is grayed out, then your 
security level does not have the permission setting to allow deletions. Contract 
your Tracker Administrator if you think you need the ability to delete messages. 
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Working with Submitted Filings

After submitting a SERFF filing, you may need to make certain changes or 
corrections.

The procedures for working with submitted filings are as follows:

• Working with Notes to Reviewers on page 284

• Creating Revised Form, Rate, and Advertisement Schedule Items on page 
288

• Creating Revised Supporting Doc Schedule Items (Other Attachments) on 
page 289

• Satisfying Previously Bypassed Requirements on page 291

• Revising Bypass Reason for Bypassed Requirements on page 299

• Bypassing Satisfied Requirements on page 300

• Working with Filing Amendments on page 301

• Viewing Objection Letters on page 306

• Working with Objection Responses on page 301

• Viewing Disposition Reports on page 307

• Submitting an Additional EFT Payment on page 315

• Working with Post Submission Updates on page 312

Working with Notes to Reviewers

A Note to Reviewer includes additional information about a previously submitted 
filing.

This section includes the following topics:

• Creating Notes to Reviewers on page 284

• Deleting Notes to Reviewers on page 286

• Submitting Notes to Reviewers on page 286

Creating Notes to Reviewers

After you have submitted a filing to SERFF, you can send a Note to Reviewer 
which includes any additional comments or information about the filing.

Method: Create a Note to Reviewer

1. Navigate to the filing where you want to create a Note to Reviewer.

2. Click the SERFF tab.

3. Click the Correspondence subtab.
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4. Click Note to Reviewer.

The Note to Reviewer dialog displays.

The Created On field is automatically populated.

Note: The Created On date for migrated filings will be blank.

5. Complete the Subject field.

6. Complete the Comments field with the information that you want to send to 
the state.

7. Click OK to save your changes.

The Note to Reviewer is added to the list of Correspondence with a Status 
of Draft. It is also listed on the Filing Package tab.

Important: While the system will allow attachments to be included on the NTR, you should 
not include any attachments on the NTR that belong on the schedules. 

You can now submit the Note to Reviewer.
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Editing Notes to Reviewer

You can edit a Note to Reviewer that is in Draft status

Method: Edit a Note to Reviewer

1. Within the filing containing the Note to Reviewer you want to edit, either

• click the SERFF tab and then the Correspondence subtab.

OR

• click the Filing Package tab.

2. Double-click the Note to Reviewer that you want to edit.

3. Make any necessary changes. (For field descriptions, see Creating Notes to 
Reviewers on page 284.)

Deleting Notes to Reviewers

You can delete a Note to Reviewer that is in Draft status

Method: Delete a Note to Reviewer

1. Navigate to the filing containing the Note to Reviewer that you want to 
delete, click the SERFF tab.

2. Click the Correspondence subtab.

3. Select the Note to Reviewer that you want to delete.

4. Press the Delete key or click the delete button on the Tracker toolbar.

You are asked to confirm the deletion.

5. Click Yes to delete the Note to Reviewer or click No to cancel.

Submitting Notes to Reviewers

After you have created a Note to Reviewer, you can submit it to the state.

Method: Submit a Note to Reviewer

1. Click the Perform Activity button on the toolbar. 

The Perform Activity dialog displays.

2. Select the SERFF: Submit Note to Reviewer activity.

The Perform Activity - SERFF: Submit Note to Reviewer dialog 
displays.
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3. If necessary, change the Priority for this activity.

4. Enter any relevant information in the Memo field. This is for internal use 
only.

5. Select the Move to Filing Package and Submit to SERFF check box, then 
click Perform.

If you perform the activity but do not select Move to the Filing Package and 
Submit to SERFF, the status on the Correspondence tab remains as Draft but the 
item is not editable. In order to enable editing, you will have to first delete the 
related activity, which unlocks the related item on the Correspondence tab, and 
then go in and make changes.

The Note to Reviewer is submitted. In the Correspondence tab:

• the Status of the Note to Reviewer changes to Submitted

• the date the Note to Reviewer was sent is displayed in Date Rec’d/Sent 
column 

Please note:

• The SERFF status of the filing does not change after submitting a Note to 
Reviewer.

• If the Tracker Monitor is busy processing other activities, the status of the 
Note to Reviewer will remain Queued until the Note to Reviewer has been 
succesfully submitted.
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Creating Revised Form, Rate, and Advertisement 
Schedule Items 

Schedule items include forms, rates, and advertisements. If after submitting a 
filing, you discover an error in a schedule item, or if this state objects to a 
particular schedule item, you need to create and submit a revised schedule item. 
(You cannot change the original schedule item.)

To create revised Other Attachments schedule items, see Creating Revised 
Supporting Doc Schedule Items (Other Attachments) on page 289.

Method: Create a revised form, rate, and advertisement schedule 
item

1. Navigate to the filing where you want to create the revised forms, rates, and 
advertisements.

2. Click the Forms, Rates or Advertisements tab.

3. Double-click the form, rate, or advertisement that you need to revise.

The form, rate, or advertisement opens.

4. Click the Revise button.

A copy of the form, rate, or advertisement is added directly below the 
original in the list.

An incremented revision number is assigned to the new form, rate, or 
advertisement and appears in the Rev # column.

In the original form, rate, or advertisement, the Enable check box on the 
Status tab is cleared. The form, rate, or advertisement becomes independent 
of the Filing Group level attachment, if it was not already. 

5. Make any necessary corrections to the copy of the form, rate, or 
advertisement attachment, including the Attachment path, then save it.

The Status tab of a revised form, rate, or advertisement attachment contains 
a SERFF Details section that indicates the State Status and Public Access 
of that form, rate or advertisement. These fields are populated by the state 
when the state takes action.

For forms, once a filing has been submitted to SERFF, you cannot edit the 
lead form designation for the submitted forms or designate any new or 
revised forms in the filing as lead forms. Therefore: 
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• If you revise a form that had originally been designated as the lead form, 
the Lead Form check box on the revision will be cleared (not selected) 
and locked (not editable). The same is true for revisions of non-lead 
forms; when the copy is made, the lead form check box will be cleared 
and locked.

• When you begin to add a new form to the filing after it is submitted, the 
Lead Form check box will be cleared and locked; it does not matter if 
there are no lead forms in the original filing. 

6. After you have created the revised schedule item, you need to submit it 
using an objection response or a filing amendment. See: Working with Filing 
Amendments on page 251 and Working with Objection Responses on page 
301. 

Creating Revised Supporting Doc Schedule Items 
(Other Attachments)

A supporting documentation schedule item is a schedule item other than a form, 
rate, or advertisement schedule item. SERFF treats fillable filing forms as 
supporting documentation. Supporting documentation schedule items are 
maintained in a filing’s Other Attachments tab. They are also listed in the 
Supporting Documentation subtab within the SERFF tab of a filing.

If after submitting a filing, you discover an error in a supporting documentation 
schedule item, or the state objects to a supporting documentation schedule item, 
you will need to revise a supporting documentation schedule item.

Related topics:

• Satisfying Previously Bypassed Requirements on page 291

• Revising Bypass Reason for Bypassed Requirements on page 397

• Bypassing Satisfied Requirements on page 376

Method: Create a revised supporting documentation schedule item 
(Other Attachment)

Part A: Revise the fillable filing form

1. Navigate to the Filing Package tab of the filing where you want to create a 
revised supporting documentation schedule item (the fillable filing form).
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2. Double-click the filing package (Filing Correspondence Description = 
SERFF: Generate SERFF Filing).

The SERFF: Generate SERFF Filing dialog displays. 

3. In the Documents area, double-click the fillable filing form that you want to 
revise.

The fillable filing form opens in its native application.

4. Save a copy of the fillable filing form to your file system, or DMS. 

5. Outside of Tracker, open the copy of the fillable filing form that you saved 
in the previous step, make all required changes, and save the document.

Part B: Create an Other Attachment with the revised fillable filing form

6. In Tracker, navigate to the filing where you want to create a revised 
supporting documentation schedule item (Other Attachment).

7. Create an Other Attachment using the revised fillable filing form from Part 
A. (See Adding a New (or Editing an Existing) Filing Level Other 
Attachment on page 190.)

Part C: Create a revision with the revised fillable filing form attached

8. Navigate to the same filing’s SERFF tab, and on the Supporting 
Documentation sub-tab, double click the requirement containing the Other 
Attachment that you need to revise.

9. Click the Revise button.

The Supporting Documentation Details dialog displays.

10. Select Satisfied from the Status drop-down menu.

The dialog displays the Available Attachments area.

11. Expand the Other Attachments branch, and select the Other Attachment 
created in step 7, and click the right arrow to move the Other Attachment to 
the Selected Attachments area.

12. Click OK. 

The Supporting Documentation Details dialog closes, and the SERFF tab, 
Supporting Documentation sub-tab displays. 

The revised supporting documentation schedule item:

• is displayed immediately below the original entry, 

• has a Status of Satisfied, 

• has a value in the Rev column of R,

• displays the name in the Document Name/Comments/ByPass Reason 
column.

The Other Attachment, if it was not already, becomes independent of the 
Filing Group level attachment.
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13. To add comments to the revised schedule item, double-click it to open it, 
then enter any comments in the Comments field, and click OK.

After you have created the revised supporting documentation schedule item, you 
need to submit it using an objection response or a filing amendment. See Working 
with Filing Amendments on page 274 and Working with Objection Responses on 
page 301.

Related Topic

• Creating Revised Form, Rate, and Advertisement Schedule Items on page 
288

Satisfying Previously Bypassed Requirements

Note: Supporting documentation filing requirements are referred to as requirements in 
this documentation.

If you had submitted a filing containing a requirement that was bypassed, you can 
revise the supporting doc item and satisfy the requirement.

Method: Satisfy a previously bypassed requirement

1. Navigate to the filing where you want to satisfy a previously bypassed 
requirement, and click the SERFF tab.

2. In the Supporting Documentation subtab, double-click the Requirement 
you want to satisfy. 

The Supporting Documentation Details dialog displays.

3. Click the Revise button.
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4. From the Status drop-down list, select Satisfied.

5. In the Comments box, enter any information about the requirement or the 
attachment.

6. Click the attachment type in Available Attachments. If necessary, expand 

the list of attachments by clicking on the  to the left of the source of 
attachments.

7. Click the attachment and click the right arrow  to move the attachment to 
the Selected Attachments list.

8. Click OK to save your changes.

The revised supporting doc item is added to the table, immediately below 
the original, identified by an R. 

Revising Bypass Reason for Bypassed Requirements

Note: Supporting documentation filing requirements are referred to as requirements in 
this documentation.

If you had submitted a filing containing a requirement that was bypassed, you can 
change the Bypass Reason with a revision.

Method: Revise the Bypass Reason for a bypassed requirement

1. Navigate to the filing where you want to create a revision with a new Bypass 
Reason, and click the SERFF tab.

2. In the Supporting Documentation subtab, double-click the bypassed 
requirement you want to revise. 

The Supporting Documentation Details dialog displays.
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3. Click the Revise button.

4. From the Status drop-down list, select Bypassed.

5. In the Bypass Reason box, enter the new information about the bypassed 
requirement.

6. Click OK to save your changes.

The revised supporting doc item is added to the table, immediately below 
the original, identified by an R. 

Bypassing Satisfied Requirements

Note: Supporting documentation filing requirements are referred to as requirements in 
this documentation.

If you had submitted a filing containing a requirement that was satified, you can 
revise the supporting doc item and bypass the requirement.

Method: Bypass a previously satisfied requirement

1. Navigate to the filing where you want to bypass a previously satisfied 
requirement, and click the SERFF tab.

2. In the Supporting Documentation subtab, double-click the satisfied 
requirement you want to bypass. 

The Supporting Documentation Details dialog displays.
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3. Click the Revise button.

4. From the Status drop-down list, select Bypassed.

5. In the Bypassed Reason box, enter any information about the requirement.

6. Click OK to save your changes.

The revised supporting doc item is added to the table, immediately below 
the original, identified by an R. 

Working with Filing Amendments

You can use a filing amendment to correct mistakes or omissions that you have 
discovered.

This section includes the following topics:

• Creating Filing Amendments on page 294

• Editing Filing Amendments on page 298

• Deleting Filing Amendments on page 298

• Submitting Filing Amendments on page 299

Creating Filing Amendments

After a filing has been submitted to SERFF, you may discover that it contains 
errors or omissions, for example:

• the wrong attachment was included with a schedule item

• a schedule item was left out

• a key piece of data was missing from the filing

In these cases, you need to send the state a Filing Amendment with the revised or 
additional schedule items.
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Important: Use a Filing Amendment only to correct mistakes or omissions that you have 
discovered. If the state discovers an error or omission and sends an Objection 
Letter, you need to send the revisions or additions using an Objection Response, 
not a Filing Amendment: see Working with Objection Responses on page 301.

Note: You must finish submitting one Filing Amendment before you can create another.

Method: Create a Filing Amendment

Before you can create a Filing Amendment, you first need to create any missing 
schedule items, or modify any schedule items that had errors under the Forms, 
Rates, Advertisements or Other Attachments tabs of a filing.

As the following procedure indicates, you need to complete extra steps if you are 
adding a new or revised Other Attachment to a Filing Amendment.

Complete the following steps to create or modify a schedule item:

1. If you are adding a revised Other Attachment to a Filing Amendment, 
complete the following steps, otherwise skip to step 2.

a. Navigate to the filing where you want to create a Filing Amendment 
with a revised Other Attachment, and click the Other Attachments tab.

b. Double-click the Other Attachment you want to revise to open it.

c. Click Revise.

d. Add attachments if required.

e. To automatically include this revision as a Supporting Doc, ensure the 
Create SERFF Supporting Doc Schedule Item check box is selected. 

Note: If this check box is clear, the revision can be added as a Supporting Doc via the 
Supporting Documentation Details dialog (which is accessed by double-clicking 
the requirement on the Supporting Documentation subtab in the filing’s SERFF 
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tab). Multiple revisions as well as original versions can be added using this 
method.

f. Click OK. 

2. Within the filing for which you want to create a Filing Amendment, click the 
SERFF tab.

3. Click the Supporting Documentation tab.

The Supporting Documentation tab displays.

4. For new Other Attachments only, complete the following steps. For all other 
attachment types, skip to step 5.

a. Click the User Added Requirement button  on the SERFF toolbar.

b. On the User Added Requirement dialog, enter text in the Comments 
field.

c. Click the Other Attachment in the Available Attachments list. If 

necessary, expand the list by clicking on the  to the left of the source 
of attachments.

d. Click the attachment, then click the right arrow  to move the 
attachment to the Selected Attachment list.
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e. Click OK.

The requirement you selected is now listed in the Supporting 
Documentation table.

You can now create the filing amendment. Continue to the next step.

5. Click the Correspondence subtab.

6. Click the Filing Amendment button.

7. The Filing Amendment dialog displays, and the Created date is 
automatically populated.

 

Note: The Created date for migrated filings will be blank.

In the Comments field of the Filing Amendment dialog, enter any 
information you want to tell the state about the reason for the Filing 
Amendment and revised or additional schedule items.

8. Click the schedule item type in Available Schedule Items list. If necessary, 

expand the list by clicking on the  to the left of the source of attachments.

9. Click the schedule item, then click the right arrow  to move the schedule 
item to the Selected Schedule Items list.

10. Click OK to save the Filing Amendment.
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The filing amendment is added to the list of Correspondence with a Status 
of Draft.

You can now submit the Filing Amendment.

Editing Filing Amendments

You can edit a Filing Amendment that is in Draft status.

Method: Edit a Filing Amendment

1. Navigate to the filing containing the Filing Amendment you want to edit, 
and click the SERFF tab.

2. Click the Correspondence subtab.

3. Double-click the Filing Amendment that you want to edit.

4. Make any necessary changes. (For field descriptions, see Creating Filing 
Amendments on page 294.)

Deleting Filing Amendments

You can delete a Filing Amendment that is in Draft status.

Method: Delete a Filing Amendment

1. Navigate to the filing containing the Filing Amendment that you want to 
delete, click the SERFF tab.

2. Click the Correspondence subtab.

3. Select the Filing Amendment that you want to delete.

4. Press the Delete key or click the delete button on the Tracker toolbar.

You are asked to confirm the deletion.

5. Click Yes to delete the Filing Amendment or click No to cancel.
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Submitting Filing Amendments

After you have completed a filing amendment, you can submit it to the state.

Method: Submit a filing amendment

1. Click the Perform Activity button on the Tracker toolbar. 

2. From the list of available activities, double-click SERFF: Submit Filing 
Amendment.

3. If desired, clear the Move to the Filing Package and Submit to SERFF 
check box.

If you perform the activity but do not select Move to the Filing Package and 
Submit to SERFF, the status on the Correspondence tab remains as Draft but the 
item is not editable. In order to enable editing, you will have to first delete the 
related activity, which unlocks the related item on the Correspondence tab, and 
then go in and make changes.

4. Add an Activity Memo if required, and click Perform.

5. Read the confirmation message that displays, and click Confirm.

The filing amendment is submitted. 

In the Correspondence tab:

• the Status of the filing amendment changes to Submitted. (If the 
Tracker Monitor is busy processing other activities, the status of the 
filing amendment will remain Queued until the filing amendment has 
been succesfully submitted.)

• the date the filing amendment was sent is displayed in Date Rec’d/Sent 
column.

Note: The SERFF status of the filing does not change after submitting a filing 
amendment.

Viewing Objection Letters

If the state that you submitted your SERFF filing to finds a problem with your 
filing that requires further explanation or revisions, the state may send an 
Objection Letter (previously called a Problem Report) detailing the problems they 
have found. 

Method: View an Objection Letter

1. To open the Objection Letter, perform one of the following:

• At the Top level, click the My SERFF Messages tab.
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• Navigate to the filing to which the Objection Letter applies, click the 
SERFF tab and then the Correspondence tab.

• Navigate to the filing to which the Objection Letter applies, and click 
the Filing Package tab.

2. Double-click the Objection Letter.

The Objection Letter screen opens.

The Objection Letter screen contains the following information:

• SERFF Filing ID

• Created By

• Date Letter Sent

• Created On

• Respond By Date 

• Objection Letter Date

• Message text with the following information:

• Objection Letter Status

• Salutation line – populated by Tracker with the filing manager’s 
name

• Introductory paragraph

• Comments for objections – the actual objection comments and the 
schedule items to which the objection comments apply
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• Closing paragraph

• Reviewer Contact Info – populated by Tracker with the names of 
the reviewers assigned to the filing; the Primary Reviewer is 
displayed first, followed by any other reviewers

• Attachments

3. When you are done reviewing the Objection Letter, click OK to close it.

You can respond to this objection letter by creating and submitting an Objection 
Response. See: Working with Objection Responses on page 301.

Working with Objection Responses

You must use an Objection Response to respond to an Objection Letter.

The procedures for working with Objection Responses are:

• Creating Objection Responses on page 301

• Editing Objection Responses on page 305

• Deleting Objection Responses on page 305

• Submitting Objection Responses on page 306

Creating Objection Responses

Complete the following procedure to create an Objection Response.

Method: Create an Objection Response

1. Navigate to the filing that contains the objection letter you want to respond 
to and click the SERFF tab.

2. Click the Correspondence subtab.

3. From the table, double-click the objection letter.

The Objection Letter screen opens. (For more information about objection 
letters, see Viewing Objection Letters on page 323.)

4. Click Create Response.

The Objection Response dialog displays.
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The Respond By Date field, the Created field, and the name of the primary 
reviewer are automatically populated. 

Note: The Created date for migrated filings will be blank.

5. Click Create (or Edit if you editing an existing introduction) next to the 
Introductory Paragraph box.

6. Enter an introduction for this response.

7. When you are done, click OK.

The text in the Introductory Paragraph is saved.

If this was a new introduction, the Create button changes to an Edit button.

8. Click Add Response.

The Objection Response Details screen opens.
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9. In the Response Comments text box, enter your response to one more 
objections.

10. The Applies To: section contains a grid listing each of the objections from 
the Objection Letter. The first three lines of the objection are displayed in 
the list. To see the entire objection, mouse over the objection; the full 
objection appears as a pop-up.

In the Applies To: list, select the check box for each objection to which your 
Response Comments apply.

11. To affiliate schedule items with this Objection Response:

a. In the Available Schedule Items list, expand an entry by clicking the 
plus sign (+) to the left of the name.

b. Double-click a specific schedule item to move it to the Selected 
Scheduled Items list. You can also use the > and < keys to move a 
selected schedule item from one list to the other.

12. When you are done, click OK to save your work or click Cancel to exit 
without saving.

You are returned to the Objection Response screen.

13. Repeat steps 8 to 12 to respond to the next objection.
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14. When you are done entering all your objection responses, click OK.

You are returned to the Objection Response screen.

If you want to delete an existing response, select the response, then click 
Delete Response.

15. You can now view a summary of your responses. On the Objection 
Response screen, click the View Summary button.

The Objection Response Summary screen opens. (The information in this 
screen is read-only.)

In the Objections section, all the objections from the state are listed. A 
selected check box next to an objection indicates if you created a response 
for that objection.

In the Selected Schedule Items section, a list of revised or additional 
schedule items associated with the objection responses also appears.

16. After you are done reviewing this screen, click OK.

You are returned to the Objection Response screen. 

17. Click Create next to the Closing Paragraph box, or if this was a new 
closing paragraph, click Edit.

18. Enter your concluding remarks for this response.

19. When you are done, click OK to save your work.

20. Click Close to exit the Objection Response screen.
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You are returned to the Correspondence tab. Your objection response is 
added to the table, directly below the corresponding objection letter, with a 
status of Draft.

You can now submit the Objection Response. 

Editing Objection Responses

You can edit an Objection Response that is in Draft status.

Method: Edit an Objection Response

1. Within the filing containing the Objection Response that you want to edit, 
click the SERFF tab.

2. Click the Correspondence subtab.

The Correspondence subtab displays.

3. Double-click the Objection Response that you want to edit.

4. Make any necessary changes. (For field descriptions, see Creating 
Objection Responses on page 301.)

Deleting Objection Responses

You can delete an Objection Response that is in Draft status.

Method: Delete an Objection Response

1. Within the filing containing the Objection Response that you want to delete, 
click the SERFF tab.

2. Click the Correspondence subtab.

3. Select the Objection Response that you want to delete.

4. Press the Delete key or click the delete button on the Tracker toolbar.

You are asked to confirm the deletion.

5. Click Yes to delete the Objection Response or click No to cancel.
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Submitting Objection Responses

After creating an Objection Response and responding to all the objections in it, 
you can submit it to the state.

Method: Submit an objection response

1. Click the Perform Activity button on the Tracker toolbar. 

2. From the list of available activities, double-click SERFF: Submit 
Objection Response to SERFF.

The SERFF: Submit Objection Response to SERFF dialog displays.

3. Review the content of the activity. If required, enter comments in the Memo 
field.

4. Select the Move to Filing package check box.

5. Click Perform to submit the Objection Response.

If there is more than one Objection Response in Draft status that is ready for 
submission, then Tracker sends them all, with the oldest Objection Response 
first.

A status message for the activity is displayed. 

6. Click OK.

The Objection Response is submitted. In the Correspondence tab:

• the Status of the Objection Response changes to Submitted

• the date the Objection Response was sent is displayed in Date Rec’d/Sent 
column 

If you perform the activity but do not select Move to the Filing Package and 
Submit to SERFF, the status on the Correspondence tab remains as Draft but the 
item is not editable. In order to enable editing, you will have to first delete the 
related activity, which unlocks the related item on the Correspondence tab, and 
then go in and make changes.

Notes:

After submitting an Objection Response:

• the SERFF status of the filing changes to Pending State Action

• the Objection Response is added to the Filing Package tab

• the state revises the Respond By Date in SERFF and the system receives a 
SERFF message with the updated Respond By Date. (On the 
Correspondence subtab on the SERFF tab, the Respond By Date on the 
Objection Letter screen is also updated.)
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• If the Tracker Monitor is busy processing other activities, the status of the 
Objection Response will remain Queued until the Objection Response has 
been succesfully submitted. 

Viewing Disposition Reports
A disposition report is the only type of SERFF report available. It advises the filer 
of the disposition of the filing, and is generated when the state closes a filing and 
changes the filing’s status to Closed–[State Specific].

Method: View a disposition report

1. Navigate to the filing with the Disposition Report and either

• click the SERFF tab then the Correspondence subtab

OR 

• click the Filing Package tab.

2. Double-click the entry with a Correspondence Type of Disposition 
Report.

The report opens.

3. When you have finished reviewing the report, click OK to close it.

Contents of Disposition Reports

Disposition reports may include the following information:

• SERFF Filing ID

• Disposition Date

• Implementation Date

• Disposition status – this status is unique to each state; possible values are 
Closed, Closed - Approved, Closed - Disapproved, Closed - Rejected, 
Closed - Acknowledged

• Company Name 

•  % Indicated Change

• Overall Percentage Rate Impact

• Written Premium Change

• No. of Policyholders Affected

• Written Premium amount

• Comments

• Attachments 

Note: Following a disposition report, the state may send status updates that change the 
the Implementation Date. You can access status updates via the Message Center.”
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Submitting an Additional EFT Payment

If the state allows EFT payments and the company is set up for EFT, after a filing 
has been submitted with an initial check or EFT payment, the following method 
can be used to make additional EFT payments.

Method: Submit an additional EFT payment

1. Navigate to the filing where you want to submit an additional EFT payment, 
and click the Filing Fee tab.

The initial payment is shown in the Payment History Details table. 

Note: If the initial payment was by check, the Check option will also be selected. If the 
initial payment was by EFT, only the EFT option will be available.

2. Select EFT as the payment method, and click Add Payment.

The EFT Fee Allocation dialog displays.

3. Enter the Fee Amount.

4. Enter any descriptive notes in the Comments field.

5. Click Allocate.

The fee is added to the Fee Allocation table at the bottom of the dialog.
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Note: If the fee amount you enter exceeds the maximum allowed for your EFT 
authorization level, a message will be displayed. In this case, you will not be able 
to proceed with the EFT payment for this filing. You will need to contact your 
Tracker Administrator to continue, or you will need to have another user with the 
appropriate EFT authority level complete the EFT information.

6. Click OK to save your work.

The filing fee you entered is displayed in the Payment History Details table 
at the bottom of the Filing Fee tab. (For more information about this table, 
see Viewing EFT Transaction Information at the Filing Level on page 263.)

7. Perform the activity SERFF: Submit Additional Fee.

Tracker submits the additional EFT payment via SERFF

Tip: You can use this method if your initial payment was by check and you decide to 
switch to using EFT instead before you send the check. Since Tracker has no way 
of knowing that the initial check was not sent, you should delete the check 
payment manually. 
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Working with Closed Filings

 For a filing that has a SERFF status of Closed, you can send a Note to Reviewer, 
receive a Note to Filer, or in some cases, send a Post Submission Update.

• See Working with Post Submission Updates on page 312.

Sending a Note to Reviewer

For a filing that has a SERFF status of Closed, you can still create and submit a 
Note to Reviewer, if the state allows you to. You may need to do this, for example, 
if:

• the state rejected the filing and you want to ask the state to reopen it

• the state closed the filing with a status of disapproved because you failed to 
respond to an objection letter or request within the require time frame, and 
you want to reopen the filing to respond

• you want to amend the implementation date

Method: Create a Note to Reviewer on a closed filing

1. Navigate to the filing where you want to create a Note to Reviewer.

2. Click the SERFF tab.

3. Click the Correspondence subtab.

4. Click Note to Reviewer.

The Note to Reviewer dialog displays.
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5. Complete the Subject field.

6. Complete the Comments field with the information that you want to send to 
the state.

7. Click OK to save your changes.

The Note to Reviewer is added to the list of Correspondence with a Status 
of Draft. It is also listed on the Filing Package tab.

To submit the Note to Reviewer, see Submitting Notes to Reviewers on page 286.

Receiving a Note to Filer

For a filing that has a SERFF status of Closed or Pending, you can receive a Note 
to Filer from the state.

An unread Note to Filer will be displayed in bold in the My SERFF Messages 
tab, as highlighted below:

Related Topics

• Note to Filer on page 280

• Managing Messages in the Message Center on page 280
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Working with Post Submission Updates

After a filing has been submitted to SERFF, you may be able to update the 
submitted filing using a Post Submission Update. Each state determines if Post 
Submission Updates (PSUs) are allowed on open filings, on closed filings, or 
both. 

Related topics:

• Post Submission Update Button on page 312

• Post Submission Update Dialog on page 312

• Using a Post Submission Update to Add Rate Data to a Non-rate Filing on 
page 320

• SERFF: Submit Post Submission Update Activity on page 320

Post Submission Update Button

The Post Submission Update (PSU) button is displayed on the SERFF 
Correspondence subtab. This button becomes active after a successful initial 
filing submission. Depending on the state rules for PSUs and the status of the 
filing, clicking the PSU button will either open the PSU dialog or display an error 
message indicating that PSU are not available for this filing. The following table 
illustrates the effect of clicking the active Post Submission Update button:

Post Submission Update Dialog

The Post Submission Update dialog contains the following areas of information:

• PSU Dialog: Header Fields

• PSU Dialog General Tab

• PSU Dialog Rate Change Details Tab

• PSU Dialog Last Revision Tab

State support for 
PSUs

SERFF Filing 
status Result of clicking PSU button

not allowed open or closed error message displays

open filings only open PSU dialog displays

open filings only closed error message displays

open and closed 
filings

open PSU dialog displays

open and closed 
filings

closed PSU dialog displays
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PSU Dialog: Header Fields

Created

The Created date field is auto-populated with the current date.
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Rate Info Applies 

• If No is the default selection, then only the General tab is active on the Post 
Submission Update dialog.

• When Yes is selected or is the default selection, all tabs on the Post 
Submission Update dialog are active.

• When No is not the default but is selected. the following message appears:

This action will delete all information entered in the Rate, CG, and Last 
Revision tabs, are you sure you want to proceed?

A Yes button and a No button are displayed.

If No is selected, the message is closed and the Rate Info Applies indicator 
is returned to Yes. 

If Yes is selected,   

• Any values input or selected under the Change, On Approval, or Null 
columns on the Rate Change Details, and Last Revision tabs are deleted 
as if they were never input or selected and instead, “Removed” appears 
for each field under the Change column.

• All fields on the Rate Change Details, and Last Revision tabs become 
inactive (locked).

• The SERFF: Submit Post Submission Update activity will display the 
following sentence: “Rate Information does not apply or has been 
removed” and will not display the Rate Change Details and Last 
Revision tables.

• If the state allows this Post Submission Update, then all Rate Data fields 
on the filing’s Rate tabs are cleared; the Max% change (approved) and 
Min% change (approved) fields are emptied.

Condition Rate Info Applies Setting

Filing is a rate or rate combo filing Yes (default)

Filing is not a rate filing and there is 
no rate data

No (default)

Filing is not a rate filing but there is 
rate data

Yes (default)

All active Null check boxes are 
selected for all fields on the Rate 
Change Details, and Last Revision 
tabs, and there are no values in the 
Change column for any of the fields

No (set by system)
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View Instructions

When View Instructions is clicked, Tracker displays optional comments and 
instructions for Post Submission Updates. This is the same information that is 
displayed on the SERFF tab in Regulatory Specialist.

PSU Dialog General Tab

Field Column

Displays the name of the field for this row of the table.

Current Column

Displays the current value for a field if one is in the database.

Change Column

Provides a place to enter a new value for the field. Note the following:

• Requested Filing Mode Explanation cannot be changed unless “Other” or 
“Combination” is displayed for Requested Filing Mode in the Current 
column or selected as an option under the Change column. 

• When a field cannot be changed, no input field will display in the Change 
column.

• For the PPACA field, an arrow button is displayed in the Change column. 
When clicked, a list of PPACA options will display. The content of this list 
is updated each time the button is clicked. If the selected sub-TOI is flagged 
by SERFF as not PPACA, no menu will display.

• When updating the Grp Mkt Type (Group Market Type) field, ensure you 
select all the options required, not just the additional options. When the PSU 
is submitted, the selections in the Change column will replace the previous 
value(s), not add to them.

Data can be entered in the Change column for the Related Fo(rm), Related Ra(te), 
and Related Ad(vertisement) fields by manually entering a related filing number 
or by clicking the Search button that displays when you click the cell.

The Search dialog functions identically to the Search dialog on the Related Filings 
section of the Filing banner. (See Linking Related Filings on page 185.)

Once a value is selected or input in the Change column for the Related Fo(rm), 
Related Ra(te), and Related Ad(vertisement) fields, this value is not locked; it can 
be edited.

Tip: When a drop-down menu is available to select a value in the Change column, you 
can delete an entry by selecting an empty row from the drop-down menu.
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On Approval Column

For Implementation Date, the On Approval check box is active only if “On 
Approval” is selected for this date on any Activity. 

When selected, if there is a Date in the date input field, the Date is deleted and the 
date input field is disabled.    

If the Post Submission Update is Allowed by the State, then “On Approval” will 
appear in the appropriate Tracker fields instead of a new date.   

Null Column

Unless the field is required (that is, the field cannot be empty in the database, like 
the Product Name), a check box will display in the Null column. To have the PSU 
remove the value from the field (as opposed to changing the value or leaving it as 
it is), select the check box.

PSU Dialog Rate Change Details Tab

This tab appears on the Post Submission Update dialog at all times even if the 
filing is not a rate filing. 

Field

Displays the name of the field for this row of the table.

Current

Displays the current value for a field if one is in the database.

Change

Provides a place to enter a new value for the field.
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Null Column

To have the PSU remove the value from the field (as opposed to changing the 
value or leaving it as it is), select the corresponding check box in this column. 

Product Types

When this button is clicked, the Post Submission Update Product Types dialog 
displays.

Note: Data entered on this dialog is only applicable to PPACA filings. If values entered 
do not conform with current NAIC regulations, a detailed message will be 
displayed when you attempt to submit the PSU to SERFF.

Type

Displays the name of the product type for these two rows of the table.

Field

For each product type there is a row for # of Policy Holders and a row for # of 
Covered Lives. 

Current

Displays the current value for a field if one is in the database.

Change

Provides a place to enter a new value for the field.
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Note: Both values for a Product Type must be entered even if your PSU is only changing 
one.

Null Column

• Unless the field cannot be changed, a check box will display in the Null 
column. To have the PSU remove the value from the field (as opposed to 
changing the value or leaving it as it is), select the check box. The Null 
check box applies to both # of Policy Holders and # of Covered Lives for 
that Product Type.

Rate Review Detail

When this button is clicked, the Post Submission Update Rate Review Detail 
dialog displays.

Note: Data entered on this dialog is only applicable to PPACA filings. If values entered 
do not conform with current NAIC regulations, a detailed message will be 
displayed when you attempt to submit the PSU to SERFF.

Current

Displays the current value for a field if one is in the database.
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Change

Provides a place to enter a new value for the field.

Null Column

Unless the field cannot be changed, a check box will display in the Null column. 
To have the PSU remove the value from the field (as opposed to changing the 
value or leaving it as it is), select the check box.

PSU Dialog Last Revision Tab

This tab appears on the Post Submission Update dialog at all times even if the 
filing is not a rate filing. 

Field

Displays the name of the field for this row of the table.

Current

Displays the current value for a field if one is in the database.

Change

Provides a place to enter a new value for the field.

Null Column

Unless the field cannot be changed, a check box will display in the Null column. 
To have the PSU remove the value from the field (as opposed to changing the 
value or leaving it as it is), select the check box. 
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Using a Post Submission Update to Add Rate Data to a 
Non-rate Filing

When a rate is added to a non-rate filing (for example, a form filing or a 
advertisement filing) before the initial filing submission, a Rate tab is added to the 
filing with all the appropriate subtabs unlocked and the rate and rate data will be 
part of the initial filing submission.

When a rate is added to a non-rate filing after initial filing submission and there 
has not been an Allowed PSU adding rate data to the filing, a Rate tab is added to 
the filing with only the Rate List subtab active. The Rate Change Details and Last 
Revision subtabs will be locked. The only way rate data can be added for this 
newly added rate is via a Post Submission Update.

If rate data is added to a non-rate filing via a Post Submission Update (before a 
rate was added to the filing) and the PSU is allowed by the state, the rate data will 
only be viewable on the PSU itself, the activity, and in Filing Summary but it will 
not be displayed on a Rate tab since this is not a rate filing and there is no Rate 
tab. 

However, if a rate is then added to the filing, a Rate tab will now appear with Rate 
List, Rate Change Details and Last Revisions subtabs (since there is already rate 
data for this filing via an Allowed PSU) and the rate data from the Allowed PSU 
will appear on the Rate tab/subtabs. If there is more than one Allowed PSU with 
rate data, the rate data from the most recently Allowed PSU will be displayed.

Note: When the added rate is submitted via a Filing Amendment or Objection Response, 
only the rate schedule information is sent and not the rate data.

If rate data is added to a filing that was a non-rate filing at initial submission but a 
rate has since been added to the filing and the rate data is now being added via a 
Post Submission Update, when the PSU is allowed by the state, the rate data that 
was added as part of the PSU is now displayed on the Rate Change Details and 
Last Revision subtabs.

SERFF: Submit Post Submission Update Activity

The SERFF: Post Submission Update activity must be performed in order to 
submit the PSU to SERFF. This activity can only be performed if a draft PSU has 
been created for the filing.
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Creating a Post Submission Update

To update a previously submitted filing, follow the steps in this method.

Method: Create a Post Submission Update

1. Navigate to the SERFF Correspondence subtab and click Post Submission 
Update.

The Post Submission Update (PSU) dialog displays. The Date field is 
autopopulated with the current date.

2. Complete the required fields in the PSU dialog and click OK, or click 
Cancel to end creating the PSU without saving changes.

When OK is clicked, an entry with a status of Draft is added to the table on 
the SERFF Correspondence subtab.

Note: After creating a draft PSU, the PSU will display on the SERFF Public Access 
subtab. Selecting Request Conf for the PSU does not request confidentiality for 
the data attached to the PSU; the public access/confidentiality setting for the data 
attached to the PSU is based on what the settings currently are for the filing or the 
Rate fields.

3. Perform a SERFF: Submit Post Submission Update activity.

Note: When performance of the SERFF: Submit Post Submission Update begins, 
Tracker first checks the PPACA value in the PSU against the current PPACA 
values at SERFF. If there is any issue using the PPACA value in the PSU, a 
message will display. Carefully read the text of the message; subsequent user 
action may be required before the SERFF: Submit Post Submission Update 
activity executes successfully.
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When a response is received from SERFF, an entry for the response is added 
to the table on the SERFF Correspondence subtab and the status of the PSU 
is updated appropriately. If a response of Allow is received from SERFF, 
Tracker updates the filing with the values entered in the PSU dialog. To keep 
track of the status of the PSU, refer to the table on the SERFF 
Correspondence subtab.

The following table describes the different statuses for a PSU:

PSU Activity on Activities Tab

After performing the SERFF: Submit Post Submission Update Activity, an 
activity is added to the table of activities on the Activities tab.

To open the activity, double-click it.

Status Effect

Draft • values have been entered in the PSU dialog and saved
• all fields in draft PSUs (except the Date field) can be 

modified by clicking the PSU button
• draft PSUs can be deleted by selecting the PSU in the 

table and clicking the Delete button on the toolbar

Queued • a draft PSU has been created for the filing and the 
SERFF: Submit Post Submission Update activity has 
been performed, but Tracker has not completed the 
transfer to SERFF

• the PSU button is inactive

Submitted • a draft PSU has been created for the filing and the 
SERFF: Submit Post Submission Update activity has 
been performed but no response from SERFF has been 
received 

• the PSU button is inactive

Allowed • an Allowed response to the submitted PSU has been 
received from SERFF for this filing 

• the filing has been updated with the entries from the 
PSU

• the PSU button is active

Disallowed • a Disallowed response to the PSU has been received 
from SERFF for this filing

• the filing has NOT been updated with the entries from 
the PSU

• the PSU button is active
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Only fields where values were changed will be displayed in the tables on the 
activity. If there were no values changed on a particular tab/table, the table will 
not appear on the activity.

SERFF Responses to PSU

Responses to the SERFF: Submit Post Submission Update are displayed on the 
SERFF Correspondence subtab. 

Double-click the response on the SERFF Correspondence subtab to display the 
details.
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Working with Public Access/Confidentiality 
Requests

The Public Access subtab enables you to request via SERFF that certain parts of a 
filing or the filing itself be kept confidential and not made available via Public 
Access.

Note: If the state does not allow confidentiality requests, this subtab will not appear.

The Public Access subtab displays the contents of a filing being submitted via 
SERFF in a list. The list is automatically updated if any items are removed or 
added to a filing. The items in the list (when present in the filing) are displayed in 
this order, from top to bottom:

• at the top of the list:

• an entry called Entire Filing

• under the heading Schedule Items:

• all forms

• all rates, followed by Rate Details and Rate Review Detail (for HIPR-
enabled states) 

• all advertisements

• under the heading Supporting Documentation:

• all SERFF filing requirements (including User Added attachments) that 
have been satisfied or bypassed, the comments, the bypass reasons, and 
the attachments

• under the heading Correspondence:

• all SERFF correspondence (in chronological order, with the oldest on 
top)

For each item in the list, there is a corresponding Request Conf check box, a 
Status value, and a Public Access value.

Request Conf

Select the check box in the Request Conf column to request this item be treated 
as confidential by the state.
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Status

The value displayed in this column (Accepted or Rejected) indicates the result of 
requesting confidentiality for this item. If the state accepts the request for an 
item’s confidentiality, the item’s Status will remain at Accepted. If the state 
rejects the request for an item’s confidentiality, the item’s Status will be set to 
Rejected.

Note: Prior to submitting the filing via SERFF, when you select an item’s Request Conf 
check box, the Status for the item will display Accepted. Clearing the Request 
Conf check box will clear the Status for that item.

Public Access

The value displayed in this column will reflect the item’s current public access 
setting from the state. 

If the Status of an item is Accepted, then the item will have a value for Public 
Access of N (meaning “no Public Access,” or “this item is confidential”). 
Likewise, an item with a status of Rejected will have a Public Access value of Y 
(meaning “this item is not confidential”).

The Public Access value displayed for an item on the Public Access subtab 
matches the Public Access value for the item in other dialogs in Tracker. 

Note: If Public Access for an item is changed to a Y for an item on the SERFF Public 
Access subtab, and that item is selected for confidentiality (Request Conf check 
box is selected) but the request for confidentiality has not yet been submitted, then 
the Request Conf check box is automatically deselected and a confidentiality 
request will not be submitted for this item. 

Entire Filing Selection

Prior to initial submission, if the Request Conf check box for Entire Filing is 
selected, all the items in the list become selected and their statuses becomes 
Accepted. (Clearing the Request Conf check box for Entire Filing clears all the 
check boxes and status values.) 

Selecting the Entire Filing option as part of the initial filing submission and as part 
of a subsequent submission results in all existing items, new or revised items, and 
SERFF correspondence from Tracker to the state, being automatically selected for 
a confidentiality request, and these files cannot be deselected. SERFF 
correspondence from the State to Tracker—such as Note to Filer, Objection 
Letter, etc.—are not automatically selected for a confidentiality request. These 
correspondence items can be manually selected if you choose.

Note: The Entire Filing option is only available if the state has not set any part of the 
filing as public (that is, the Public Access indicator for all items is either blank or 
N).
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When the Request Conf check box for Entire Filing is selected and submitted to 
SERFF, the state considers the Entire Filing item separate from the items. This 
means that there are several possible outcomes: 

Tip: When the state sets Public Access on the Entire Filing item, it is only referring to 
general filing information not covered by the various other items (that is, filing 
fees, product info, etc.).

Public Access/Confidentiality Requests After Filing 
Submission

After the initial filing submission, you can request confidentiality for any items 
not previously selected and submitted, or any items where Public Access is blank 
or N, by selecting Request Conf for the item(s) and performing a SERFF: Submit 
Confidentiality Request activity.

When the SERFF: Submit Confidentiality Request activity is run, confidentiality 
is requested for items that are newly selected for Confidentiality on the SERFF 
Public Access subtab. However, any items in draft status (that is, Objection 
Response, PSU, etc.) and any schedule item added or revised but not yet 
submitted (for example, a revised Form) where confidentiality has been selected, 
will not be submitted as part of this Confidentiality Request.

For example, an NTR is submitted but confidentiality is not requested on the NTR 
when submitted. A PSU is then created and is in Draft status. On the SERFF 
Public Access subtab, the NTR and the PSU in Draft status are both selected for 
confidentiality. Then the SERFF: Submit Confidentiality Request activity is run. 
Confidentiality will only be requested for the NTR and not the PSU in Draft 
status. Confidentiality for the PSU in Draft status will be requested when the 
SERFF: Submit Post Submission Update activity is run.

After filing submission, SERFF Correspondence items will be displayed at the 
bottom of the list on the Public Access tab.

When submitting a Post Submission Update, the Public Access status of the PSU 
itself is displayed; the Public Access status of the data attached to the PSU is 
based on what the settings currently are for the filing or rate fields.

Request Conf 
Submitted Status Public Access

Entire Filing Entire Filing Item: Accepted

All Other Items: Accepted

Entire Filing: N

All Other Items: N

Entire Filing Entire Filing Item: Rejected

All Other Items: Accepted

Entire Filing: Y

All Other Items: N

Entire Filing Entire Filing Item: Rejected

Some Items: Rejected

Some Items: Accepted

Entire Filing: Y

Rejected Items: Y

Accepted Items: N
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The attachments for Objection Responses and Filing Amendments appear 
separately in the list and have their own Confidentiality Request settings and 
indicators.

Public Access Settings

Public Access settings are locked and cannot be changed on items where 
confidentiality was requested and submitted, or where Public Access has been set 
to Y by the state.

Public Access settings are also locked for the entire filing or any of its parts once 
the filing has a SERFF status of Closed. However, if the filing is re-opened by the 
state, the SERFF status is no longer Closed, so any items locked as a result of the 
filing being Closed are now unlocked and confidentiality can be requested for 
these items. This includes the Disposition that originally closed the filing and any 
Notes to Reviewer sent while the filing was closed.

Revisions and Correspondence Items

If the Entire Filing option was selected before any submission, as part of the initial 
filing submission, or as part of a subsequent submission, all items on the SERFF 
Public Access subtab, including existing items as well as new or revised items, 
will automatically be selected for a confidentiality request, and cannot be 
deselected. Correspondence from the state is the only exception to this rule. A 
Note to Filer, Objection Letter, and Disposition are not automatically selected for 
a confidentiality request. These items can either be manually selected or not 
selected at all. The Objection Response, however, will be automatically selected 
for a confidentiality request, and cannot be deselected.

If the Entire Filing option was not selected, if any of the items listed on the Public 
Access subtab are revised, the revised items will appear directly beneath the 
“parent” item. Revised items inherit the confidentiality settings of their “parents,” 
but these values are unlocked and can be changed if desired. Thus, even if an item 
has Public Access set to Y, a Confidentiality request can be submitted for revision 
to that item.

After a revised item is submitted via SERFF, the public access indicators all 
throughout Tracker (including the Public Access tab) for this revised item are no 
longer tied to the parent item, and its public access status is completely separate 
from its parent’s.
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Filing Summary for SERFF Filings

The Filing Summary is an excellent way to generate a comprehensive snapshot for 
SERFF filings. (For information on Filing Summary for paper filings, see Filing 
Summary for Paper Filings on page 406.)

There are two parts of the Filing Summary that can be optionally displayed and 
printed: Filing Details, and Filing Correspondence.

This section contains:

• Filing Detail (SERFF Filings) on page 329

• Filing Correspondence on page 332

• Generating a Filing Summary on page 333

Filing Detail (SERFF Filings)

The Filing Detail part of the Filing Summary displays detailed information about 
the selected filing. The SERFF Filing Details tab displays most of this 
information.

In the header:

• SERFF Tracking Number

• State

• Filing Company

• State Tracking Number

• Tracker Filing ID or Company Reference # 

• TOI

• Sub-TOI

• Product Name (based on what was sent to SERFF or is in the Product Name 
field at the time the Filing Summary is generated)

• Project Name/Number (based on what was sent to SERFF or is in the 
Project Name/Number field at the time the Filing Summary is generated)

In the Filing Overview section:

• Company Name and Company Code

• Product Name (based on what was sent to SERFF or is in the Product Name 
field at the time the Filing Summary is generated)

• SERFF Tracking ID

• State

• TOI - include numbering & TOI name

• SERFF Status 

• State Tracking Number
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• Sub-TOI 

• Tracker Filing ID or Company Reference # 

• State Status

• Filing Type (based on what is selected when TOI/SubTOI selection made)

• Tracker Status

• Reviewer(s)

• Author (based on the Filing Manager)

• Disposition Date 

• Date Submitted (date successfully submitted filing via SERFF)

• Disposition Status

• Approved Effective Date (based on the Implementation Date that comes 
from SERFF)

• Implementation Date (based on the Implementation Date on the Filing 
Details tab)

• PPACA

In the General Information section:

• Project Name (based on what was sent to SERFF or is in the Project Name 
field at the time the Filing Summary is generated)

• Status of Filing in Domicile

• Project Number (base on what was sent to SERFF or is in the Project 
Number field at the time the Filing Summary is generated)

• Date Approved in Domicile

• Requested Filing Mode (based on what was sent to SERFF or what was in 
the Requested Filing Mode field at the time the Filing Summary is 
generated) 

• Domicile Status Comments

• Explanation for Combination/Other (based on what was sent to SERFF or 
what was in the Explanation for Combination/Other field at the time the 
Filing Summary is generated) 

• Market Type (based on what was sent to SERFF or what was in the Market 
Type field at the time the Filing Summary is generated) 

• Submission Type (based on what was sent to SERFF or what was in the 
Submission Type field at the time the Filing Summary is generated) 

• Group Market Size (based on what was sent to SERFF or what was in the 
Group Market Size field at the time the Filing Summary is generated) 

• Overall Rate Impact 

• Group Market Type 

• SERFF Status Changed (date)
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• State Status Changed (date)

• Deemer Date

• Tracker Status Changed (date)

• Related Filing ID (number and type)

• NAIC Filing Description

• Include Exchange Intentions

• Exchange intentions

In the Company and Contact section:

• Filing Contact Information:

• Filing Manager Name

• Filing Manager Title

• Filing Manager Email Address

• Filing Manager Address

• Filing Manger Phone Number 

• Filing Manager Fax Number

• Filing Company Information:

• Company Name

• NAIC Company Code

• State of Domicile

• Company Address

• NAIC Group Code

• Company Type

• Group Name

• State ID Number

• Company Phone Number 

• FEIN Number 

In the Filing Fees section, these fields display if required:

• Fee Required

• Fee Amount

• Retaliatory

• Fee Explanation

• Per Company

• Check Number

• Check Amount
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• Check Date

• Company

• Amount

• Date Processed

• Transaction #

In the State Specific section:

• State Specific information

Filing Correspondence

The Filing Correspondence section of a Filing Summary contains two parts: the 
Summary part, and the Filing Correspondence Details part.

The Summary part contains five sections:

1. Filing Correspondence

• Filing Correspondence Description

• SERFF Filing ID 

• Date

2. Supporting Documentation

• Requirement

• Status

• Rev

• Document Name(s)/Comments/Bypass Reason

• State Status

3. Public Access

• Public Access 

• Filing Package

• Request Conf

• Status

4. SERFF Form Schedule

5. SERFF Rate/Rule Schedule

The SERFF Rate/Rule Schedule includes the PPACA Product Types table, and the 
the values for the HIPR fields from the Rate Review Detail table.

The Filing Correspondence Details part contains the detail for each activity 
listed in the above Summary. Each activity’s detail is followed by the attachment 
from the activity’s Attach File field (if present), then the rest of the activity’s 
attachments (documents).
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Generating a Filing Summary

Any user can generate a Filing Summary by following these steps.

Method: Generate a Filing Summary

1. To generate a Filing Summary for one filing, navigate to the Filing level for 
the desired filing.

OR

To generate a Filing Summary for multiple filings in a filing group, navigate 
to the Filing Group level for the desired filing group and multi-select the 
desired filings.

2. Click the Filing Summary button on the tool bar.

The Filing Summary dialog displays.

3. Select the desired options for the Filing Summary. At least one option must 
be selected.

4. Click Generate Summary.

Note: If this is the first time you are generating a Filing Summary, Adobe Reader may 
display a warning message. Select the appropriate action and click OK.

The system generates and opens the PDF documents (one for each filing 
selected).
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Chapter 9

Understanding Filing Letters

This chapter deals with letters in Tracker and how to work with them.

A filing letter is composed of a number of elements. Most of them are generated 
automatically by the Tracker system. You must enter additional information 
during the filing preparation process.

Before creating a filing letter, you should have finished entering all the rate, 
advertisement, and form information for the filing, and all filing comments (see 
The Comments Tab on page 205 for details). If, after creating and previewing the 
letter, you become aware of missing elements or discrepancies, you can go back to 
the filing, make any necessary changes or additions, and generate the letter again.

This chapter describes:

• Available Letter Types on page 336

• Filing Letter Comments on page 338

• Creating Letters on page 340
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Available Letter Types

The following types of filing letter are described:

• Long Filing Letter on page 336

• Alternate Long Filing Letter on page 336

• Short Filing Letter on page 336

• Follow-Up Filing Letter on page 336

• Correspondence Letter on page 336

• Withdrawal Letter on page 336

• Objection Letter on page 337

Long Filing Letter

The long filing letter is lengthy and comprehensive. It is used for the initial filings.

Alternate Long Filing Letter

The alternate long filing letter is a slightly different version of the long version 
described above.

Note: When you begin using Tracker, experiment with the letter generation function and 
generate samples of each so that you become familiar with each of the various 
letter formats, and can use the letter that suits your needs best for each filing 
situation.

Short Filing Letter

The short filing letter is short and to the point. It is used for simpler filings, such as 
informational filings.

Follow-Up Filing Letter

The follow-up letter is a form letter used to follow-up on outstanding filings.

Correspondence Letter

The correspondence letter is used for communicating with State Departments of 
Insurance regarding filings that have already been submitted and are pending 
approval.

Withdrawal Letter

The withdrawal letter is used for indicating to a State Department of Insurance 
regarding that you want to withdraw a previously submitted filing.
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Objection Letter

The objection letter is used to reply to a State Department of Insurance following 
the receipt of an objection about a submitted filing.
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Filing Letter Comments

Depending on what has been specified in your filing, you may need to enter some 
of the following comment information as part of the filing letter creation process.

• General Forms Comment

Use this comment to make a statement about the forms and endorsements 
included in the filing.

• Advertisement Comments

Use this comment to include any pertinent information on the 
advertisements for the filing.

• Rate Comments

Use this comment to make a statement about the rates included in the filing.

• General Closing

You can include a general closing statement in your filing letter to 
summarize comments made in the body of the letter or to add information 
such as an appeal for fast approval. This statement precedes the final 
statement in the letter. The final statement, which includes your phone 
number, is generated automatically.

• Certification of Compliance

Use this comment section to enter a Certification of Compliance statement if 
required. Certification statements are state-specific. Your submission may or 
may not require that one be included in a filing letter. Even if one is not 
required, you may decide to include a certification statement as an assertion 
that the letter is in compliance with state regulations and laws.

• Attachment

Use this comment section to list any attachments that are being included 
with this filing, such as special exhibits, actuarial displays, filing 
memorandums, and so on

• Filing Fee Comment

Use this comment section to note whether a filing fee accompanies the 
filing, and if so, in what form and amount. Many states require that a fee 
accompany each filing submission; this information can be found in the 
SERFF General Instructions in the Regulatory Specialist section of your 
Tracker system.

• Special Language

Use this comment section to enter any state-specific or state-required 
language. Examples are specific legal text, or text that needs to be translated 
into a language other than English to meet state filing requirements.
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Note: See The Comments Tab on page 205 for more information.
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Creating Letters

You should ensure that all rate, advertisement, and form information and all filing 
letter comments (see The Comments Tab on page 205 for details) have been 
completed in the filing record before generating the filing letter.

Note: Filing letters will usually be generated as part of the Generate Complete Filing 
activity, so it is not required that the Generate Letter activity be performed before 
the Generate Complete Filing activity.

Method: Create a letter

1. Navigate to the filing where you want to create a letter.

2. Click the Perform Activity toolbar button  to open the Activity List 

box.

3. Select the Generate Letter activity (or another of the letter-generating 
activities; see Standard Tracker Activities on page 212 for details).

4. Click Perform to open the related new Perform Activity dialog box.

5. Enter information in the applicable fields:

• Use the Description field to enter a brief description of the activity 
(such as “draft long filing letter”).

• The Date field will automatically be filled in with today’s date.

• The Performed By field will automatically be filled in with your name.

• Indicate the Priority of the activity by clicking in one of the Low, 
Medium, or High selection buttons (the default priority is Medium).

• Select the required Letter Type from the drop-down list to the right of 
the field.

• Click or un-click the View, Print, Draft, and Print One Copy 
checkboxes as required.

If you check the View checkbox, the generated letter will be presented 
in a native application (such as Microsoft Word) window for viewing 
(you may then use Word’s print command to print the letter, if desired).

If the Print checkbox is checked, the letter will automatically be printed 
following generation.

If you check the Draft checkbox, the letter will be generated, but will 
not be saved for future viewing in the activity record.

If you check the Print One Copy box, only one copy of each document 
in the letter will be printed.
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Use the View/Draft check combination to generate and preview draft 
filing letters. If you want to generate and save a letter, and have it 
generate and print as part of the final Complete Filing generation, make 
sure that you un-check the Draft option.

Generated (non-draft) letters will be saved, and will be accessible later 
from the activity detail record.

6. Click Perform. The filing letter is generated. During the generation process, 
a Document Generation window appears, tracking the generation in 
progress.

7. The document will then open in Microsoft Word (if specified). Here you can 
view and print the filing letter, as required.

Warning: Editing a Filing Letter: Changes made to a generated letter in Microsoft Word 
will not be saved, and will not appear in any final generation of the complete 
filing.

If you want to make changes to a generated letter, do so while the word 
processor window is open and then select Save As from the File menu to 
save the changed letter document file to a location on your hard drive or 
system.You can then replace the letter in the Edit Activity window. Click 
Replace and choose the file. 

8. If it is open, close the Microsoft Word document window.

9. Click OK to finish.

The activity will be saved and listed on the filing’s Activity tab. The letter 
will remain available via the corresponding activity detail record.
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Chapter 10

Working with Legislation

In Tracker, the term legislation refers to all bulletins, circulars and legislative 
documents issued by state insurance departments, whether provided directly from 
the state or through trade organizations such as the HIAA (Health Insurance 
Association of America) or the ACLI (American Council on Life Insurance).

This chapter introduces you to the Tracker legislation tracking function, and 
describes how to enter new legislation into the system, and how to work with 
them to create filings and monitor your filing processes.

This chapter describes:

• The Main Legislation List Window on page 344

• Adding New Legislation Records on page 346

• Adding (Removing) States for an Existing LegislationThe following method 
describes how to add or remove states for an existing legislation. on page 
347

• The Legislation Record on page 348

• Creating a New Filing from a Legislation Record on page 352

• Linking Legislations to Filings on page 354

• Adding a Copy of a Legislation on page 355
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The Main Legislation List Window

The Main Legislation list window is your access point to all the legislation 
currently in your Tracker system. This screen is composed of two main elements: 
a Legislation tab listing all the legislation in the system, and a legislation header.

Note: To access the Legislation list window, on the menu bar, select View > 
Legislation.

When a legislation record listed on the Legislation tab is selected or highlighted, 
basic information relevant to that legislation appears in the upper field header. 
This provides you with a quick method of browsing through and viewing 
information pertaining to the legislation in your system.

You can browse through the other Legislation details records in the system by 
going to any one record and going back and forward through the records using the 
Back and Forward buttons.

From the main Legislation list window, you can access detailed information 
about any single legislation record in the system by double-clicking on that 
legislation on the Legislation tab.

Note: See also The Legislation Details Tab on page 348.

This chapter also describes:

• Adding New Legislation Records on page 346

The Suspended Button

At the Filing Group level and on the Legislation list window, a Suspended button 
appears on the right-hand side of the screen above the tabs. It is used to show only 
those records having a future dated (or Suspended) activity associated with them. 
This helpful feature allows you to view only those records which require your 
immediate attention, rather than having to sift through hundreds or thousands of 
records to find the ones you want.

The Suspended button is activated if it is depressed (so that it appear to be pushed 
in). It can be activated or inactivated by clicking on it with your mouse (one click, 
another click off). When you log in to Tracker, or access the filing group or 
Legislation sections of the system, the Suspended button is always activated by 
default. You will need to remember to check it, and unclick it (deactivate it) when 
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you are at these levels if you want to see any newly added or non-suspended 
records in the system.
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Adding New Legislation Records

The following method describes how to add new legislation records

Method: Add a new legislation record

1. At the Top, Filing Group, or Filing level, select Insert > Legislation from 

the menu bar, or click the Legislation button on the Tracker toolbar. 

The New Legislation dialog displays.

2. On the New Legislation dialog, enter the following information:

• The Legislation Number

• The Legislation Date (the date on which the legislation was issued)

• The Organization that issued the legislation

• The filing Content Type to which the legislation applies (Actuarial/
Rate, Advertisement, or Form)

• The Type of legislation (Advanced Law, Premium Comparison, 
Statistical Plan)

• The Status of the legislation (Administrative, Advisory, Approved, 
Filed, To Be Effective)

• The Line of Business to which the legislation applies
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• A brief Description of the legislation

• The State(s) for which the legislation applies. Note that the States field 
allows the selection of multiple states.

3. When finished, click OK. 

The new legislation will be added to your Legislation list window, and a 
related Legislation Details record will now be available.

Adding (Removing) States for an Existing 
LegislationThe following method describes how to add or remove states 
for an existing legislation.

Method: Add or remove states for an existing legislation

1. On the Legislation Details main screen, select Insert > Edit States.

The Add States dialog displays.

2. From the Available States list field, select the states which you want to add 
to this legislation, using the left and right Move/Move All buttons.

OR

From the To Add list field, select the states which you want to remove from 
this legislation, using the directional move buttons.

3. Click OK to close the dialog box and save your changes.
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The Legislation Record

There is a detailed Legislation dialog for every legislation record in your Tracker 
system. Each of these dialogs have four tabs:

• Details, with a set of detailed information about the legislation record. See 
The Legislation Details Tab on page 348.

• Links, with a list of other/previous legislation in Tracker linked to this 
legislation. See The Legislation Links Tab on page 349.

• Filing References, with a list of Filing References (linking this legislation 
to its resultant filings.) See The Legislation Filing References Tab on page 
350.

• Activities, with a list of activities performed in relation to this particular 
legislation record. See The Legislation Activities Tab on page 351.

The Legislation Details Tab

The Legislation Details tab contains fields where detailed information regarding 
the legislation can be stored.
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Entering and Editing Legislation Detail Information

The following information can be added or changed at any time following the 
creation of the legislation record:

• The Received Date indicating the date on which your company received the 
legislation.

• An Attachment pertinent to the legislation (such as an electronic version of 
the actual legislation). You can type in the desired path (to a maximum of 

255 characters), or browse (using the  button) to select the path of the 

attachment. After specifying a path you can later double-click in the 
attachment field to open the attached document.

• The Date to be Effective (the proposed effective date) for the contents of 
the legislation.

• The Effective Date (the actual effective date) for the contents of the 
legislation.

• Four custom User Date fields, which can be customized to suit the needs of 
your company. See Performing Custom Table Tasks on page 78 for details.

• Five Filing Reference Numbers.

Note: Click the Save button when you have finished adding or editing the legislation 
detail information to ensure that your information is saved.

The Legislation Links Tab

The Links tab lists legislation records which have been linked to the current 
legislation. Legislation records are generally linked if they are strongly related, 
have a bearing on one another, or are parts of a series of legislation records (a new 
legislation which replaces an old one would be linked to its predecessor).
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Adding a Legislation Link

To create a link between one legislation record and another legislation record in 
the system, use the following method.

Method: Add a legislation link

1. Open the detailed dialog for the Legislation where you want to create a link 
and click Insert > Add New Link.

The Linking Legislation dialog displays.

2. In the Link to Legislation # field, enter the legislation number of the 
legislation to which you want to link, or click Search to search for the 
desired legislation number in the system.

3. Click Next to open a new Link Legislation dialog box if you want to link 
another legislation to the current one,

OR 

Click OK to finish.

All specified links will be created and the dialog closes.

The Legislation Filing References Tab

The Filing References tab lists all of the filings which have been created from, or 
in reference to, this legislation. From here, you can access the filing details for 
each filing listed.

Note: Any filings that are linked to a legislation will automatically be listed on the 
Filing References tab.

A filing referenced by a legislation can be displayed by locating the filing on the 
Filing References tab, and double-clicking it. The filing’s dialog displays.
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The Legislation Activities Tab

In the Tracker system, an activity is any action related to or performed upon a 
filing group, filing, or legislation record. This can be anything: from the creation 
of a memo or a note to yourself; the recording of a phone call to or from a state 
insurance department; or the generation of a filing. All can be recorded and kept 
as a history within the activity function. The legislation level activity functions are 
composed primarily of passive, information tracking and communication 
activities.

For complete instructions about performing, posting, and working with the 
Tracker Activity function, please see Working with Activities on page 209.

The Legislation level Activities tab lists all activities that have been performed 
upon (or are pending performance upon) this legislation record. From this tab you 
can access the activity details for any of the activities listed.
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Creating a New Filing from a Legislation Record

You can create a new filing or filings directly from within a Legislation dialog. 
When a filing is created this way, Tracker automatically adds that filing to the 
legislation’s Filing References tab, and adds the legislation record to the new 
filing’s Legislation tab.

Method: Create a new filing from a legislation

1. From a Legislation dialog, click the New Filing(s) button  to open the 

Select Filing Group dialog box.

2. Select an existing filing group from the list, and click OK to open the New 
Filing(s) dialog. Go to step 7.

OR

To create a new filing group, click New to open the New Filing Group 
dialog.

3. Select a Product Name from the drop down list.

4. Check the Filing Group Code to see that it is what you want. If it is not, 
click in the Override check box and enter the filing group code you want.

5. Check that the filing group Name is what you want; change it if necessary.

6. Enter a filing group Description, Manager, and Date.

7. Click the New Filing(s) button to open the New Filing(s) dialog.
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8. Enter the required information for the filing: Description, Date, Filing 
Type, Filing Manager, and Content Type (check Rate, Advertisement, 
Form, or a combination). 

Note: The Content Type, Line of Business, and State(s) information will be pre-
selected according to the information in the originating legislation record; you 
may alter this if necessary.

9. From the Available list field on the left, choose the desired company/state/
line of business combination(s) for this filing using the left and right 
movement buttons. 

The selected combination(s) appears in the Queued for Filing field.

10. When you are satisfied with all the information displayed, click Create. 

A status box will open to display the filing creation process as it progresses; 
when the status box indicates that the process is done, click Close. The 
newly created filing(s) appear in the Filing Reference tab of the legislation 
from which they were created, and the information for the legislation 
appears in the related filing(s)’ Legislation tab.



WORKING WITH LEGISLATION

354 TRACKER L&H USER GUIDE

Linking Legislations to Filings

The following method provides the instructions for linking a legislation to an 
existing or new filing. 

Method: Link a legislation to an existing or new filing

1. Navigate to the filing you want to link to a legislation.

2. Click View > View Legislation.

3. If you do not see any legislations listed on the Legislation tab, click 
Suspended.

4. Double click on the applicable legislation.

5. To add a filing reference to an existing filing: 

a. Click Insert > New Filing Reference.

The New Filing Reference dialog displays.

b. In the Filing Number text box, type in your complete filing number. If 
you do not know the filing number, click Search and search for your 
filing. When you double-click a filing in the Search Results, the Search 
window closes and the filing number automatically populates the Filing 
Number text box.

OR

To add a filing reference and create a new filing:

a. Click Insert > New Filing Reference.

The Select Filing Group dialog displays.

b. To use an existing filing group, select filing group from the list, click 
OK, and follow the steps in Adding New Filings on page 116, beginning 
at step 2.

OR

To create a new filing group, click New and follow the steps in Adding a 
New Filing Group on page 110, beginning at step 2.

6. Click Next to add additional filing references to this legislation, or OK to 
exit.

The legislation’s Filing References are shown on the Filing References tab 
of the legislation’s window. 

A filing with legislations will have a Legislation tab where the legislations 
are listed.
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Adding a Copy of a Legislation

Often a piece of legislation will be sent that simply updates or revises existing 
legislation. Tracker allows you to update and link series of legislation records 
quickly and easily using the Copy Legislation function. The information from the 
old legislation record is copied to a new legislation record under the new 
legislation number, and the records are linked for easy tracking and referral. Any 
necessary changes can then be made to the new record and then saved in the 
system.

Method: Add a new version (copy) of an old legislation

1. On the Legislation list window, select the legislation you want to copy and 
click Insert > Copy Legislation, or click the Copy Legislation button on 

the toolbar. 

The Legislation dialog displays.

2. Enter the Legislation Number of the new legislation.

3. Check the Create Link? check box to create a link between the old 
legislation and the new one. The new legislation will be linked to the old one 
and will also carry any additional links or filing references that the old 
legislation did.

4. Click OK.

The new Legislation Details screen opens.

5. Make any changes to the information on the new Legislation Details record, 
as required, and click Save to save the new record.
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Legislation Reports

There are two standard reports in Tracker which you can use to better keep track 
of the legislation in your system: the Legislation Details Report under the Status 
tab, and the Legislation Summary Report under the Historical tab. For more 
information on using the Tracker reports functions, please see Searching, 
Reporting, and Filing Summary on page 375.
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Chapter 11

Working with the Regulatory
Specialist

This chapter introduces and explains the Regulatory Specialist component of 
Tracker. 

This chapter describes:

• The Regulatory Specialist on page 358

• Regulatory Specialist Tabs on page 360



WORKING WITH THE REGULATORY SPECIALIST

358 TRACKER L&H USER GUIDE

The Regulatory Specialist

The Regulatory Specialist provides access to SERFF information and General 
Instructions. It also provides a database that you can populate with DOI addresses, 
contact information, and custom information.

The Regulatory Specialist window contains the following tabs:

• SERFF on page 360

• RS Custom Fields on page 362

• Dept. Addresses on page 363

• Contacts on page 365

Related topics:

• Using the Regulatory Specialist on page 358

Using the Regulatory Specialist

The Regulatory Specialist can be accessed from any point in the system at any 
time.

Method: Use the Regulatory Specialist

1. Select View > Regulatory Specialist.

The Regulatory Specialist dialog displays.
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If you access the Regulatory Specialist while working within a filing, the 
tabs will automatically be populated with information pertaining to the filing 
you are working in. If you were not working within a filing, or you want to 
view other information, adjust the values in the Settings section for Line of 
Business, Type of Filing, and Filing Content as applicable:

• State – the State to which this information applies. There is one record 
for each of the 50 states, as well as Puerto Rico, the US Virgin Islands, 
Guam, American Samoa, and the District of Columbia.

• LOB – The Line of Business to which this information applies.

• Filing Content – the content of the filing, such as Rate or Form, or any 
combination of these.

2. Wait for a few seconds while Tracker locates and displays the information.

3. View the required information. If you double click on some fields, a dialog 
box containing more information on that field will display.

4. When finished, close the Regulatory Specialist Window.
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Regulatory Specialist Tabs

Information in Regulatory Specialist is organized into seven tabs:

• SERFF on page 360

• RS Custom Fields on page 362

• Dept. Addresses on page 363

• Contacts on page 365

SERFF

The SERFF tab displays two subtabs: General and Billing

General

 The General subtab provides access to a wide range of filing information. The 
information displayed on this tab is organized into the following areas:

• State Preferences: whether the state allows NTRs on closed filings; SERFF 
General Instructions (displayed by clicking the corresponding View button) 

• EFT Information: the filing fee information for that state (including 
whether the state is currently accepting EFT and if they only accept EFT for 
advisory/rating organizations)

• Public Access Information: whether the state allows confidentiality 
requests

• Post Submission Update Information: whether the state allows Post 
Submission Updates

• TOI: which TOIs, sub TOIs and filing types a state is accepting for SERFF 
filings. 

Note: This information is provided in real time. When you click the SERFF 
tab, display the General subtab, and select the state, Tracker connects with 
the Filing Rules server at the NAIC and returns the TOI, sub-TOI and types 
applicable to that state. To see what kinds of SERFF filings are supported 
for that TOI and sub-TOI, click + beside a TOI to expand it.
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Billing

The Billing subtab enables you to view and print SERFF Transaction Block 
information.

The following read-only information is displayed:

Profile Section

• Instance Name
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• PeopleSoft Customer ID

• Number of Free Filings

• Note to Customer

Detail Section

• Block Name

• Date Created (MM/DD/YYYY format)

• Block ID

• Product ID

• Unit Price (USD)

• Paid Ref ID

• Total Filing Units

• Units Used

• Units Remaining

RS Custom Fields

This tab contains ten custom free-format fields which you can use to capture filing 
information unique to your organization.

For each state, ten custom fields are provided, but there are no LOB-specific 
custom fields. Therefore, if you need to record information for specific LOBs, you 
should enter it in the custom field.

In addition to the ten custom fields, you can also include an attachment path and 
website address with links to a document and website related to the information in 
the corresponding custom field. Clicking on these paths or URLs will open the 
document or website.
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Entering or Editing Custom Field Data

Your ability to enter data in the new fields is controlled by a permission option 
within the Security Access menu in System Defaults. This permission must be 
enabled for your security access level in order for you to be able to enter or edit 
data in the custom fields. If the permission is not enabled, you will only be able to 
view the data in the fields. Consult your Tracker Administrator regarding the 
applicable permission setting for your security access level.

Tab Name and Field Names

You can give the new RS Custom Fields tab its own name, and also assign names 
to each of the ten custom fields: see RS Custom Field Labels on page 37.

Dept. Addresses

This tab of Regulatory Specialist is provided for you to keep your own record of 
information about state Departments of Insurance, including names, addresses, 
phone numbers, and e-mail and Web site addresses, as well as the titles of 
insurance commissioners, reviewers, and so on.

The addresses you send your filings to may depend on the type of filing being 
submitted. Multiple Department of Insurance addresses are supported in the 
database; the Settings selected will determine which contact record is displayed. 
Cover letters that are generated during the Generate Complete Filing activity will 
have the correct address automatically included.

Method: Entering/Changing Dept. Addresses Information

To enter or change data in the fields on the Dept. Addresses tab, follow this 
method.

1. On the Dept. Addresses tab of the Regulatory Specialist view, select values 
for all three Settings fields. 

2. Enter or change values in the fields.

3. Click Save.

The new values are saved in the database.
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Settings

The settings selected in this section determine which contact information Tracker 
displays on the tab.

State

This field identifies the State this information applies to. There is one record for 
each of the 50 states, as well as Puerto Rico, the US Virgin Islands, Guam, 
American Samoa, and the District of Columbia.

LOB

This field identifies the Line of Business this information applies to.

Filing Content

This field identifies the content of the filing, such as Rate or Form, or any 
combination of these.

For information on the fields on the Dept.Address tab, see Address/Contact 
Information on page 365.
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Contacts

On the Contacts tab of Regulatory Specialist, you are able to enter and save 
additional contact information.

Note: Information on the Contacts tab is for your use only. Tracker will never use this 
information when creating a filing or a filing package.

Settings

The settings selected in this section determine which contact information Tracker 
displays on the tab.

State

This field identifies the State this information applies to. There is one record for 
each of the 50 states, as well as Puerto Rico, the US Virgin Islands, Guam, 
American Samoa, and the District of Columbia.

NAME

This field identifies the Name of the person to whom this information applies.

Address/Contact Information

The following describes the fields on the Dept. Addresses and Contacts tabs. 
Both tabs contain almost exactly the same fields. The differences between the two 
tabs are noted in the field headings below.



WORKING WITH THE REGULATORY SPECIALIST

366 TRACKER L&H USER GUIDE

First Name/Last Name

This field identifies the full name of the commissioner, director, chief, supervisor, 
or contact.

Title

This field identifies the formal title of the person shown in the previous fields.

Department

This field identifies the full name of the Insurance Department.

Attention

This field identifies the name of the individual or department within the state DOI 
to whose attention the filing should be directed.

Address

This field identifies the street address of the Insurance Department.

City

This field identifies the name of the city that the filing should be sent to.

Zip Code

This field identifies the zip code the filing should be sent to.

Phone and Extension

These two fields identify the main phone number and relevant extension of the 
Insurance Department or contact.

Alt. Address, Alt. City, Alt. Zip Code, Alt. State

These fields list an alternate street, city, and zip code address for this department 
or contact (such as a mailing address or post office box).

Fax 

This field identifies the facsimile number if the Insurance Department has a 
published fax machine number.

Office Hours

This field identifies the hours that the Insurance Department office is open.

Web Site

This field identifies the URL for the Web site of the Insurance Department.

E-mail

The e-mail address is shown if the Department of Insurance has an e-mail address.
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Notes

Any additional notes users want to add regarding the insurance department or this 
contact in particular are entered here.

Tip: Clicking the URLs in the Web Site or Notes fields will open that page in your 
default browser.

Tip:
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Chapter 12

Searching, Reporting, and Filing
Summary

This chapter describes how to perform searches in Tracker, use the Tracker 
Reports function—including each of the standard reports that come with the 
system and instructions on how to produce a variety of reports—and display a 
Filing Summary.

This chapter describes:

• Performing Tracker Searches on page 370

• Tracker Reports on page 373

• Working with Reports on page 374

• Report Descriptions and Types on page 383

• Filing Summary for Paper Filings on page 400
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Performing Tracker Searches

You can search Tracker to locate a specific filing, activity or other item.

The following procedure describes the general steps required to perform a Tracker 
search.

Method: Perform a Tracker search

1. Click the Search button  to open the Search dialog.

2. Enter the following information into the Context section fields (select from 
the drop-down list where available):

• In the Search for field, enter the type of information you want to find.

• In the In field, enter the range limit in which you want to search for 
those records.

3. Enter the following information into the criteria fields (select from the drop-
down list where available):

• In the Field field, enter the name or type of field you want to search for 
or search by.

• In the Criterion field, enter the desired relationship between the Field 
chosen above and its specific content, chosen next (for example, if you 
want to search for certain text in a field, your criterion choice would be 
contains).

• In the remaining criteria fields (which will vary depending upon the 
criteria specified above), enter the appropriate specific information. For 
example, if your criterion field is contains, here you would specify the 
text you want the field to contain. For example, if you are searching in 
the Notice of Domiciliary State Approval fields for entries containing 
the words not required, you would enter ‘Not Required’ into the This 
text field.

Notes:

• In numeric fields, if you select “is equals to” for the Criterion, the 
search results will contain records with exact matches only, but it will 
ignore trailing zeros. (For example, a field with a value of 31.0 will 
match if you use “31” as the Criterion.)

• If you are searching for records by a field that may contain multiple 
values, and you want the search results to show records that contain a 
specific set of values for that field, a best practice is to use one value per 
search criterion, and have multiple search criterion. The search results 
will display only records that contain all the specified values. The order 
of the search criteria doesn’t matter.
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4. Click Add to add the criterion you have just specified to the Criteria 
Selected list field.

Repeat steps 2 to 4 to add up to five criteria statements to the Selected 
Criteria list. When the search is performed, records that match all the 
criteria will be displayed.

5. When you are satisfied with the search criteria you have specified, click 
Search. The results of your search appear in Search Results. 

Note: If no records are found matching your search parameters, a message appears 
stating: No entries were found using the selected criteria.

6. In Search Results, you can double-click an item from the list to view it, or 
select the item and click View Selection.

OR

Click Print to open a page of the search results in your browser. 

Tip: Some Search Results will print better if you select “Landscape” as your 
Orientation setting in your browser’s Page Setup dialog. 

OR
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Click New Search to return to the Search Parameters tab of Tracker 
Search to define a new search.

OR

Click Close to exit Tracker Search. 

Related Topic

• Performing Activity Searches on page 237
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Tracker Reports

Tracker is equipped with a flexible report generation feature which allows you to 
produce a variety of standard reports based on date, sort, and criteria 
specifications you set yourself.

There are different types of Tracker reports. Each type serves a particular function 
in helping you to track your overall compliance filing process. For complete 
descriptions and details of all the available Tracker reports, see Report 
Descriptions and Types on page 383.

For details on the steps required to define and generate reports, see Working with 
Reports on page 374.
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Working with Reports

In this section, the steps used to define and generate reports are described. 
Although there are many types of reports, the procedures used to work with them 
are similar.

Related topics

• Accessing the Reports Function on page 374

• Producing a Report on page 375

• Customizing the Report Name on page 377

• Defining the Date Range of a Report on page 377

• Defining the Selection Criteria of a Report on page 377

• Selecting Multiple Items in Report Parameters on page 378

• Defining the Sort Order of a Report on page 380

• Viewing a Generated Report on page 380

• Scrolling Through the Pages of the Report on page 381

• Viewing a Report at Different Sizes on page 381

• Printing a Report on page 381

• Saving Report Settings on page 381

• Exporting Reports on page 382

Accessing the Reports Function

The reports function can be accessed at any time via the View menu.

Method: Access the Reports function

1. On the menu bar, select View > Reports.

The Reports dialog displays.
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Producing a Report

This section outlines all of the steps involved in producing and printing a report in 
Tracker. Further explanation and instructions for individual steps within this 
process follow.

Important: If you want to abort the generation of report after it begins, click the Stop Loading 

button.  Clicking the close window button instead will result in error messages 
the next time the report is generated.

Method: Produce a report

1. Access the Reports dialog.

2. On the Reports dialog, click the tab that represents the type of report you 
would like to produce.

3. Select the report you want to produce from the list of available reports.

Note: If you double-click the report or select a report and click Preview, Tracker will 
produce a report using default values. (If you have used that report before, your 
most recently used values will be used.)

4. To adjust the report values, click the Parameters button to open the selected 
report’s parameters dialog. The default parameter values are displayed. If 
you have used that report before, your most recently used values will be 
displayed.

Note: The example below is for the Current Filing Status Detail Report; the 
parameters dialog for each report will be slightly different.
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5. If the report uses date ranges, you can optionally enter From and To values 
for the Start Date and the File Date. Only records that fall within this date 
range will be shown on the report. 

Note: Date fields will not appear when the report does not require a date range.

6. Define the Selection Criteria for the report. The fields displayed are 
appropriate to the selected report. For each field, either specify a value or 
select *All. (When a field’s value is set to *All, the field will not be used as 
a criteria for selecting records to include in the report.)

7. Define the Sort Order of the report. Beside each of the selection criteria 
fields is a number. In the Sort Order field, enter the number corresponding 
to the field by which you want the report to be sorted.

8. If displayed, customize the report’s Report Settings. Examples of Report 
Settings parameters used in some standard reports include the following:

• Suppress parts of the report

• control Page Breaks

• control use of an Additional Summary

Custom reports may include additional Report Settings parameters.

9. To generate the report with the chosen values, click OK. 

Tracker generates the report you have specified using your dates, criteria, 
and sort order, and a preview of the generated report appears in a Crystal 
Reports viewer window. (Note: Move your cursor off the screen to suppress 
the tooltip that displays.)

Note: Alternatively, to close the report parameters dialog (and save your selected criteria 
values), click Close. The report parameters dialog closes. Tracker returns to the 
Reports dialog.
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10. Examine the generated report carefully. If you need to make changes, close 
the report window and redefine the report criteria.

If you do not need to make changes, proceed to the next step.

11. Click  Print Report.

The report is printed to your default printer.

Note: If your report does not print as expected, check your Printer Settings for correct 
formatting. Tip: Most reports are best printed and viewed in Portrait 
Orientation, printed on one side of the page only.

Customizing the Report Name

On some reports, you can adjust the report name. The parameter selection screen 
will retain one custom name per individual user, in addition to the default name 
for future reports. However, if you select the default name after creating a custom 
name and run the report under the default name, the custom name is deleted. Also, 
if you already have one custom name and create a second one, the second custom 
name replaces the first one.

Defining the Date Range of a Report

When you define the date range of a report, you are simply specifying the time 
period that will be covered in the report. For example, if you were generating a 
Filings Report and you wanted it to list all filings in the system that were created 
between January 2001 and December 2003, you would input a From date of “01/
01/2001” and a To date of “12/31/2003”. The generated report would include only 
filings created within that time frame.

If you do not choose to enter a date range, Tracker will generate the report using a 
From date of 01/01/1990 and a To date of 01/01/2100.

Please note:

• Some reports do not require the specification of a date range. No date range 
entry fields will appear when they are not required.

• You can input the From and To dates using the drop-down calendars 
provided via buttons to the right of these date fields, or you may type in the 
date, remembering to use the format specified by your company.

Defining the Selection Criteria of a Report

The Selection Criteria report function allows you to filter (or choose) which 
records will appear in your report. The list of available selection criteria is specific 
to each standard report. A choice of *All usually available as the default.
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Selecting Multiple Items in Report Parameters

Some of the reports in Tracker allow you to select multiple items for a given 
report parameter. This functionality allows you to, for example, select multiple 
states, lines of business, or filing managers as parameters to create a single report.

The following reports support this functionality:

• Current Filing Status Detail Report

• Forms Current Status Detail Report

• Aging Detail Report for Outstanding Filings

• Activities Detail Report

• Current Production Status Detail Report

• Production Activity Detail Report

• Average Filing Approval Time Summary Report

• Filing Fees Detail Report

• Regional Filing Status Report

• SERFF Transaction Fee Report

Method: Select multiple items in report parameters

1. On the menu bar, select View > Reports.

The Reports dialog displays.

2. Click the Status tab.

3. Select the report you want to work with and click Parameters. (The Current 
Filing Status Detail Report is used for this method.)

The report parameters dialog displays.
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4. Click the button  at the right side of the parameter.

The items dialog displays.

5. Select multiple items within a parameter by pressing and holding the Ctrl 
key while clicking on each item you want to use with that parameter.

6. When you have finished selecting items, click OK in the items list.
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7. Repeat steps 4 to 6 until you have finished setting parameters, then click OK 
in the main parameters dialog.

The report is generated based on the parameters you have selected.

Note: There is a limit of 20 individual selections per parameter. For example, you can 
only select 20 states for a given report.

Defining the Sort Order of a Report

Defining the Sort Order for a report allows you to choose the order in which 
records will be presented on the final, generated report. There are two steps 
involved in choosing your sort order.

First, you need to decide which of the Selection Criteria you want to use to sort 
your report: in a Filings Report, for example, you may want to organize your 
report by Filing Number, by Date Created, by State, or by LOB, depending upon 
the purpose of your report. Note the number located beside the selection criterion 
you have chosen.

Second, you need to enter that number into the Sort Order field. Text and 
numeric sorts will present records in ascending order (such as by state or by the 
manager’s name starting at A and working to Z, or by filing number starting at the 
lowest number and working to the highest).

Viewing a Generated Report

After you have created and generated a report, the report appears in a preview 
window for you to view the results.

This is a typical standard report (the Forms Listing Report):
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Scrolling Through the Pages of the Report

While viewing the preview of the generated report, you can scroll through the 

pages of the report using the  Back, Back to First , Forward , and 

Forward to Last  buttons found at the top of the preview window.

Viewing a Report at Different Sizes

Use the Sizing field  located at the top of the preview window to 

change the magnification view of the report. Use the drop down list to select a 
magnification, or enter a percentage manually.

Printing a Report

You can print a report right after you have previewed it to see that it meets your 
needs. This can be done from the preview window.

Method: Print a report

1. In the report Preview window, view the previewed report. Check to see that 
it includes all the information you intended.

2. Click the Print Report button. 

The report prints on your default printer.

Saving Report Settings

Whenever you change report settings or criteria, your changes will be saved by 
the system. The next time you access that particular report dialog, the settings will 
be as you last left them.
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Exporting Reports

You can export reports in any of several formats, to any of several destinations. 

Note: If you have a MAPI-compliant program like Outlook or Outlook Express already 
installed, you can export to email. Select PDF as the Format and MAPI as the 
destination. Citrix users will require Outlook or Outlook Express installed on the 
Citrix Server before they can use this feature.

Method: Export a report

1. In the report Preview window, click the Export Report button. 

The Export dialog displays.

2. Choose the export Format you want.

3. Choose the Destination for the exported data. 

4. Click OK.

The data is exported in your chosen format to the destination.
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Report Descriptions and Types

The reports available in Tracker are:

• Status Reports on page 383

• Historical Reports on page 391

• Management Reports on page 393

• Custom Reports on page 397

• Other Reports on page 399

See also Tracker Reports on page 373.

Status Reports

Status Reports provide current information about the status of the filings in your 
system. For example, you can produce a report that lists current information about 
every filing associated with a particular filing manager.

Method: Access a status report

On the menu bar, select View > Reports.

On the Status tab, the following status reports are available in Tracker:

• Advertisement Details Report on page 383

• All - Current Filing Status Detail Report on page 384

• Current Filing Status Detail Report on page 384

• Filing Approval Notification Report on page 385

• Filing Details Report on page 386

• Filing Group Status on page 388

• Forms Current Status Detail Report on page 389

• Forms Summary Listing on page 389

• Legislation Details Report on page 390

• Objection Report on page 391

Advertisement Details Report

The Advertisements Details Report displays a list of all advertisements that 
have been entered in your system and fall within the specified filing date range.

This report displays the following information:

• Product to which the advertising pertains

• Advertising Form Name and Form Number
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• Means of Distribution

• Audience

• Attachment File (including path)

• Memo field

• Number of pages

The report also includes a table of Applicability with the following fields:

• Company

• Line of Business

• Filing Group Number

• Status

• Effective Date

All - Current Filing Status Detail Report

The All - Current Filing Status Detail Report displays a listing of current filings 
and their status with state DOI. 

This report displays the following information:

• Filing Group Number

• State

• LOB

• Company

• Filing Content

• Filing Manager

• Status

• File Date

• Approval Date

• Description

Current Filing Status Detail Report

The Current Filing Status Detail Report displays filings by filing group, and 
shows the status of each filing within a filing group, the total number of filings for 
each status within a filing group, as well as the total number of filings in each 
status for the complete report.

This report displays the following information:

For each filing group:

• Product Code and Description

• Filing Group Number and Description
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For each filing:

• State

• Line of Business

• Company

• Filing Content (Rate/Advertisement/Form)

• Filing Manager

• Filing Status

• Start Date

• File Date

• Objection Date

• Resubmission Date

• Approval Date

• Disapproval Date

• Withdrawal Date

• Summary of Filings within a Filing Group, subtotalled by status

Filing Approval Notification Report

The Filing Approval Notification Report provides detailed instructions and 
information for the filing(s) specified. Use it to track and communicate 
information about approved filings.

This report displays the following fields:

• Product Code and Description

• Filing Group Number and Description

• Filing Description

• Line of Business

• Filing Type

• Content

• State

• Filing Manager

• Company

• Approval Date

• Special Instructions (if any)

• Forms (if any) with the following information for each form:

• Title

• Form #
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• Edition

• Replaced Form #

• State Variation

• Impacts Rates

• Requirement

• Rates (if any) with the following information for each rate:

• Title

• Rate #

• Edition

• Page #

• Replaced Page #

• Advertisements (if any) with the following information for each ad:

• Title

• Advertising Form #

• Replaced Advertisement

Filing Details Report

The Filing Details Report provides a detailed description of the status of a 
selected filing.

This report includes the following fields:

Filing

• Program

• Name

• Filing Group

• Group Description

• Filing Description

• Company Code and Description

• State

• Seq #

• Filing Type

• C. O. Reference Number

• Line of Business

• Content

• Manager

• Status
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• DOI#

Status Dates

• Start

• Approved Effective

• Disapproved

• Objection

• Respond By

• Filed

• Approval Received

• Resubmitted

• Request Effective Date

• Approved

• Withdrawn

• Deemer

• Days

Print/Mail/Automation Status Dates

• Schedule Mail

• Actual Mail

• Print Status

• Rate Built

• EDP

• Rate Effective

Miscellaneous

• Filing Fee

• Check#

• Check Date

• Tracker Reference Number

• Custom

Activities

• Date

• Description

• Suspense

• Completed

• Performed By
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• Memo

Legislations

• Legislation #

• Adv. Org.

• Effective Date

• Type

• Description

• Filing Ref #1, 2, 3, 4, 5

Filing Group Status

The Filing Group Status report displays a listing of filing groups and the status of 
filings.

The report displays the following information

• Product Code and Description

• Filing Group Name and Description

• Special Instructions

For each filing:

• Company

• LOB

• State

• Content

• Seq#

• Lead Form

• Manager

• Status

• Filed Date

• Effective Date

• Special Instructions

The Summary Status of filings includes this information:

• Number of Start

• Number of Pending

• Number of Approved

• Number of Disapproved

• Number of Closed

• Number of ReOpened
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• Number of Withdrawn

• Number of Archived

• Number of Objection

• Number of Exempt

Forms Current Status Detail Report

The Forms Current Status Detail Report shows the status of all the forms that 
have been filed. You can either display all forms, or forms with selected statuses 
only. 

The report is grouped at two levels: the first level is by form number, and the 
second level is by form (not filing) status. Within each form number group is an 
entry for each instance of that form in the system, and details (including the filing 
status) of each filing with that form number.

Note: Usually the form and filing status will be the same, but not always. For example, 
there may be a situation where the form has been approved but the filing has not.

Each grouping by form number displays the following information:

• Form Number

• Filing Group Number and Description

• Edition Date

• Form Type

Each instance of the form number displays the following information:

• State

• Line of Business

• Company

• Filing Status

• Filing Manager Initials

• Start Date

• File Date

• Objection Date

• Resubmit Date

• Approval Date

• Disapproval Date

• Withdrawal Date

Forms Summary Listing

The Forms Summary Listing displays a list of filings and the forms they contain.
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The report displays the following information for each filing:

• Tracker Filing Number

• Filing Description

• Company

• Product Code

• Product Name

• Filing Group Number

• Filing Group Description

• State

• Line of Business

Each form contained within the filing is then displayed with the following 
information:

• Form Number

• Edition

• Title

• Form Type

• Requirement

• Impact Rates – indicates whether this form will impact rates

• Replaced Form

• Comments

Legislation Details Report

The Legislation Details Report is a list of all legislation records in your Tracker 
system.

The following information is displayed for each legislation:

• Legislation #

• LOB

• Description

• Legislation Type

• Legislation Status

• Contents

• Legislation Date

• Proposed Effective Date

• Effective Date

• Five Filing References
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• States

• Links

• References:

• Company Code

• LOB Code

• Content Code

• Seq #

• Activities:

• Date

• Description

• Target

• Completed

• Performed By

• Memo

Objection Report

The Objection Report provides a list of all filings in Objection and Resubmit 
status recorded in the system for the date range specified.

This report displays the following fields:

• Filing Group Number and Description

• State

• Line of Business

• Company

• Filing Content

• Status

• Filing Manager

• Objection/Disapproval Date

• Respond By Date

• Resubmit Date

• Objection/Response (obtained from the Activities and Memo fields)

Historical Reports

Historical reports provide information about approved and implemented products 
and filings. For example, you can produce a report that lists every approved filing 
for a particular line of business.
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Method: Access a historical report

On the menu bar, select View > Reports, then click the Historical tab.

The following Historical reports are available in Tracker:

• Activities Detail Report on page 392

• Forms Summary by State on page 392

• Legislation Summary Report on page 393

• Rate Summary Report on page 393

Activities Detail Report

The Activities Detail Report displays existing activities in Tracker at a detailed 
level. Activities are grouped by filing group and by filing.

This report displays the following information:

• Product Code and Description

• Filing Group Number and Description

• Filing:

• State

• Line of Business

• Filing Content (Rate/Advertisement/Form)

• Company Code and Description

• Filing Manager

• Filing Status

• Activities:

• Activity Description and Level (FG indicates Filing Group level 
activity, FL indicates Filing level activity)

• Activity Memo

• Activity Status

• Suspense Date

• Completion Date

• Due Date

• Performed By

Forms Summary by State

The Forms Summary by State report provides a summary of forms data by 
Product, Group, State, and Form.
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Summarized by state, the report displays the following information:

• Form #

• Edition

• Title

• Date Filed

• Effective Date

• Comments

Legislation Summary Report

The Legislation Summary Report displays a list of legislation records, as 
specified, together with their internal detailed company adoption information. Use 
this report to monitor legislation in your system as they are adopted.

This report displays the following fields:

• Legislation Number

•  Date

• Description

• Adv. Org. ID.

• Type

• LOB

• Content

• Status

• Proposed Date

• Approved Date

• States

Rate Summary Report

The Rate Summary Report provides a summary list of Rates, including Rate # 
and Title.

This report displays the following fields:

• Rate #

• Title

• Applicable States

Management Reports

Management Reports provide information that managers will find useful, such as 
statistical totals and averages for the number of filings, approval percentages, the 
number of days expended, and so on.
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Method: Access a management report

On the File menu, select View > Reports, then click the Management tab.

The following management reports are available in Tracker:

• Aging Detail Report For Outstanding Filings on page 394

• Current Production Status Detail Report on page 395

• Filing Evaluation Report on page 395

• Manager Production Report on page 396

• Production Activity Detail Report on page 397

Aging Detail Report For Outstanding Filings

The Aging Detail Report For Outstanding Filings shows information on filings 
that are still outstanding. By default, filings are grouped first by period, then by 
Product, then by Filing Group. You can set the report to display outstanding 
filings from a date of your choice by typing it in the field, or by selecting one of 
the following:

• Start Date

• Filing Date

• Most Recent Date of Start Filing, Objection, or Resubmit Date

Each Filing Group displays this information:

• Product Code and Description

• Filing Group Number and Description

Each filing displays this information:

• State

• Line of Business

• Company

• O/S Days

• Filing Content (Rate/Advertisement/Form)

• Filing Manager

• Filing Status

• Start Date

• File Date

• Objection Date

• Resubmit Date
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Current Production Status Detail Report

The Current Production Status Detail Report shows the production activity at 
up to two levels of grouping and sorted up to two ways.

Grouping can be done by company and filing manager, with summaries if you 
want. Within a grouping, you can sort by status and Filing Group. The summaries 
show the number of filings with the states of Start, Pending, Objection, Approved, 
Disapproved, Withdrawn, or Closed.

This report displays the following information:

• Filing Group Number and Description

• Filing Manager

• State

• Line of Business

• Company Code(s)

• Filing Status

• Filing Content

• Start Date

• File Date

• Objection Date

• Resubmit Date

• Approval Date

• Disapproval Date

• Withdrawal Date

Filing Evaluation Report

The Filing Evaluation Report provides management information about filings 
under development. It lists information about filings, grouped by filing group.

This report displays the following information:

• Product Name

• Filing Group Name, Description, Number, and Manager

Each filing listed includes the following information:
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• Company

• Line of Business

• State

• Content

• Lead Form Number

• Type

• Manager

• Status

• Start Date

• Filed Date

• Approval Date

• Closed

Under the heading of Days To:

• Filed (number of days between Start Date and Filed Date)

• Approved (number of days between Start Date and Approved Date / number 
of days between Filed Date and Approved Date)

• Effective (number of days between Start Date and Effective Date / number 
of days between Filed Date and Effective Date)

• Disapproved (number of days between Start Date and Disapproved Date / 
number of days between Filed Date and Disapproved Date)

• Withdrawn (number of days between Start Date and Withdrawn Date / 
number of days between Filed Date and Withdrawn Date)

Manager Production Report

The Manager Production report lists the monthly production for each selected 
Filing Group Manager.

For each month with activity, the report lists the following:

• # Started and %

• # Pending and %

• # Exempt and %

• # Objection and %

• # Disapproved and %

• # Withdrawn and %

• # Approved and %

• # Closed and %

• # Other and %
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• # Total and % 

Production Activity Detail Report

The Production Activity Detail Report lists the activities performed within a range 
of Suspense Dates and Completion Dates. The activities listed can be grouped by 
the different type of activities and by the Filing Manager.

For each grouping, the report lists the following:

• State

• LOB

• Company Code(s)

• Filing Content (Rate/Advertisement/Form)

• Filing Status

• Activity Memo

• Activity Status

• Suspense Date

• Due Date

• Completion Date

• Performed By

Custom Reports

The Custom Reports tab contains a selection of specialized reports. This tab also 
contains reports that have been created specifically for your company.

Method: Access a custom report

On the menu bar, select View > Reports.

On the Custom tab, the following reports are available in Tracker:

• Average Filing Approval Time Summary Report on page 397

• Filing Fees Detail Report on page 398

• SERFF Transaction Fee Report on page 398

Average Filing Approval Time Summary Report

The Average Filing Approval Time Summary Report lists the average number 
of days taken by the state DOI to approve SERFF, paper filings, and filings of 
either type. The report displays the average for all filings for each state. By 
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adjusting the Group By parameters, the report can display the results for each 
filing group within each state as well.

Filing Fees Detail Report

The Filing Fees Detail Report report lists detailed filing fee information with 
summaries within a specified date range: Transaction Date/Check Date or Filed 
Date. The listing can be grouped by up to two of the following: Company, Filing 
Group, LOB, Program. Totals can be displayed as well.

This report displays the following information:

• Transaction Date

• State

• Filed Date

• Line of Business

• SERFF Tracking ID

• Tracker Filing ID

• TOI

• Sub TOI

• Type (Initial or Additional)

• Amount

• EFT Transaction ID

• Authorized By

• Total Number of Transactions

• Total Amount

SERFF Transaction Fee Report

The SERFF Transaction Fee Report list all filings that have been submitted to 
SERFF, allowing you to track and reconcile the transaction fees charged by the 
NAIC.

Note: If two filing managers have exactly the same initials, when you select either using 
the report parameters, both filing managers will appear on the report. To prevent 
this, in the user profile of one of the filing managers, change the initials so the two 
are not exactly the same.

This report displays the following fields:

• Company/NAIC Code

• Filed Date

• Filing Manager 

• State
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• LOB

• Filing Content

• SERFF Tracking ID

• Tracker Filing ID

• TOI

Other Reports

The following reports are not part of the general reports and are available only to 
certain users:

• Administrative Reports on page 399

• Filing Summary for Paper Filings on page 400

Administrative Reports

Administrative Reports provide administrative level information about the 
companies, users, and products in your system. For example, you can produce a 
report that lists authority information for every company in your system.

Note: These reports are available only through the Administration menu and not 
through the general reports function, and are accessible only to users having the 
requisite security clearance (usually Administrator level or higher).

For more detailed information on Administrative Reports, please see 
Administrative Reports on page 97.
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Filing Summary for Paper Filings

The Filing Summary is an excellent way to generate a comprehensive snapshot of 
paper filings. (For information on Filing Summary for SERFF filings, see Filing 
Summary for SERFF Filings on page 336.)

There are two parts of the Filing Summary that can be optionally displayed and 
printed: Filing Details, and Filing Correspondence.

This section contains:

• Filing Detail (Paper Filings) on page 400

• Filing Correspondence on page 403

Related topic: 

Generating a Filing Summary on page 339

Filing Detail (Paper Filings)

The Filing Detail part of the Filing Summary displays detailed information about 
the selected filing.

In the header:

• Tracker Filing ID / Company Reference # 

• State

• Filing Company 

• State Tracking Number

• LOB

• Filing Type

• Filing Explanation (based on Filing Description field)

• Product Name (based on what is in the Product Name field at the time the 
Filing Summary is generated)

• Project Name/Number (based on what was in the Product Name/Number 
field at the time the Filing Summary is generated)

• Filing Group Name

In the Filing Overview section:

• Company Name and Company Code 

• Product Name (based on what is in the Product Name field at the time the 
Filing Summary is generated)

• Tracker Filing ID / Company Reference #

• State

• LOB

• Filing Status
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• State Tracking #

• Filing Statute

• Filing Type 

• Filed Date

• Filing Explanation (based on Filing Description field)

• Filing Manager

• Approved Effective Date

• Implementation Date (based on the Implementation Date on the Filing 
Details tab)

In the General Information section:

• Product Name (based on what was in the Product Name field at the time the 
Filing Summary is generated)

• Status of Filing in Domicile

• Project Number (base on what was sent to SERFF or is in the Project 
Number field at the time the Filing Summary is generated)

• Date Approved in Domicile

• Requested Filing Mode (based on what was in the Requested Filing Mode 
field at the time the Filing Summary is generated) 

• Domicile Status Comments

• Explanation for Combination/Other (based on what was sent to SERFF or 
what was in the Explanation for Combination/Other field at the time the 
Filing Summary is generated) 

• Market Type (based on what was sent to SERFF or what was in the Market 
Type field at the time the Filing Summary is generated) 

• Submission Type (based on what was sent to SERFF or what was in the 
Submission Type field at the time the Filing Summary is generated) 

• Group Market Size (based on what was sent to SERFF or what was in the 
Group Market Size field at the time the Filing Summary is generated) 

• Overall Rate Impact 

• Group Market Type 

• SERFF Status Changed (date)

• State Status Changed (date)

• Deemer Date

• Tracker Status Changed (date)

• Related Filing ID (number and type)

• NAIC Filing Description

In the Company and Contact section:
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• Filing Contact Information:

• Filing Manager Name

• Filing Manager Title

• Filing Manager Email Address

• Filing Manager Address

• Filing Manger Phone Number 

• Filing Manager Fax Number

• Filing Company Information:

• Company Name

• NAIC Company Code

• State of Domicile

• Company Address

• NAIC Group Code

• Company Type

• Group Name

• State ID Number

• Company Phone Number 

• FEIN Number 

In the Filing Fees section, these fields display if required:

• Fee Required

• Fee Amount

• Retaliatory

• Fee Explanation

• Per Company

• Check Number

• Check Amount

• Check Date

• Company

• Amount

• Date Processed

• Transaction #

In the State Specific section:

• State Specific information
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Filing Correspondence

The Filing Correspondence section of a Filing Summary for paper filings contains 
a Summary part, and a Filing Correspondence Details part.

The Summary part displays these items for each correspondence activity:

• Filing Correspondence Description

• Tracker Filing ID/Company Ref #

• Date

The Filing Correspondence Details part contains the detail for each activity 
listed in the above Summary. Each activity’s detail is followed by the attachment 
from the activity’s Attach File field (if present), then the rest of the activity’s 
attachments (documents).
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Chapter 13

Viewing Filings and
Attachments for Schedule Items

in the DMS

If you have a document management system (DMS), you can view the following 
within the DMS:

• a listing of filings showing each filing’s status

• a listing of schedule items associated with a filing

• the status of each attachment

Note: The only attachments that are shown in the DMS are attachments that are stored in 
the DMS. Attachments that are stored in a file systems will not display.

The types of schedule items that can be displayed in the DMS are as follows:

• rates

• advertisements

• forms

Using the search capabilities of the DMS, you can search for filings or rates, 
advertisements, and forms that match your search criteria.

This chapter describes:

• The Search Interface on page 406

• Searching for Filings on page 408

• Searching for Rates, Advertisements, and Forms on page 411

• Viewing Rate, Advertisement, and Form Statuses on page 413

• Clearing Search Parameters on page 414

Note: The screens on your system may differ from those shown in this guide.
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The Search Interface

The following kinds of search mechanisms exist in the search interface for filings 
and schedule items:

• Drop-Down Menus on page 406

• Drop-Down Menus with Manual Text Entry on page 406

• Date Search Menus on page 407

Drop-Down Menus

Drop-down menus contain a list of all available entries from the existing data for 
the given search parameter.

In the above example, all available filing statuses are entered automatically in the 
drop-down menu and can be used as the choice for that search parameter. 

Drop-Down Menus with Manual Text Entry

Some drop-down menus allow you to enter a search string as part of the search 
parameter.
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In the above example, you can search for the Filing Description by entering text 
found at the beginning of the description.

Date Search Menus

Some search parameters involve the dates of statuses associated with filings or 
attachments.

In the above example, you can search for filings with a Start Date of January 1, 
2009.
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Searching for Filings

You can search for filings using a variety of criteria. This method is a convenient 
way to see the status of a filing or filings.

Method: Search for a filing

1. Log in to the DMS.

2. Under the heading Tracker, click Filings. 

The Search Tracker Database screen displays with the Search for Filings 
tab selected.

3. Enter any combination of criteria you want to use to narrow your search and 
click Search.

The Filings Search Result page displays.
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The status of each filing displayed is shown in the Status column.

Viewing Rates, Advertisements, and Forms

On the search results screen, you can view rates, advertisements, and forms 

associated with a filing by clicking on the folder icon  at the far right. You can 
also view the states and LOB for any rate, advertisement, and form.

Method: View rates, advertisements, and forms

1. On the Filings Search Results screen, click the folder icon at the far right of 
the filing. 

The contents of a folder containing all the attachments for that filing 
displays.
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2. To view the status of that attachment’s schedule item, click the arrow and 
select Tracker Status.

A list of the states and LOBs associated with this attachment’s rate, 
advertisement, or form appears.

3. Click the Details link to view the list of dates applicable to this rate, 
advertisement, or form.
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Searching for Rates, Advertisements, and Forms

Using the DMS, you can search for and view a filing’s rates, advertisements, and 
forms, view their attachments, and check their status.

Method: Search for rates, advertisements, and forms

1. Log in to the DMS.

2. Under the heading Tracker, click Forms, Rates, etc. 

The Search Tracker Database screen displays with the Search for Rates/
Advertisements/Forms tab selected.

3. Enter any combination of criteria you want to use to narrow your search and 
click Search.

The Filings Search Result page displays.



VIEWING FILINGS AND ATTACHMENTS FOR SCHEDULE ITEMS IN THE DMS

412 TRACKER L&H USER GUIDE



VIEWING RATE, ADVERTISEMENT, AND FORM STATUSES

TRACKER L&H USER GUIDE  413

Viewing Rate, Advertisement, and Form Statuses

The status of some rates, advertisements, and forms can correspond to multiple 
dates. The following table summarizes the relationship between statuses and 
dates:

When you view the status of a rate, advertisement, or form, in all cases the 
Corresponding Date from the above table will be displayed in the DMS.

You can view rate, advertisement, and form statuses by searching for rate, 
advertisement, and form. The status is displayed in the Status column.

Status Corresponding Date 
Conditions/Rules for Determining 
Date 

Disapproved Disapproved Date Same as Corresponding Date

Objection Objection Date Same as Corresponding Date

Start Start Date Same as Corresponding Date

Withdrawn Withdrawn Date Same as Corresponding Date

Approved Approval Date Approval Date has been entered, 
Deemer Date has not

Approved Approved Effective Date Approval Date and Approved 
Effective Date have both been entered

Approved Deemer Date Approval Date and Deemer Date have 
both been entered

Pending Filed Date The Filed Date will be displayed when 
there is a Start Date but no Objection 
Date or Resubmitted Date

Pending Resubmitted Date The Resubmitted Date will be 
displayed when there is a Filed Date 
and an Objection Date
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Clearing Search Parameters

After entering multiple search parameters, you might want to clear all parameters 
to enter new ones.

Method: Clear search parameters

On the search screen, click the Refresh button in your Web browser, or press F5. 
The current set of search parameters is cleared.
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Appendix A

Troubleshooting

This appendix reviews potential problems you might have with Tracker, and some 
possible solutions. If the methods described in this chapter do not resolve your 
problem, please contact Customer Support.

This chapter describes:

• Troubleshooting Tracker on page 416

• SERFF — Filing in Limbo on page 417



TROUBLESHOOTING

416 TRACKER L&H USER GUIDE

Troubleshooting Tracker

This section describes troubleshooting the following areas:

• Viewing Activities in the Filing Package on page 416

• Deleting Activities in the Filing Package Tab on page 416

• Updating Subscriptions or Services Causes Error Message on page 416

See also: SERFF — Filing in Limbo on page 417.

Viewing Activities in the Filing Package

Problem

Trying to view a document within an activity in the Filing Package tab displays 
the following error message:

This file does not have a program associated with it for performing this 
action. Create an association in My Computer by clicking View and then 
clicking Options.

Solution

You need to install Adobe Acrobat Reader 5 or higher to be able to view the 
document. Adobe Acrobat Reader is available at http://www.adobe.com.

Deleting Activities in the Filing Package Tab

Problem

Trying to delete an activity under the Activity Tab that has been moved to the 
Filing Package tab displays the following error message:

This activity has been moved to the filing package and cannot be deleted.

Solution

You do not have a user access level that allows you to delete activities from the 
Filing Package tab.

Updating Subscriptions or Services Causes Error 
Message

Problem

You receive the following error message when trying to load a monthly update:

Wrong ‘Tracker Load’ file or the update period in the ‘Tracker Load file is 
different.

Unable to continue. Options or dates mismatch.
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Solution

Check to make sure you are loading the correct monthly update. If not, you will 
receive the error message above.

SERFF — Filing in Limbo

Problem

A “filing in limbo” is a filing where the SERFF activity was successfully 
completed and moved to the Filing Package, but no log entry was received, nor 
has the SERFF status of the filing advanced. Here are two examples:

• SERFF: Generate/Submit to SERFF: After performing this activity, if 
Tracker receives a status update for this filing, the Move to Filing Package 
check box will remain locked. If no status message for the filing is received 
after four hours, the check box will unlock.

• SERFF: Submit Filing Amendment, SERFF: Submit Objection 
Response, and/or SERFF: Submit Note to Reviewer: After performing 
one of these activities, if the item is successfully submitted, the Move to 
Filing Package checkbox will remain locked. If the item is not successfully 
submitted, the checkbox will unlock after four hours.

Solution

After Tracker unlocks the Move to Filing Package check box, you can move the 
activity out of the filing package by clearing the check box and closing the 
activity. This results in one of two possible outcomes:

• If the filing is no longer in the queue, Tracker will change the status of the 
activity to FAILED. For Filing Amendments, NTRs and Objection 
Responses, Tracker will also change the status of these items under the 
Correspondence tab to DRAFT. If you need to edit, change, or delete any 
data or attachments, you must delete the activity with which they are 
affiliated.

• If the filing is still in the queue, this error message will appear: “The activity 
could not be moved out of the filing package as it’s still in the queue to go to 
SERFF. Please check with your system administrator to ensure that the 
Tracker monitor is functioning properly.”

Note: You must not go back into a FAILED activity; you must perform the activity 
again.
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active records, deleting, 224
passive records, deleting, 224

detail report, 398
filing package tab, 229
for multi-filing, performing, 239
in filing package

adding, 229
tab, deleting, 422

multi-filing, 239
On Approval option, 217
overview, 210
passive, 210
performing

basic, 215
method, 215

post activities, 210
posting, 218
reassigning, 96
records, editing, 221
recurring filing, creating, 89
search

options, 237
performing, 237

specific filing, 206

standard
SERFF, 214
Tracker, 212

suspense, 32
tab

filing, 206
filing group, 211
legislation, 357

viewing in filing package, 422
activity codes

active, adding, 82
changing, 85
deleting, 88
obsoleting, 86
overview, 80
passive, adding, 81
reactivating, 86

administration module, 21
administrative reports

generating, 99
overview, 405
types, 97

advertisements
adding or editing in filing, 178
attachments, adding or editing in filing group, 172
details report, 389
filing group tab, 172
searching, 417
statuses, viewing, 419
viewing, 415

advisory organizations, 74
affiliation criteria, profile configuring, 39
aging detail report for outstanding filings, 400
All, 390
All SERFF Messages tab, 288
alternate long filing letter, 342
amendments, filing, see filing amendments
attaching documents, 233
attachments

adding or editing advertisement in filing group, 172
other, see other attachments
types, 74

authenticating user IDs and passwords, 34
authorities listing report, 98
authority information, entering company, 48
authority levels, EFT fee, 60
average approval time summary report, 403
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B
browsing, filing records, 126

C
check payments, filing fee, editing, 196
closed filings, 317
codes

company, 45
filing group, 113
table of activity, 74

comments
adding to filing letter, 205
tab, 205

company
adding, 43
authority information, 48
codes, overview, 45
deleting, 53
general information, 45
group filings

filing fees, advisory/rating org setting and 
EFT, 46, 271

information, 43
overview, 43
records, accessing, 54

listing report, general, 97
products

creating, 106
working with, 106

resource information, entering, 52
with authorities listing report, 98

company program
deleting, 108
editing, 107

confidentiality requests
entire filing, 333
if state allows, 366
revised items, 335

confidentiality requests / public access, 332
correspondence letter, 342
current

filing status detail report, 390
production status detail report, 401

custom
fields

labels, defining and editing, 78
overview, 78

LOBs, mapping to standard, 90
reports, 403
tables

elements, deleting, 80
entering information into, 79
tasks, performing, 78

understanding, 73
viewing, 78
working with, 73

custom tables, changing information in, 79

D
date

ranges of reports, defining, 383
search menus, 413

defaults
SERFF settings, 56
system, overview, 31
system, settings tab, 31

dialogs, definition, 24
displaying filings with suspense activities, 
configuring, 32
disposition reports

contents, 314
viewing, 314

DMS, using with Tracker, 22
documentation, supporting, filing requirements in 
filing, 257
documents, attaching to filings, 233
draft SERFF filings, generating, 280
drop-down menus

manual text entry, 412
overview, 412

E
EFT

additional payments
submitting, 315

company group filing fees
advisory/rating org setting and, 46, 271

fee authority levels, 60
filing fee details, adjusting, 271
if allowed, 366
paying filing fees via, 268
state accepts indicator, 257
transaction

information, viewing in filing, 271
status, 272

eligible groups, 74
Enabling, 149
error updating subscriptions or services, 422
exporting reports, 388

F
fee authority levels, EFT, 60
field labels, custom, 35
fields

custom, see custom fields
labels, defining and editing custom, 78
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filing activities
creating recurring, 89
performing procedures, 226
specific, 206

filing amendments
creating, 301
deleting, 305
editing, 305
submitting, 306

filing approval
activity, performing, 234
notification report, 391

filing attachments, overview, 233
filing correspondence, SERFF filing, 339
filing detail, filing summary, SERFF, 336
filing details

entering, 130
tab, 130

filing evaluation report, 401
filing fee

state charges per company indicator, 257
filing fee details, adjusting EFT, 271
filing fee information

state, 366
filing fees

check payments, editing, 196
detail report, 404
entering, 195
paid by check, entering, 195
paying via EFT, 268

filing group tabs, viewing, 112
filing groups

adding, 110
code

entering, 113
overriding, 113

creating in multi-user environment, 113
creating past 99999, 113
records, accessing, 112
settings, changing, 112
viewing specific product, 111
working with, 110

filing header, 127
filing letters

alternate long filing letter, 342
comments

comments tab, 205
field descriptions, 344
overview, 229

comments, adding, 205
correspondence letter, 342
creating, 346
follow-up filing letter, 342
information in, 228

list of types, 342
long filing letter, 342
objection letter, 343
overview, 341
sample, 226
short filing letter, 342
withdrawal letter, 342

filing method (rate), 75
filing module, 19
filing package

adding activities, 229
tab

and activities, 229
deleting activities from, 422

viewing activities in, 422
filing records

accessing from filing group, 125
browsing, 126

filing references tab, 356
filing requirements

supporting documentation in filing, 257
filing resources

entering, 204
resources tab, 204

filing statuses
detail report, all - current, 390
detail report, current, 390
searching, 414

filing summaries, generating, 339
filing summary

overview, 336
paper filing

filing correspondence, 409
filing detail, 406

paper filings, 406
SERFF

filing correspondence, 339
filing detail, 336

filing tabs, 129
filing types, 75

selecting for filings en masse, 245
selecting in filings, 254

filing updates, SERFF status, 285
filings

adding new, 116
browsing, 126
closed, 317
creating from legislation, 358
generating, 233
in limbo, 423
multiple, generating and printing, 240
printing, 233
submitting to SERFF, 282
with suspense activities, configuring display, 32
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filtering My Filings - All tab, 125
follow-up filing letter, 342
forms

adding or editing in filing group, 134
current status detail report, 395
deselecting for printing, 149
enabling, 149
searching, 417
selecting, 149

for printing, 150
statuses, viewing, 419
summary listing report, 395
tab, filing group, 134
types, 76
viewing, 415

forms summary by state report, 398

G
general

company
information, entering, 45
listing report, 97

instructions, filing level, working with, 261
generated

reports, viewing, 386
generating

draft SERFF filings, 280
filings, 233
multiple filings, 240

group names, defining, 31
group, eligible, 74

H
header, filings, 127
help, online

see online help
HIPR

rate review detail (PSU), 325
state is enable indicator, 257

HIPR/PPACA
Rate Schedule, 279

historical reports, 397

I
index, using in online help, 26
information records, accessing company, 54

L
legislation

adding copy of, 361
adding or removing states from, 353
creating filings from, 358
detail information, entering and editing, 355

details
main screen, 354
tab, 354, 355

link, adding, 356
list window, 350
overview, 21
references, adding, 207
reports, 362
status, 77
summary report, 399
tab, 207
types, 77

letters
filing, information in, 228
sample filing, 226

letters, see filing letters
Links tab, 355
LOB

change a mapping, 92
mapping

custom and standard, 90
overview, 77

multiple and SERFF filings, 91
multiple LOBs to a custom LOB, mapping, 93

log entries, SERFF, 283
logging in, overview, 101
login

password, changing, 103
Tracker, 102

long filing letter, 342

M
management reports, 399
manager production report, 402
mapping custom LOBs to standard LOBs, 90
messages

deleting, 290
managing, 287
SERFF, 283
types, 283

modules of Tracker, 19
multi-filing

activities, 239
posting activities for, 239

multiple LOBs and SERFF filings, 91
My Filings - All tab

accessing, 123
filtering, 125

My SERFF Messages tab, 288

N
NAIC code, advisory/rating organizations, 47
notes to filer
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receiving, 318
SERFF, 287

notes to reviewer
creating, 291
deleting, 293
editing, 293
sending, 317
submitting, 293
working with, 291

NTR
on closed filings, if allowed, 366

O
objection

letters
SERFF, 287

report, 397
responses

creating, 308
deleting, 312
submitting, 313

objection letter, 343
objection letters, viewing, 306
objection responses, editing, 312
online help

index, using, 26
navigating, 26
printing topics, 27
searching, 25
table of contents, using, 26
using, 25

organizations
advisory/rating, NAIC code, 47

other attachments
adding or editing in filing, 190
adding or editing in filing group, 187
creating revised, 296
filing group tab, 187

outstanding filings, aging detail report, 400

P
passive activities, 210
passive activity detail records, deleting, 224
passwords

authenticating, 34
changing, 103

payments, additional EFT, 315
post activities, 210
Post Submission Updates

if allowed, 366
post submission updates, 319

activity, 327
adding rate data, 326

button, 319
PPACA, 322
rate review detail, 325

posting activities
filing or filing group, 218
multi-filing, 239

PPACA
post submission update, 322
Product Types (PSU), 323
required fields

Company rate change?, 161
Grp Mkt Size, 127
Implementation date, 130
Mkt Type, 127
PPACA (SERFF Filing Details), 274
PPACA Product Types, 162
Rate Review Detail, 162

previsously satisfied, bypassing, 300
print status, 78
printing

filings, 233
multiple filings, 240
reports, 387

production activity detail report, 403
production status detail report, current, 401
products

company, 106
creating company, 106
viewing filing groups for, 111

profiles
affiliation criteria, configuring, 39
user, see user profiles

provinces, displaying or hiding, 33
proxy server settings, configuring, 61
public access / confidentiality requests, 332

R
rate summary report, 399
rates

disabling, 170
enabling, 170
filing group tab, 151
information, entering in filing, 159
rate/rule

viewing schedules, 279
schedules, viewing, 279
searching, 417
viewing, 415

or changing in filing, 159
reassigning activities, 96
recurrent activities, completing, 224
recurring filing activities, creating, 89
references, adding legislation, 207
regulatory specialist
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accessing, 364
contacts tab

address/contact information, 371
description, 371
settings section, 370, 371

custom fields
labels, changing, 37
tab, 368

dept. addresses tab
address/contact information, 371
description, 369

SERFF tab, 366
tabs, 364

related
filings, linking, 185
legislation, 207

related filings, linking, 185
report

activities detail, 398
advertisement details, 389
aging detail report for outstanding filings, 400
all-current filing status detail, 390
average filing approval time summary, 403
current production status detail, 401
filing approval notification, 391
filing evaluation, 401
filing fees detail, 404
filing group status, 394
forms current status detail, 395
forms summary by state, 398
forms summary listing, 395
historical, 397
legislation details, 396
legislation summary, 399
manager production, 402
objection, 397
production activity detail, 403
rate summary, 399
SERFF transaction fee, 404

reports
administrative

overview, 405
types, 97

custom, see custom reports
date ranges, 383
descriptions and types, 389
disposition, 314
exporting, 388
function, 380
management, 399
other types, 405
overview, 21, 379
parameters, selecting multiple items, 384
printing, 387

producing, 381
saving settings, 387
scrolling, 387
selection criteria, 383
SERFF, 287
sort order, 386
status, 389
viewing generated, 386
working with, 380

requirements
bypassing for filings en masse, 251
bypassing in filings, 265
filing level

removing, 264
satisfying, 263

previously bypassed, satisfying, 298
retrieving for filings, 258

en masse, 247
revising Bypass Reason, 299
satisfying for filings en masse, 249
user added, see user added requirements
viewing in filing, 260

resources
filing, entering, 204
information for companies, entering, 52
tab, 204

Retrieving, 247

S
sample filing letter, 226
schedule items

adding, 132
form, rate, etc., revising, 295
overview, 132

schedule items, state status updates, 286
schedules

viewing form, 278
screens

see dialogs
scrolling reports, 387
search

activity options, 237
interface, overview, 412
parameters, clearing, 420

searching
filing statuses, 414
rates, advertisements, and forms, 417
Tracker, 376

searching the online help, 25
security access

levels
configuring, 39
defining, 41
titles, defining, 40
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security, system, 39
selection criteria of reports, defining, 383
SERFF

activities, standard, 214
configuring Tracker for, 56
default system settings

configuring, 58
overview, 56

filing default options, 58
filing details fields, 274
filing summary, overview, 336
filings

details, viewing and editing, 273
generating draft, 280
monitoring, 283
multiple LOBs, 91
reviewing, 273
working in filing, 254

filings, working with en masse, 245
general instructions (en masse), 250, 253
help with, 22
integration, 22
log entries, 283
messages

content, 283
identifying new ones, 289
monitoring, 283
viewing, 289

messages, hide, 57
notes to filer, 287
objection letters, 287
overview, 242
reports, 287
schedule item attachment formats, configuring, 63
server URLs, 58
specific security settings, 39
SPI

log on ID, 57
password, 57

status filing updates, 285
submitted filings, procedures for working with, 291
submitting filings to, 282
subtabs, 243
tab

banner, 243
in filing, 243

transaction fee report, 404
troubleshooting, 423
URLs, 57

SERFF filings
monitoring, 283

SERFF settings
displaying state messages, 65

SERFF transaction fee report, 404

services, error updating, 422
setting up Tracker first time, 30
settings

generic security, 39
settings tab, system defaults, 31
short filing letter, 342
solicitation methods, 78
sort order of reports, defining, 386
SPI, SERFF password, 57
standard

LOBs, mapping custom LOBs to, 90
SERFF activities, 214
Tracker activities, 212

state
adding from legislation, 353
removing from legislation, 353
schedule item status updates, 286
specific values, entering in filing, 267

state messages, displaying SERFF, 65
status

changes and active activities, 210
reports, 389
SERFF filing updates, 285

sub TOIs, selecting
en masse, 245
in filing, 254

submitting
filing amendments, 306
filings to SERFF, 282
notes to reviewers, 293
objection responses, 313

subscriptions, error when updating, 422
summary

listing report, 395
supporting doc filing requirements, 257
supporting doc schedule items, creating revised, 296
suspended button, 125
suspense activities, configuring display, 32
system

defaults, overview, 31
defaults, settings tab, 31
security, 39
settings

SERFF default, configuring, 58
SERFF default, overview, 56

T
table of contents, using in online help, 26
tables

elements, custom, deleting, 80
tasks, 78

TOI, selecting
en masse, 245
in filing, 254
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Tracker
configuring

for SERFF, 56
DMS, using with, 22
integration with SERFF, 22
modules, 19
searches, performing, 376
setting up first time, 30

training, 22
transaction

information, EFT, viewing in filing, 271
status, EFT, 272

troubleshooting, 422
troubleshooting SERFF, 423

U
updating

errors, 422
user

access levels, assigning, 42
IDs, authenticating, 34
listing report, 98
profiles

adding, 68
changing, 70
deleting, 71
overview, 68

user-added requirements, creating in filing, 266

W
withdrawal letter, 342
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